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Abstract

This document is a ”User’s Guide and
tutorial” for the PERSINT interactive
detector, magnetic field, and event visual-
ization program developed for the ATLAS
collaboration [1]. The program is well
suited for event scanning and for analyzing
complicated events in their most intricate
detail.

Run Number: 189280,
Event Number: 143576946
Date: 2011-09-14, 11:37:11 CET

EtCut>0.4 GeV
PtCut>0.4 GeV
Vertex Cuts:

Z direction <lem
Rphi <lem

Muon: blue
Cells: Tiles, EMC
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H — pppp candidate event of invariant mass 124.6 GeV, from the 2011 dataset.
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13 1 MAIN FEATURES OF PERSINT

Introduction

Persint ! is an interactive visualization program developed for ATLAS. The program has
been operational for many years and was used for:

- Designing the muon spectrometer

- Debugging the successive detector layouts, in particular resolving volume clashes

in the GeoModel

- Optimizing the reconstruction software

- Analysing cosmic ray data in the commissioning phase

- Analysing collision events (data and Monte Carlo)

The new version described in this manual retains all the functionalities of the original
package [2] and features a modern graphic user interface (GUI) and an easy to use file
management system. The new interface, which uses the Qt library from Trolltech, makes
it easy to interact with objects or applications.

Persint has many remarkable features, which can be used to visualize events in their
most intricate detail. It is currently running on Linux , Mac OS and Windows operating
systems and is interfaced with ATHENA, the general framework for data analysis in
ATLAS. The package is being used with simulated events and with real data: cosmic
ray events and events from collisions.

Persint is particularly well suited for understanding complicated events, when the visual
representation of the detector’s response becomes crucial.

1 Main features of Persint

The Persint program is designed for the three-dimensional representation of objects. It
visualizes detector geometries using an interface with AMDB 2, an ASCII file containing
the primary numbers used to build the muon spectrometer geometry. It also accesses
AGDD?3, an XML-based geometry description language for the Atlas generic detector,
mainly concerned with the inert material in the spectrometer. Persint interfaces with a
variety of independent applications, in a fully interactive way. These applications include
visualization of active detectors, inactive material, and the magnetic field map, as well
as the detection of volume clashes, the display of event hits from files of physics events
(simulated or data). It is possible to display events reconstructed with any reconstruc-
tion program active in ATHENA. Furthermore it is also possible to interactively run the
embedded muon reconstruction program MuonBoy, and display the results.

For spatial navigation, one can set the desired perspective for the 3D-view and display
2D-projections along various axes (Fig. 1). It is possible to change the viewpoint in order
to best visualize the desired region, to displace the viewed objects with operations like
translation, rotation and zoom.

The remarkable features offered by Persint are:

- 3-dimentional representation of objects in full volumes or “wire mode” using the compu-
tation of hidden faces

- Spatial navigation with real time displacements

- Focal length adjustment, from isometry to wide angle

- Displays can be exported as .png, .jpg, .bmp, or .svg files.

- Highlight of volume edges; adjustable light intensity on volume faces

! Persint: PERSpectively INTeractive
2 Atlas Muon Data Base
3 Atlas Generic Detector Description
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1 MAIN FEATURES OF PERSINT

- Detection of clashing volumes and highlight of intersections

- Boolean volume operations (addition, subtraction, intersection).

- Interfaces with numerous applications:

Display magnetic field map and field integrals; generate & track muons in mag. field

Distribution of material along tracks
. Vertex display; Invariant mass calculation

. Display of jets and missing Er vector

IIII‘I‘IlllI|

(a) 3D View

(b) 2D Z-View

Figure 1: Various views

(c) 2D X-View

of a Persint display
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2 Architecture

Persint has been in use since 1995 and is written in Fortran90 . The core code contains
everything needed to parse, store transiently and generate volumes from standard XML
files. Analytic calculations determine volumes with hidden faces, provide the detection
of clashes, can highlight volume intersections and supports boolean volume operations.

A second layer of C™" wraping classes provides the liaison between the core program
and the graphic interface. This layer is made of classes encapsulating the calls to Fortran
routines.

The third component is the Qt/CT* Graphic User Interface (GUI) .

Persint is a stand-alone package which uses ASCII event files as input:

1. The ASCII event files can be produced by ATHENA from raw data, with proper
setting of the “properties”. In this case, the full potential of Persint can be used,
including the interactive reconstruction of tracks with the embedded Muonboy re-
construction package. However, results from any ATHENA reconstruction package
can be chosen for display (Muonboy, Staco, Moore, Muid, ...)1.

2. These ASCII files may also be produced from ESDs, using a “procedure” in
ATHENA (Appendix G.2). In this case, events can be displayed but the inter-
active reconstruction of tracks cannot be performed.

Details of the design architecture can be found in Appendix A and in [5].

3 Installation on supported platforms

The necessary total disk space for installing Persint is less than 200 Mbytes. The fol-
lowing platforms may be used (see details in Appendix B, figure 131):

e Ubuntu

e Scientific Linux

e Mac OS X

e Fedora

e Debian

e CentOS (Ubuntu)

e Cygwin, the Linux-like environment tested with Windows 7
e CernVM via VirtualBox 4.0 (Ubuntu and Mac OS X)

Detailed instructions for installation and requirements for dependencies are given in
Appendix B. An abridged HTML version of this user’s manual is available at:

https://twiki.cern.ch/twiki/bin/view/Atlas/Persint2Wiki

Up to date information on releases, installation and dependencies can be found
there.

! Muonboy, Staco, Moore, Muid are computer programs for muon track reconstruction in Atlas.
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4 Starting Persint

e To start Persint under Linux, launch the program with the Persint icon on the
desktop .

e Under Mac OS, launch the Persint.app application placed in the Application folder

at installation time 2.

In the pop-up window, choose the language: English, French, German, or Italian.

Upon launching Persint, the default AMDB geometry file is loaded automatically. It
is located in the directory Persint-00-02-ee /AmdcData/share, where Persint-00-02-ee is
the persint working directory 3

Then a window is displayed which prompts you
to restore (or not) the view which is automat-

ically saved when closing the previous session
(answer Yes or No).

When launching Persint for the very first

The last time you ran Persint, a view was

time (there is mno “previous session”), automatically saved before you left.
answer Yes in order to display the default Do you want to restore this view now ?
view (Zmumu4023p2vf) .WhICh is .created (N (Ve
at installation time in the directory — g
Persint-00-02-ee /example. ¢
“When running the preloaded Persint on lxplus at
CERN for the first time, there is no default view available.
Figure 2 shows this default display in which labels have been added to indicate the
location of the various tool bars and windows. The display also contains a simulated
di-muon event which has been superimposed. How this is done is explained in section 6.3.
It is always possible to retrieve the original view (or any view which was saved as a
.p2vf file). This is done in the following way:
Click on the Open view icon of the File tool bar. Select and open either the |&£ O
| | =
default file Zmumu4023.p2vf 4, or any saved .p2vf file. epc= o

Open view

Open view. . .

e The program’s version number can be seen in the About item in the Help menu
(or in the persint menu in Mac OS). The latest version is Persint-00-02-74.°
Upon starting Persint, if your version is not up to date, a warning will tell you so
and invite you to make the update.

e When loading the simulated event, you may be warned to use the appropriate
geometry file. Answer to load the suggested file (see page 24, figure9a).

!Under Linux, this icon is created on the desktop at installation time.

2Under Mac OS, an alias can be conveniently placed e.g. on the Desktop or in the Dock.
It can also be launched from the Terminal by typing ./start_persint.sh in the persint working direc-
tory: Persint-00-02-ee.

3 Persint-00-02-ee is the evolving version number of Persint, e.g. Persint-00-02-74.

4Zmumu4023. p2vf is located in the Persint-00-02-ee/ example directory.

®Check for the latest version at: https://twiki.cern.ch/twiki/bin/view/Atlas/Persint2Wiki.
As the version will evolve with time, the version number is given as Persint-00-02-ee in this document.
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5 The Graphic User Interface

Figure 2 shows the Persint window once the program has been launched.

5.1 TItems of the Graphic User Interface

A detailed description of menus and tool bars available in the Graphic User Interface is
given in Appendix E.

e At the top are the menus: |File|,
’Tools ‘,

These menus give access to the various operations one can perform.

, ’ Volumes ‘, Events

Image |, | Navigation ,

Window‘ and ’Help ‘ The ’persint ‘ menu is specific to Mac OS).

e The most common operations (but not all) are also available through Tool bars [
which appear just below the menus, as repeatedly shown in Appendix E. S

v Log
 AMDB.

The user can choose which tool bars to display. A right-click on any displayed | . o

: . . . . + Image toolbar
tool bar will produce a pop-up list from which items can be enabled or disabled. ¢ Nevgation toolbar
v Event toolbar

The Navigation tool bar has been placed on the right hand side ! by the user. It
has a number of functions (represented by icons) which allow changing the aspect
of the main display in many ways.

List of tool bars

e The large window at the left, the Selector window, is used for selecting detector
volumes.

1. The AMDB interface allows interactive access to the geometrical data bases
of the amdb_simrec type [3] and concerns not only detector volumes like muon
chambers, calorimeters and trackers, but also magnets, feet, and shielding.

2. The AGDD interface allows interactive access to data bases of the ATLAS
Generic Detector Description type[4][8]. The AGDD interface is used to
display the inert material in ATLAS.

3. The Magnetic Field interface provides a fully interactive 3D visualization of
the Magnetic Field. The use of this interface will be described in section 9.7.

4. The X0 interface provides a full 7, ¢ map of the amount of material traversed
by a particle originating from the interaction point. The use of this interface
will be described in section 9.8.

e The detector and event Main display window occupies the largest area of the
display. When saving or exporting a view, it is the content of this main display
window which is saved.

The Main display can be modified in size by dragging the lower right corner. Also,

by right-clicking on the title bar of the window, a number of functions appear i

in a pop-up window, which you are invited to test. SlZ;inimiz e

This Main display window can be made ”Full screen” by using the appropriate OMaximize

item in the Window menu, or the short cut by typing the letter F' (lower case). To Stay on Top

exit the full screen mode, type F again. Actions on Main
display

e Finally, the Log window can be opened in the Window menu (Appendix E.7) and
shows comments about the successive operations when running Persint.

! Any tool bar can be placed to a preferred location by the user.
2This pop-up menu also appears when right-clicking on the title bar of the Histogram of hit
calorimeter cells window (section 11.3.3).
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5.2 Online help

The location on the screen and the size of all these windows may be changed by the
user. Online information about the functions of the icons is provided in an information
box which appears when the curser is positioned on any icon. Some examples are shown
in figure 3.

BOE| =Y B 4,)E D)%

b \Export view as a picture| |Previous view|
(a) Data manager (b) Export (c) Previous view
AMDE eQ00
Volume | &y | Selection | Wire
Volume | dgy | Selection | Wire |
» RPC 0,
r
> TGC B Ege— ™
.‘.‘ |Click to switch an/off wire mode for this volume |
BIS - ]
» CSC .'%%. O
b MAT BML .%%8:!:! O
» CAL |Magnets and dead material | s % =
= 1D e —
(d) Volume indentification (e) Generic chamber description
Selection | Wire | Volume | ¢ | Selection | Wire |
55 27
oo ™ BEE oa O
5?_‘)% |_|C|ickt0 switch on/off wire mode for this volume| on .D?—-\% | Switch on/off the negative Z region|

(f) Partial wire mode (g) Z-halves selection

@{l { Q| —&
L i —— ,
HZDDH’I on custom area |Displaced volurmes | — Reload event

Mavigation scale : x 1

(h) Customized zoom (i) Navigation scale (j) Displaced volumes (k) Reload event

Figure 3: Examples of online information boxes, when positioning the curser over an
icon.

5.3 Toolbars or Menus 7

m Image MNavigation

In the following tutorial, we will mostly use the B> Data manager P
tool bars, although using actions in the menus £ Open view... %®0
may be preferred by some users. [ Save view as...  #S

= Export view... {+38S

h’ B B g E:é ‘4 Print... ¥P

Save Special...

Download... >
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6 Exercise 1l: Setting the stage

In this section, we will start using Persint and explore it’s most basic features as well
as the main functions proposed by the interface. It is assumed that the installation was
successful and that the necessary dependencies are satisfied (see Appendix B).

6.1 Necessary files

For proper initialization of certain applications, the program loads several databases
and input files. It is possible to load any database during running time, but it is of
interest to load default files, so that the program can initialize its applications when
they are launched for the first time. Default files are stored, at installation time, in the
Persint-00-02-ee directory .

This section (6.1) provides information about the files needed for running Persint, and
no action is needed at this time. You may however want to create two directories for
storing various files generated when operating Persint, for example:

The persint_export_files directory (or any other name) for storing files generated by the Export view
function of the File tool bar (see section 6.4, item 2). These are files for presentations and publi-
cations.

The persint_working_files directory (or any other name) for saving Persint-specific files. These are files

which you may want to save when interrupting your work until your next session with Persint.

6.1.1 Detector description and magnetic field

6.1.1 Persint uses several files which concern the detector description and the magnetic
field map . At installation time, they are placed in the directory Persint-00-02-ee !
and can be loaded by clicking on the Data manager icon of the File tool bar. In the
pop-up window (Figs. 4,5, and 8) load the necessary files as follows %:

Data Manager

[ Voumes  Events  Magnetic Field  Others |

AMDE

Default file : amdb_simrec.r05.01

Current file : amdb_simrec.r03.01.Iniial.Light BML.S13.Patch

£ Load H &) Reload H Define As Default H Load Default

AGDD

V! Load AGDD Volumes from the AMDB file

Current file : <No AGDD file loaded=

Load Reload

Close |

Figure 4: Volume tab: Choosing AMDB and AGDD files

!Created at installation time and named according to the Persint version in use. Check for the latest
version at: https://twiki.cern.ch/twiki/bin/view/Atlas/Persint2Wiki

2When all the files are chosen, click on .

800
(=R =M= -

Data manager

Data manager
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1. The AMDB file (of the amdb_simrec.xxx type) from which the detector volume can be

displayed is loaded from the | Volumes| tab (Fig.4). When clicking on , the files in
the directory Persint-00-02-ee/amdcData/share are made available. ! For this tutorial,
we will load the Default file by clicking on and checking the box: ” Load
AGDD Volumes from the AMDB file”.

The two other buttons are used to the current AMDB file or [Deﬁne as Default]
the Current file.

2. The magnetic field files are loaded from the [ Magnetic Field| tab (Fig.5). The magnetic
field map can be chosen for both the muon spectrometer (toroid) and the inner detector
(solenoid). Click on , and the Magnetic field wizard proposes several possible
actions, first for the spectrometer (toroidal) field map (Fig. 6a).

Data Manager

! Wolumes  Events | Magnetic Field = Others |

Maagnetic Field

Muon Spectromerer:  EGITEGRSIEEEIARASESISIE
Solenoic: <No magnetic field map has been loaded.>

(" Modify ... )

Close )

Figure 5: Magnetic field tab

° to load the default map initially proposed ? or chosen with one of the two
following actions:

. to choose from the maps proposed in the Persint-00-02-ee/BFieldData/share
directory

. to download additional files from a CERN repository to the

Persint-00-02-ee/BFieldData/share directory

Clicking the button will load the chosen spectrometer field map, and will
prompt two options for the solenoid field map (Fig. 6b):
i) Use the theoretical map calculated from Biot-Savart;

ii) Use the measured map which needs to be ed or ed.

Finally you are asked if the field maps you just loaded should be your future default maps
(Fig. 7).

3. Event files are loaded from the [Events tab (Fig.8). When clicking on , the files in
the directory Persint-00-02-ee/ example are made available. Event files can be loaded
from other directories.

The bottom part of the window shows the Data cards file, which is used for the interactive
reconstruction of tracks within Persint. Here again, the default file Muonboy_collision_cards

was chosen with | Load Default |.

IThe content of this directory is shown in AppendixD.2, Figure 133a.
2When running Persint on lxplus at CERN for the first time, there is no default map available.
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Spectrometer Magnetic Field Solenoid Magnetic Field
Specify the magnetic field map to use for the muon spectrometer. Choose whether to use a specific magnetic field map for
the solenoid.

Spectrometer map: llshareibmagatlasos,(estz.data ‘ M o
Use the theoretical map (Biot-Savart)

@ Use the measured map

Solenoid map: (a/share/map7730bes2.grid | ( Select .. )

( Download ... ) Co Back ( Continue ) ( Download ... ) ( Go Back ) ( Continue )
A

A

(a) Spectrometer (b) Solenoid

Figure 6: Magnetic field wizard

Remember?

Decide whether you want these maps
to be the default maps.

[1Use selected map(s) by default

( Download ... ) ( Go Back ) ( Done )
4

Figure 7: Magnetic field wizard: set map(s) as default ?

["Volumes | Events | Magnetic Field Others |

MboyView Muon Hits

Default file : Out.MboyView_Zmumu4023

Current file : Out.MboyView_Zmumu4023

| £ Load | | Define As Default | | Load Default

Data Cards

Default file : muonboy_collision_cards

Current file : muonboy_collision_simul_cards

2 Load | | Define As Default | | Load Default

Close

Figure 8: Choosing the Event file
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6.1.2 “Example” files for Event 4023

For the purpose of this exercise (Exercise 1), three more working files were placed in the
directory Persint-00-02-ee/example ! during installation of Persint. They concern
Event 4023 of a Z — ™y~ simulation:

1. Zmumu4023.p2vf: Detector description file.

This file was produced to embed Event 4023 in a detector layout, and is
only an example. You may want to build and display your own “visible”
detector, save it as a .p2vf file and use it as a template for displaying
events (see 6.4, item 1; and 7.4).

2. Out.MboyView_Zmumu4023: Event file.

This Event file is an ASCII file produced by ATHENA when the “prop-
erties” are properly set. It contains the event Zmumu4023 with all in-
formation necessary for viewing in Persint: parameters for hits, tracks,
calorimeter clusters, reconstruction, and simulation of this Monte Carlo
event.

Persint can also use event files produced from ESDs, as explained in
Appendix G.2.

3. Zmumu4023.p2ts: Track parameter file.

This file contains the track parameters applied to the event to be dis-
played. The file is produced within the Set track parameters window
where parameters such as momentum and energy thresholds, as well as
the color code are set (see section 6.3, item 6, and figure 10). The param-
eters can be saved from the Set track parameters window as a .p2ts file
to a directory of your choice.

4. .p2gm files: Parameters of generated muon tracks.
The usage of this type of Persint file is described in 7.1.

No action is required at this stage, except to check that these files are present in the
proper directory. All these files will be used in this tutorial as “Default files” .
6.2 Interfaces to applications

The Persint display window gives direct access to a series of applications through dedi-
cated interfaces. They will be described and used throughout this tutorial.

e the AMDB Interface

the AGDD Interface

the reconstruction and Event display Interface

the Track parameters interface

the Muon Track Generation Interface

e the Magnetic Field Interface

IThe way to access these files will be explained as we go along.



24

6 EXERCISE1: SETTING THE STAGE

6.3

1.

2.

4.

Displaying detector layouts and events (Exercise 1 starts here).

Start Persint (see section4).

Clear the view in the main display.

Use the Clear icon in the Image tool bar and choose Clear view in the proposed
menu (or click directly on the “brush” in the icon). With this scrolling menu
one can make a selective clearing of AMDB or AGDD volumes, event hits !, labels?

captions or pictures?.

. Display detector volumes.

The desired detector volumes can be displayed using the Selector window, the
operation of which will be detailed in sections 7.2. For the present exercise, we will
load the “Default file” which was prepared when studying the Zmumu4023 event:

Click on the Open view icon of the File tool bar. Choose and open the file
Zmumu4023.p2vf in Persint-00-02-ee/example of your working directory. The
detector volumes are displayed 4, as shown in figure 2.

Load a Z — u™p~ event in the following way.

Click on the Data manager icon in the File tool bar. In the pop-up window, go
to the Events tab (Fig.8) and click on to load the “Default
file” Out .MboyView _Zmumu4023 which becomes the “Current file”. Close the
Data manager window.

The Event file contains information concerning the geometry to be used. It may
happen that a warning is issued, which prompts you to load the expected
geometry file and/or the magnetic field files, as shown in figure9. Answer

to load the expected files. It is possible to answer No), in case one

wants to use files different from the default files (e.g. a misaligned geom-
etry or an different magnetic field). Furthermore, any given file available
in the Persint-00-02-ee/AmdcData/share directory (see App.D.2, figure
133a) can be loaded from within the Volumes tab of the Data manager win-
dow.

4y @ 2l A

¢ Clear view
| £ Clear AMDB volumes
{4 Clear AGDD volumes
| Clear event

¢ Clear labels

¢ Clear captions

¢ Clear pictures

u
v 4

B’ |

Clear

800

&QE:

2

Open view

Open view. . .

The current magnetic field map(s) differ(s) from the

Current file: amdb_simrec.r.03.01 ﬁ:r;:_'" Emavaasistes et

The current AMDB file is not the file required by the new - map(s) required by the new event file:
- muon hits file. Maps r

Expected file : amdb_simrec.r.03.01.Initial.Light.BML.513.Patch
maps:
Do you want to load the required AMDB file ?
map(s)?

Expected bmagatlas05_test2.data map7730bes2.grid

Do you want to load the required magnetic field

\ No Yes ENod)
(a) About the geometry file (b) About the magnetic field file

Figure 9: Warnings issued by Persint.

Click on the Next event icon of the Event tool bar: the muon chambers which
are hit by reconstructed tracks are displayed.

!Event hits are treated in section 10.2.

2Labels are treated in section9.1.2.

3Captions and pictures are treated in section 6.5.

“The selected detector volumes can be identified by looking at the AMDB and AGDD panes in the
Selector window.

M

Next event
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5. Display the event.!

Click on the Simulation tracks icon of the Event tool bar: the muon tracks from
the simulation are displayed. Erase these tracks by clicking again on that
icon.

Click on the Athena reconstruction icon of the Event tool bar: only reconstructed
tracks are displayed along with the associated segments in the chambers. Keep
these tracks. [The segments and tracks can be erased by clicking again on
that icon].

Click on the Hit calorimeter cells icon of the Event tool bar: the calorimeter hits
of the event are displayed. Keep these hits on display. [The hits can be erased
by clicking again on that icon].

6. Make track and cluster selection.

Click on the Set track parameters icon of the Event toll bar. In the pop-up window
(Fig. 10) one can choose physics objects, and define some of their parameters. The
usage of this facility is straightforward: items can be selected and momentum (pr)
or energy (E or Er) thresholds can be set. It is possible to choose the color, the
track shape (ribbon or cylinder), the track and segment width, display the scat-
tering centers used by the reconstruction program, and define cuts on the impact
parameters (d0, z0) of tracks.

A detailed description of the Set track parameters window is given in Appendix E.5.1,

where all the parameters are shown, in each of the five tabs.

["Reconstruction imulati C cells  Physics  TRT |

Recanstruction

EMuunBay segments

=
=)

os0cev [2 [ |

o]
oo 0[]

" Moore segments

™ 1D tracks at IP
EMuunBay tracks at IP

] MuenBoy tracks at Spectro
"I Staco tracks at IP

" MuTag tracks at IP

" Moere tracks at Spectro

[ MulD extra tracks

w0 =]

1,0000 cm 3]

I MulD Comb tracks at IP

Maximum d0

Maximum |20] 1,0000 cm (3

Track shape [ Ribbon I+ !
" Draw scattering boxes

—_——
—_——

Track width 0,249804 [3)

Segment width 02990778 [i) W ‘

(" Restore Defaults ) (“Open ) (Saveas ) ( Save ) ( Cancel )
R — o= e e )

Figure 10: Set track parameters window. The parameters shown here (for the
Reconstruction tab) are those of the predefined parameters of file Zmumu4023.p2ts men-
tioned below. See Appendix E.5.1 for the content of all 5 tabs.

IThe result of the actions described below depend on the status of the Set track parameters window
(see item 6).

Simulation
tracks

2
Athena

reconstruction
‘. -

Hit calori-

meter cells

#

Set track
parameters
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For this exercise, we will use a pre-defined set of parameters by loading a file
prepared beforehand, which is relevant to the event under study: in the pop-up
window, click on the W box, and in the Persint-00-02-ee/example directory

choose the file Zmumu4023.p2ts. Close the window by clicking on - To

complete the loading of this “track parameter” file (Zmumu4023.p2ts), click on
the Compute icon ' of the File tool bar. The parameters from this file are then
displayed in the Set track parameters window (Fig.10). The resulting view is
shown in figure11.

ATLAS Experiment

Run 5745, Evant 4023

Figure 11: Resulting display of the exercise in section 6.3

6.4 Save, Export, and Print views

1. Save.

By clicking on the Save view as icon in the File tool bar the view displayed in
the main display can be saved as a .p2vf file to the directory of your choice, e.g.
Persint_working_files. This file (e.g. exercisel.p2vf) can be retrieved for later
use in Persint via the Open view icon.

. Export.

By clicking on the Export. .. icon in the File tool bar the view displayed in the main
display can be exported to the directory of your choice, e.g. persint_export_files.
There is a choice among several formats: .png, .jpg, -bmp for matrix graphics
or .svg, .ps, .pdf for vector graphics. These files can be used in publications
and presentations 2.

Note that the background color of the display can be chosen with the Background
color function of the Image menu. The grey background in figure 21d illustrates

'The Compute icon is one of the most used functions. Whenever in doubt about the status of a

display, clicking on this icon will compute the most recent requests for viewing.

2The inserted Captions, Labels, and Pictures are saved with the display.

|
]

Compute

s

Save view as. ..

600

bg@:!j

|

Open view

Open view. . .

-

Export. ..
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4 Clear > |

15 Compute ¥®C |

thlS featul"e. 3 Previous view |
+ Logo |

The edges of volumes can be highlighted with the Specific edge color function % o color
of the Image menu. Figurel2 shows a display without (a) and with (b) the % Specificedsecolor

Wire mode w’W
Specific edge color being enabled (with the "red color”). m:::is—a\iasina #A
The effect of the Anti-aliasing function aimed at smoothing the edges is shown in = projection >
ﬁgure 13 Specific edge color

& Anti-aliasing

Parsint

(a) Without specific edge color; with Persint logo (b) With specific edge color (red); without Persint

logo

Figure 12: The Specific edge color function and Persint logo of the Image menu.

(a) Without Anti-aliasing (b) With Anti-aliasing

Figure 13: The Anti-aliasing function of the Image menu.

Because the printer performs its own optimization, the effect of Anti-aliasing shown here is less apparent

than on a computer screen.

3.

Print. |
It is straightforward to use the Print icon in the File tool bar for printing the view L g4

of the main display. Print
rin

. Save special. ..

This function allows for comparison between two geometries. In particular, it
makes it possible to use a geometry from a file amdb_simrec different from the file
expected from an event file. Invoking the Save special... function produces the
following action:
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e The current view is saved as a . p2vf macro file named compare_persint_views.p2vf
into the $HOME/ . persint directory.

e The current view is also saved as a . png image file named persint-view-000.png
into the same directory.

If a compare_persint_views.p2vf file already exists because of a previous use of
the Save special ... function, a warning is issued which asks you if the existing
file should be loaded.

e If the answer is , the compare persint_views.p2vf file is overwritten
and the active display remains unchanged.
o If the answer is [[Yes)|, the existing compare persint _views.p2vf file is

loaded and displayed, and stays unchanged in the $HOME/ . persint directory.

In both cases, the view is saved as an image in the same directory with the name
persint-view-001.png L

You can either load or overwrite the
- previously saved view.

Warning: no geomerrical data
compatibility checks will be performed
during the loading process.

Do you want to load the previous view?

[ No Yes

Figure 14: Warning issued when using the Save special. .. function

The use of the Save special. .. function is illustrated in section9.3.

6.5 Dressing the display with captions, logos, and pictures

The Export function in the Image menu is used to make displays available for presenta-
tions and publications. It is possible to insert captions, logos, and figures in the displays,
as described below.

1. The Persint logo.
The Persint logo can be shown/hidden by checking/un-checking the function Logo
in the Image menu. The result can be seen in figure 12a (with the Persint logo
in the bottom-left corner) and figure 12b (without the Persint logo), and also in
figure 31a.

2. Add Caption.
A caption can be inserted in the following way: position the cursor at a cho- = Add aption
sen location in the display window and right-click. In the pop-up list choose B Add picture
Add caption. The text of the default caption can be edited as in figurels by ~— .~
adding text anywhere.
The editing is done line by line and the text format can be chosen with the options
provided:

Caption/picture

!The view number is incremented for each subsequent use of the Save special. .. function. If needed,
the files can be deleted from the directory.
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Insert special character: the special character palette appears when clicking
on the box; characters are inserted in the text bar at the bottom with a

” double-click” ; when the text is composed, click on to make it appear
in the caption. Special characters include the greek alphabet, arrows, etc.

Other available functions (icons, from left to right):
Load caption from...
Save caption as. ..
Add event information (Run#, Event#, Time stamp) Add caption icons
Clear the entire text of the caption

Font: By clicking on the Font box, the font and font size can be chosen.
Vertical alignment: text can be normal, superscript gy subscript-
Foreground: The Foreground box lets you choose the color of the font.

Background: Checking the Background box provides the background color of
selected text in the caption.

Add caption

Simulated Z--> p | event M
Event #4023 with two reconstructed muon tracks, ID tracks and hit calorimeter cells

This is how to insert "Captions" and "Pictures"
Vertical alignment allows for **"® and s p.ci

The text above this line was added to the cap(ion|; below is the default caption

Run Number: 5145
Event Number: 4023
Date: YYYY-MM-DD, hhmm=s CET

ExCut > TBC GeV
PtCut > TBC GeV
‘Vertex Cuts:
Z direction < 1 cm
Rphi< 1 cm

Muon: blue
Electron: black W
Celk: Tikes, EMC

Collection: .

Text format

Font: [ Lucida Grande,13,-1,5,50.0,0,0,0,0 =)

Vertical alignment: ["Normal 4

Foreground: E

Background: O

([ Cancel )

Figure 15: Add caption window. The last 3 paragraphs are the Default caption when
an Event is displayed
dociolil g

7 Clear view RV |
When opening a new Add Caption window, the previously entered text is displayed, | § Clear AMDG volures
. . . . £ Cle
ready for modifications. The following actions can be taken: ¢ Cloa labels

¢ Clear captions
. { Clear pictures

e Remove caption: =

Clear captions

Use the Clear captions function of the Clear icon;

or Right-click on the caption and choose Remove caption from the list.

-@ Add caption
° EXpOI‘t -@ Edit caption
. . . . . 4 R il
Captions are saved when using the function Export view as a picture. emove caption
Il Add picture

Actions on captions
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e Save view as a .p2vf file: the captions are saved with this function, and can

be retrieved with the .p2vf file.

e FEdit caption

Captions can be edited by Right-clicking on the caption and choosing Edit

caption from the menu.

The location of captions cannot be changed; if their location is not adequate, they
need to be removed and redone.

. Add picture.
Various logos or ad-hoc pictures can be inserted in a Persint display:

position the cursor at a chosen location in the display window and right-click.
In the pop-up list choose Add picture and choose from the proposed list (Fig. 16).

1

Add picture

No Text

Picture

@ ATLAS Logo
O CEA, IRFU Logo
O Scale

O From file...

Dimen:

Black
Transparent

0 [[] &9 30 [

)

Figure 16: Add picture window

http://atlas.ch

AILAY

EAFERIMENI

(a) Default

(b) Black

(c) Transparent

Figure 17: The four flavors of the ATLAS logos.

The ATLAS logo exists in four flavors:
without text. They are shown in figure 17. It is also possible to load any picture

from an existing file with From file .. ..

Finally, the size of the inserted picture can be adjusted with the Dimensions pa-
rameters in two ways: keeping the original aspect ratio or with independent

%,y dimensions .

Note two features of the Add Caption and Add picture functions:

e The location of pictures (logos) cannot be changed; if their location is not

adequate, they need to be removed and redone.

e The Clear captions or Clear pictures functions of the Clear menu offer two
options: erase all the captions or pictures or erase only the last. Another way
of removing one particular caption or picture, is to use the Remove caption
or Remove picture in the menu which appears when right-clicking on the

item to be removed.

1But remember that the text of the deleted caption is saved and appears when a new caption is

added.

(d) No text

default, black, transparent, and

@ Add caption
Bl Add picture

Caption/picture

dy & A Ly %

£ Clear view 'Y |
| £ Clear AMDB volumes

{ Clear AGDD volumes
I { Clear event

{ Clear labels

¢ Clear captions

{ Clear pictures

Clear captions

| -3 Add caption

Bl Add picture
4 Remove picture

Remove picture
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o
%

e e STl OATLAS
3-_//) (AR RILR)D EXPERIMENT
E ~ [, / i r\fl‘lrl\‘i

http://atlas.ch
Add picture
ATLAS logo "Default”, dim. 150x110

ATLAS logo "Black”, dim. 200x145
ATLAS logo "Transparent”, dim. 160x116
ATLAS logo "No text”, dim. 125x200

/ |

Add Caption

N\ ,f

ATLAS Experiment

Fun 5145, Evert 4023

/ With “Logo” checked in Jmage menu
Parain

Figure 18: Examples of inserting various captions, logos and pictures in a display.
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7 Exercise 2: Muon tracks in your own layout

In this exercise, we will create a custom made event from scratch. By following the
instructions, you should obtain the displays shown in figures 21d and 22b with possible
minor differences due to your choice of colors or navigation.

We want to start with an empty main display window: Start Persint and do not load
the saved file, by answering to the question in the pop-up window (page 16). If you

answered , use the Clear icon in the Image tool bar to clear the view in the main
display.

7.1 Generate muon tracks at the IP

In the Event tool bar, click on the Generate muon tracks icon. In the pop-up window
(Fig.19), click on the [+ Add muon| box four times. Fill in the parameters of the
generated four muons, for example:

1. n=10.30; ¢ =90° P, =1000 GeV; Xv=Yv=Zv=0

2. n=0.30; p =90° P, =100 GeV; Xv=Yv=Zv =0

3. 1=030;0p=90% P, =4GeV;Xv=Yv=Zv=0

4. n=0.30; p=90°% P, =—-4 GeV; Xv=Yv=Zv=0
This is done by double-clicking on the value to be edited and using the spinbox which
opens. Values can also be entered via the keyboard.
The muon momentum can be set either with P, or P. The [— >| box is used in the
following way:

e P,|— > P means that only P, can be edited, P being calculated accordingly. Furthermore

if one changes the value of 1, P; is kept fixed and P is recalculated.

e P, /< — P means that only P can be edited, P; being calculated accordingly. Furthermore
if one changes the value of 1, P is kept fixed and P, is recalculated.

The electric charge of a generated muon is determined by the sign of the Pt or P
momentum: e.g. track # 4 has negative charge.

Click on [OK . The four tracks originating from the interaction point (IP) are displayed:
whereas the 100 GeV and 1000 Gev tracks appear as straight and superposed, the two
4 GeV tracks show clear opposite curvatures in the magnetic field.

Let’s delete the 1000 GeV track by selection the appropriate line number and clicking
on the (— Remove muonJ box. The pop-up window now looks like figure 19. You may
want to choose specific colors for the tracks.

For future use, save the generated muon parameters as a .p2gm file by clicking on
the box inside the Generate muon tracks window. You may want to use your
persint_working_files directory as a destination.

Enter track parameters (n, @, Pt,.... Zv)
/ " Generated muons
i / Pt pr/P P Xv ™ v Color  ——pE E—
0.3 a0 * 100 GeV <-- 104.5... Oem Oem Ocm #fF0000
Remove muon
0.3 a0 ° 4 GeV <= 4.181.. Oecm 0Oecm Ocm
{ Removeall )
ap® -4 GeV <-- -4.18... 0cm Ocm 0cm R

Choose sign of electrical charge Gliskhat@lio R Geleoron

(" Open ) ((Save ) (Cancel ) (0K )

Click here to select a given muon

Figure 19: Pop-up window for muon track generation

Generate
muon tracks
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7.2 Display the detector using the AMDB interface

The Selector window (Figs. 2,21, and 22) gives access to the AMDB interface to select the

detector volumes to be displayed by clicking on the relevant pictogram.® The layout of

this window is determined by the two approximate symmetries of the muon spectrometer:

e The 8-fold symmetry with respect to ¢ of the toroids and the muon chambers in

terms of Large and Small sectors. Thus the octant wheel selector.

8100
BML O
I%E_g

(I

e The symmetry between Z > 0 and Z < 0 regions. Thus the Z-halves selector-

Clicking in the center of a “wheel” selects all sectors of a given detector. Clicking again
in the center erases that selection. Sectors can be selected individually by clicking in
the corresponding box, but only adjacent sectors can be displayed in this way. Figure 20
shows the functioning of the selector.

Object name

AMDE Click to Select/Remaove a Z-half
(Z-half will light-up)

Volume i Selection Wire

Choose color

10
BIL % @ [F— Click to Activate / Deactivate « wire mode »

Click to Select or Remove an Octant
(Octant will light-up)

Click Center to Select all Octants or Z-halves
Click again to Reset

Figure 20: Illustration of the working of the Octant and Z-half selectors

7.2.1 Draw MDT muon chambers

In the Selector window, click on the MDT triangle and then in the center of each of the
BIL, BML and BOL “wheels”. Click on the Compute icon in the Image tool bar to display

the view.

Now we want to simplify the view by choosing the BIL, BML and BOL chambers of the
upper (Phi=90°) sector:

Click on the center of each wheel (followed by a click on Compute) to erase the view

Click in the corresponding sector of each “wheel”, as shown in figure 21a

Click again on the Compute icon to display the modified view

The box at the left of the wheel allows you to choose your preferred color, if the default

color is not suitable.

You may want to try a “pastel” color and click again on the

Compute icon to display the modified view.

The Wire” box lets you choose between the full or wire modes. (sections?7.7.3 and 9.6).

7.2.2 Draw RPC muon chambers

Click on the RPC triangle and choose the BML and BOL chambers of the upper (Phi=90°)
sector by clicking on the corresponding sector of each “wheel”, as shown in figure 21b.
Click on the Compute icon to display the modified view. Again, you may want to choose

a color.

'The AGDD interface is described in section 7.5.

el
f

Compute
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7.2.3 Draw Inner Detector

In the Selector window, click on the ID triangle. Click in the left-most third of the
horizontal box, as shown in figure 21c, to select all sectors located at Z < 0 (1), Here we
have kept the default color. The view which has been composed appears in the Main
Display window and resembles figure 21d. Note that it is possible to click the Compute
icon only once, after having made all selections in succession.

AMDE (X AMDB 20
Volume | &h|  Selection | Wire
> MDT
Click ! v RPC

Click !

Click !
Click !

Click !

(a) Selection of MDT chambers (b) Selection of RPC chambers

AMDB (= ) x]

Volume Selection | Wire

» RPC

» TGC

» CSC

> MAT

» CAL

v ID Click !

ool
) meqo% TS

(c) Selection of the Inner detector (ID) (d) Resulting display. Note the background color (see sec-

tion 6.4, item 2, page 26)

Figure 21: Illustration of the operations (a,b,c) resulting in the display shown in (d).
The selections are highlighted inside a red ellipse.

7.2.4 Optimizing the view: a first try at navigation

It is appropriate, at this time, to have a preview of the Navigation tool (Fig.2) in order
to place the view at the center of the display, with the proper magnification. To do
this, we use the Navigation tool bar, in particular the Default mode which is the ‘magic
wand” used most often.

Click on the Default mode icon of the Navigation tool bar.

1To check if this horizontal box corresponds indeed to Z < 0, display the axes of the ATLAS coordinate
system by clicking on the Axes icon of the Image tool bar and choose e.g. Huge axes in the menu. When
done, erase the axes by choosing No axes. The coordinate axes are shown in figures 25, 67b, 68, and 69a.

3

Default mode
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1. Drag the view to the middle of the display with the right button of the
mouse pushed down. The displacements can be in any direction in the
display.

2. Rotate the central wheel of the mouse to zoom-in or zoom-out, so that
the view occupies the whole display.

3. The left button of the mouse is used to rotate the view in 3-dimentional
space.

The detailed description of the Navigation tool bar is in section 8 and Appendix E.3.

7.2.5 Starting anew

In case the result of an operation (navigation, addition of volumes, etc.) is not satisfac-
tory, the Previous view icon allows you to retrieve the view which was displayed before (}:I-
the latest Compute step. Up to ~ 100 previous steps can be retrieved.

Previous view

7.3 Place the calorimeters

In the Selector window, click on the CAL triangle and click successively on items in the
ECAL and HCAL lines. Make the selections shown in figure 22a: select the left-most rect-
angle to display the Z < 0 part of the calorimeters and choose the colors. The resulting
display is shown in figure 22b.

AMDE 00
| Volume | & | Selection | Wire |
» RPC
» TGC
b CSC
b MAT
v CAL

%

ECAL (@)1 mm]
4
L=a

HCAL (@)= 1= mm]
LY

v ID

%

1D & O ED
LTy

(a) Selection of ECAL and HCAL (b) Resulting display. Note that, contrary to figure 21d,

the background color has been set to ”white” in the
Image / Background color menu

Figure 22: Additional selections (a) resulting in the display shown in (b).

Comparing figure 21d and figure 22b, one notices that when the material of the calorime-
ters is included (Fig. 22b), the two low momentum tracks, generated with 4 GeV at the
IP, are bent more by the magnetic field, because of the energy loss in the calorimeters
(=~ 3 GeV on average) is now taken into account.

!The energy loss is taken into account as soon as one element of the calorimeter is chosen in the
Selector window even if the track does not cross the element which is displayed, as in figure 22b.
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7.4 Save files for future use

Let us suppose you must now interrupt your work.

In order to be able to retrieve, at any time, the view displayed in figure 22b, save it

as a .p2vf file to a directory of your choice (e.g. persint-working-files, as suggested in B
section 6.1). This is done with the Save view as icon of the File tool bar.

The saved view, e.g. exercise2.p2vf, only contains the detector volumes. It is neces- Save view as...
sary to also save the generated muons as a .p2gn file from within the pop-up menu of

figure 19. If not already done, open the Muon generation pop-up window and save the

parameters by clicking on the box. You may again choose the persint-working-

files directory to store the saved exercise2.p2gn file.

You may also want to export the view in order to use it for a presentation: use the Export E
icon of the File tool bar to save it, e.g., as my-presentation.png to the persint-export-files
directory. Export. ...

7.5 Place inert material using the AGDD interface

With the AGDD pane in the Selector window, one selects the inert material to be
displayed '. In figure23, we have displayed one of the two endcap toroids, the rail
assembly, and the saddle for the barrel calorimeters.

Selections in the AGDD pane can be made at several levels of detail, according to the
tree structure which is provided.

AGDD 00

Volume Id.
v W List_of independant_trees
v E ECT_Toroids

» ® ECT_ToroidN
"1 ECT_ToroidP
BAR_Toroid
Feet
RailAssembly
JFSH_AFrame_,
JFSH_Shield
JDSH_Shield
JTSH_Shield
ppP2
MBAP_AccessPlatform
MBAP_Sectorl3
MBWH_BigWheels
SADL_CalorimeterSaddle
TBWH_BigWheels
TGC3_BigWheels
TGC1_BigWheels
MDTRail
Solenoid
servicesAtZ0

Y vV Y Y Y Y Y Y Y Y Y Y YYIYYYY
[ m]a] (]

100000mAaEEI

E Boolean operations

0 @ envelope levels

| AMDB | AGDD = Magnetic field X0 |

Figure 23: Selections made in the AGDD pane to obtain the modified display.

7.6 The Dead material function

The Dead material function is used for taking into account dead material traversed by
tracks, even when the material is not selected for display.

! Calorimeters (ECAL, HCAL) and the inner detector (ID) are accessed with the AMDB pane.
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7.6.1 Preparing the working view

If you resume work with a new session of Persint, you want to display the view of
figure 22b. When starting Persint anew, the view which was in use in the previous ses-
sion is reloaded, provided you answer in the initial pop-up window (Figure on
page 16). This is because the current view is automatically saved when quitting Persint.
In any case, the view may be retrieved since it was saved as exercise2.p2vf in sec-
tion 7.4 by clicking on the Open view icon. Using the window which opens, choose the

file exercise2.p2vf in the persint-working-files directory and click on

You must also load the file containing the generated muon tracks which was saved as
exercise2.p2gm.

Click on the Generate muon tracks icon and, in the Muon generation window,
click on the box to retrieve the exercise2.p2gnm file saved in your

persint- export-files directory. !

If necessary, click on the Compute icon. Figure 22b should now be displayed.

7.6.2 Use of the Dead material function

We now have figure 22b as working display, with the detectors and the 3 generated muon
tracks. Note the visible curvature of the 4 GeV tracks, as they loose energy in crossing
the calorimeters.

We will now remove the calorimeters from the display: in the AMDB pane of the Selector
window, in the CAL arborescence deselect ECAL and HCAL by clicking in the center of
the two wheels (see Fig.22a). When hitting the Compute icon of the Image menu, the
tracks now appear less curved, i.e. without the energy loss.

The energy loss can however be restored by clicking on the Use all dead matter icon of the
Events menu. With this icon one can switch to displaying the muons with or without
energy loss, even though the calorimeters are not shown in the display. This feature
comes in handy for showing realistic muon tracks when material must be ommitted for

600

& 8 B = o
peniew

Open view. . .

Generate
muon tracks
e

o

Compute

T

clarity of the view. Use all dead matter

(a) Muon tracks without energy loss in dead matter (b) Muon tracks with energy loss in dead matter

Figure 24: Display of figure 22b, but where the calorimeters are not selected for display.
Use displayed dead matter only has been selected in a), Use all dead matter in b).

If this file was not saved, it is easy to generate the muon tracks again, as indicated in section 7.1.
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7.7 Look at the event in detail

In this section, we will continue work with figure22b. If necessary, restore that view
as shown in section 7.6.1. We will look at the ATLAS coordinate system, produce a

projected view, and finally zoom-in to look at the MDT tubes in detail.

7.7.1 Show ATLAS coordinate system
The ATLAS coordinate system is shown in Appendix C (Fig. 132).

1. Click on the arrow of the Axes icon and choose Huge axes.

2. Click on the arrow of the Projection icon and choose Invert.
The view is inverted with respect to the Z axis.
Go back to the original orientation by repeating the Invert operation.

3. Erase the axes by clicking on the Axes icon again and choose No axes.

7.7.2 View the event in the X-projection

Click on the arrow in the Projection icon and choose X.

A projection perpendicular to the X-axis is displayed, in the (Y, Z) plane (Fig. 25).

--i--," 33 ¥ _i_V
No axes
Tiny axes
Small axes
Medium axes
Large axes

v Huge axes

B Axes color...
Axes
X '
£nv b
iD 3
v X ;X
Y ®Y ¢
z ®Z
©p
Invert 381
Projection

Figure 25: Resulting X-view from manipulations in section 7.7.2. The energy labels have

been added by hand. See section 9.1.2 for labels generated by Persint.
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7.7.3 Zoom-in on muon chambers

1. Select the Default mode in the Navigation tool bar and, with the “wheel” (“central &
button”) of the mouse pushed down, select a region in the BML chamber including Default mode
the two tracks as shown by the red rectangle in figure 25.

2. In the Selector window, choose the ¢ ‘MDT options’’ tab and check the boxes as
shown in figure 26a.
Choose the ¢ ‘RPC options’’ tab and check the boxes as shown in figure 26b.

3. Click on the Compute icon.

4. Note that the selections can be made to produce displays in the solid or wire
modes.

™

means: item displayed in solid mode

means: item displayed in wire mode

(] [

means: item not displayed

MDT options RPC/TGC options
I Cross plate (] Long beams ™ Tubes envelop HlEnvelar
aTubes . . ESrrips S
[1End-plugs [ | Faraday-cages [ | Stair-casing M Strips 2 1
v
(a) Selected MDT options (b) Selected RPC options

Figure 26: Selections made in the Option tabs in the Selector window

A view similar to figure 27 should be displayed. It shows the three generated muon
tracks crossing the two layers of MDT tubes and RPC Z-strips, in the BML station ! .
The two colors of the tubes alternate every 8 tubes (for easier tube identification) and
can be chosen in the ¢ ‘MDT options’’ of the Selector window (Fig. 26a.). The red open
squares represent the centers of multiple scattering used by the program.

The display in figure 27 can
again be saved as a .p2vf
file into one of your work- \
ing directories (use the Save

view icon). It can be re- . ! )

. - . e Rt s S
trieved with the Open view \ :
icon. The same is true '

for the generated tracks: |mmooo
they can be saved as a

\'\.\ ‘
=
.p2gn file and retrieved by “

opening this file inside the ‘

Muon generation window | " .

opened with the Generate
muon tracks icon (see sec- Figure 27: Resulting X-view from manipulations in

tion 7.6.1). section 7.7.3.

LA detector station is the mechanical entity holding several layers of detector planes. For example, a
BML MDT station is made of two triplets of drift tubes (see fig. 27).
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8 Exercise 3: Practicing Navigation

The interface to the various graphics applications of Persint is provided by the Navigation tool bar
on the right hand side of the display (Fig.2 and Appendix E.3). Its functions allow spa-
tial navigation and modifications of the visualization properties.

The desired perspective is obtained by changing the viewing point and the viewed point,
by changing the focal length of the observer eye. The view may be rotated, displaced,

enlarged or made smaller (Zoom). For Zoom in/out and Rotation, the amplitude of

movements can be chosen with the Navigation scale gauge.

Figure 28: The scale can be changed by moving the cursor or
by opening the spinbox with a click on the three dots (=), and

setting the scale with the keyboard. The default value of 1.0000

is displayed.

8.1 Preparing the working view

In this section, we will learn to use the spatial navigation tools and start with the view

" Edit scale...

Set navigation scale:

10000 8
[ Cancel

]

which was saved as exercise2.p2vf in the previous exercise (section 7.4, Fig. 22b).

Start the Persint application and click on the Open view icon of the File tool bar. Load
the exercise2.p2vf file, from the persint_working_files directory. The view of figure 22b

is now displayed.

AMDB AMDB AMDE
Volume Selection |VOIume ection Volume E Selection
= MDT 2598, - TGC
S0 BOG %%@ ) o Csc
~BiL e == 0 2 MAT
Qr A=A
> e PO m— <>
B 500 %% - BARREL TOROID %%g o
s - EES Qoﬂ o
- BML S%Dg == %ﬁé‘? - ENDCAP TOROID (&Y %E;wﬂ? (=
AR ~EIL Qoﬂ )
\BT e
- BMS D‘C}% o QU - FEET 808 [ -
" - 8%%3 == e
- BOL S%Dg ) .%% - SHIELD E==
2% -t [l 308 m— o cAL
~0s [l §0S mmm x e
e - EMS eod = L ECAL [ | 'O= -]
2578, s LS
.. BIM @OU | ‘GD .‘.‘
B oL [l 808 mmm ~HCAL N 500G =ro
290, €Jrs T
BIR WOG' [ S0 21D
%% - EOS %%8 = I
..... e
.. BEE %%g —— - RPC b Q]%G B

(a) Barrel MDTchambers

(b) Endcap MDTchambers

(c) Selection of toroid coils and feet

Figure 29: Additional choices made in the Selector window to display the muon spec-

trometer

From the Selector window, add a second adjacent large sector and one adjacent sector of

small MDT chambers (fig. 29a) and a few endcap MDT chambers (Fig.29b). Check the
result by clicking on the Compute icon. Three barrel toroid coils !, one of the endcap
toroids, as well as the detector feet are added when the selection shown in figure 29¢ are
made?. When clicking on the Compute icon, the view of figure 30 is displayed.

!The toroids can be displayed in much more detail using the AGDD pane of the Selector window.
2Note the selections of HCAL, ECAL, and ID associated with the selections already made in exercise 2.

Navigation scale

600

bg@:!j

Open view

Open view. ..
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Before starting with the navigation, save the view for future use: click on the Save view as
icon and save the view as Exercise3.p2vf into the Persint_working files directory.

EDLF4Z-+6/EOL/Eta6 /Phid/MDT/ML2/ : ‘—'—._:;—
X =-653.01cm | Y = 1020.26 cm | Z = 2160.66 cmE g
R=1211.34cm | =12262"|n=1.34

7

Figure 30: Detector layout resulting from the additional selections made in Exercise 3.
The information box is obtained by positioning the cursor on the chosen volume
EOLF4Z+6 (see section9.1.1).

8.2

The Default mode: a magic wand

The Default mode is the most powerful function of the Navigation tool bar. With this
icon selected, all three buttons of the mouse can be used to perform the most frequent
navigation actions, as we have already seen in section 7.2.4.

1.

The left button of the mouse is used to rotate the view in 3-dimentional space.
Keep the left button pushed down and move the cursor anywhere inside the display.
Start with simple movements, e.g. horizontal, vertical, and then use more complex
movements. The actions and results are very much intuitive.

. Rotate the central wheel of the mouse to zoom-in or zoom-out. Practice by

making successive reverse zooms to the view.

. With the right button of the mouse pushed down, the view can be translated in

any direction inside the display.

. By pushing the central wheel down (without rotating it), one selects a rectangular

zone to be zoomed, as already exercised in section7.7.3 (Fig.25). This action is
called Zoom on custom area.

. By pushing and releasing the right button of the mouse on any detector volume,

a pop-up menu is displayed from which various operations on the volumes can be
performed. These operations include moving volumes, adding labels, captions, or
pictures, and are described in section 9.

&

Default mode
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Note that the amplitude of the first two actions (rotation and Zoom in/out) can be tuned
with the Navigation scale. Remember that the scale can also be set with the Spinbox
accessible with a click on the ) of the Navigation scale icon.

8.3

Single functions

The 5 functions described below can all be performed with the Default mode icon (the
magic wand) and are in fact redundant. However, when repeating the same action many
times, it may be advantageous to use a single function.

1.

8.4

Translation
Activate the Translation icon and use the left button of the mouse to translate
the view in any direction.

. Zoom-in

Activate the Zoom-in icon and click on the left button to zoom-in on the view.

. Zoom-out

Activate the Zoom-out icon and click on the left button to zoom-out on the view.

Zoom on custom area
Activate this icon and use the left button to select a region (red rectangle). When
the button is released, the zoom of the selected rectangle is performed.

. Rotation

Activate this icon and use the left button to rotate the view around the center
point of the display, with the appropriate movements of the cursor.

More functions

The remaining functions of the Navigation tool bar are:

1.

Initial Zoom

Activate the Initial zoom icon with the left button to retrieve the original zoom
parameters. Note that if this function is used on a projected view (e.g. X-view),
the Initial zoom action brings back the 3-D view.

. Set center

Selecting the Set center icon and then clicking on a given volume centers the view
on that volume . The point around which a view is rotated is chosen in this way.

. Navigation scale

As already mentioned, with this function it possible to change the amplitude of
two navigation actions: Rotation and Zoom in/out.

. Focal length

The nominal focal length is 35 mm. It can be changed with the cursor of the
Focal length icon, and set back to the nominal value with the Reset focal length
icon.

. Isometric view

By clicking on this icon, one produces an isometric view (infinite focal length). To
return to the previous focal length, click on the icon again.

Some results of using these functions are shown in figure 31, where the same volumes are
shown with different perspectives.

!This action is more efficient (faster) than using the Translation function.

T bkt cabe

O

Sot nvipation wcale

=

Carew ) 00
/.a Spinbox

Navigation scale

P

Translation
==
&,
Zoom-in
=
o
Zoom-out
e
L3
-

Zoom on
custom area

D

Rotation

e
U

Initial zoom

4

Set center

Focal length and
Reset icons

N

Isometric view
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//}HZ#»EHCL/EHE/PNWMTfMLZ
ki e s
Persint
Praraint

(e) Z projection

(f) X projection

Figure 31: Defining the viewing perspective

The two remaining functions will be explained in the next exercise (Section9).

1. Volume information

2. Selection mode

i

Volume information

45

Selection mode
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9 Exercise 4: Exploring more features

We start with the view saved at the end of exercise 3. Click on the Open view icon and 8&0 (:1 D= o
open the file Exercise3.p2vf from your Persint_working_files directory. This should -+ —
display the view of figure 30. Open view. ..

9.1 Volume information labels
9.1.1 Volume identification with information boxes

You will have noticed that by positioning the cursor on a volume, an information box is
shown which displays the identity of the volume and its geometrical parameters. It is a
convenient feature to identify any volume in the layout.

9.1.2 Label maker

When saving displays to be used for publications or presentations, it is useful to be
able to also display the volume parameters (volume identification, position, ...) and
an explanatory text. This is achieved with a feature which makes labels, as explained
below. !

1. Default labels
By right-clicking on a volume (in this case a MDT chamber) ? and releasing the

button, one produces the pop- up window of figure 32a. Choose (Add /Remove label)

/ (Add default label) to obtain the default label which displays the “Hardware
name” of the chosen muon chamber (BOL5C05) 2, as shown in figure 32b. If the
geometry file does not provide the ”Hardware name” the ”Software name” is dis-
played.

F Select volume |
~ Select super-volume ‘ ‘

2 Move volume to infinity
7 Move super volume to infinity

4 Center on volume

I&] Add/Remove label L@l @ Add default label
? Volume information @ Add customised label
¥ Remove label

-
L

<@ Add caption
Bl Add picture

(a) Pop-up window when right-clicking on a (b) Default label for a MDT chamber
volume in the Display window.

doo il s

Figure 32: Making a Default label [ESeaicn 6 oY
i ot
To remove the default label, repeat the operation by right-clicking on the same | g
volume and choose . The Clear labels function of the Image menu = ="
clears all labels in the display. The Reload event function has the same effect. @ jabels
2. Customized labels Reload event

The label can be customized by clicking [Add customised labelj (figure 32a). In
the window which opens (Fig. 33), the complete Volume information appears and
room for Additional text is provided.

'Labels are saved when using the Export View... and Save view as .p2vf file... functions.

2Track labels are obtained with the same procedure, by clicking on the tracks (Fig 64 in section 10.5).

3BOL: Barrel Outer Large chamber; 5: 5" chamber from | Z |= 0; C side (Z < 0) [A side (Z > 0];
05: sector number. See reference [6] for conventions on chamber numbering.
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The Customized label has 5 lines of information:

(a) Hardware name of the chamber (EOL6AOT)
(b

(c

Software name of the chamber.

X,Y,Z coordinates of the cursor.

)
)
)
)

(d) R, ¢,n coordinates of the cursor.
(e) Magnetic field (B, By, B.)
Volume information
gHardware name EOLGAQO7
I Name EOLF4Z+6/EOL/Eta6/Phi4/MDT/ML2/

"] Cartesian coord. X = -625.33cm | ¥ =1011.35¢cm | Z = 2149.73 ¢m
Et\rlindr. coord. R=1189.06cm | =121.73"|n=1.35

["1 Magnetic field  Br = 0.00048634 T | Bp = -4.931e-05 T | Bz = 0.00060972 T

Additional text

This is a customized label with additional text.

This label shows information on the chosen MDT chamber.
Only the "Hardware name" and the cylindrical coordinates are
selected for display.

'aaa

The position of the label is "NE" wrt.the position of the cursor.

[Other... |-3-' ['Normal I-H I L I

Position : | NE = @

4

Figure 33: Pop-up window when choosing Customised label in the window of figure 32a.

It is possible to place the label at four different positions with respect to the
cursor position (SE, SW, NW, NE). Click on -, after having chosen “NE”; the
customized label of figure 34 appears in the NE position.

EQLBADT
A=18906cm| ¢ =12173" I n= 135

This is a customized label with additional text.

This label shows information on the chosen MDT chamber.
Only the "Hardware name" and the cylindrical coordinates are
selected for display.

The position of the label is "NE" wrt.the position of the cursor. |

|

[

*

decicial L
£ Clear view EV

i 4 Clear AMDB volumes

# Clear AGDD volumes

£ Clear event

£ Clear labels

£ Clear captions

£ Clear pictures

Figure 34: Custom label for an endcap MDT chamber

To remove the customized label, repeat the operation by right-clicking on the

same volume and choosing {Remove label). The Clear labels function clears all Clear labels

labels in the display. The Reload event function has the same effect, if indeed an
event is displayed. @

Reload event
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9.2 Hide/Displace volumes or super-volumes

There are several ways to remove a volume or super-volume from the display. Technically
this is done by setting the coordinates of a volume to very high values, thus the term
“Move to infinity” used in the relevant functions.

EOLGAD7)

EOL5A07)

EOSBAOR
EOS5A08]
EOS4ADS]

(b) Partial display after the hiding of 3 volumes
and 2 super volumes

(a) Partial display of the initial layout of endcap
chambers

Figure 35: Hiding volumes and super volumes

9.2.1 Hide volumes

The simplest way to hide a volume is to right-click on a volume, release the button

and choose [Move volume to inﬁnityj or [Move super volume to inﬁnityj in the pop-up

window (Fig.32a). In the following example, we proceed to hide MDT endcap cham-

bers: 3 volumes and 2 super modules in two neighboring sector. The procedure is simply

repeated for each chosen volume (5 operations). Figure 35 shows a partial display of the

initial layout and the result of the hiding. !

In order to restore the initial layout, simply click on Displaced volumes of the Volumes

menu. In the pop-up window (Fig.36), choose [Reset all the displacements] and click @
F

on : the initial view is restored.

Displaced volumes

It is also possible to individually select the volumes to be returned to the display by select-
ing each volume in the pop-up window (Fig. 36) and clicking on [Reset volume displacement} .

The action takes place when the box it clicked on.

Volume X Offset ¥ Offset Z Offset Ax Angle | Ay Angle | Az Angle ‘

v s w o

t &) Refresh 4

EOL_F4_Z+6
EOL_F4_2Z+5
EOS_F4_Z+6/EQS/Eta6/Phi4/MDT/ML2/
EOS_F4_2Z2+5/EOS/Eta5/Phi4/MDT/ML2/
EQS_F4_Z+4/EQS/Etad/Phi4/MDT/ML2/

Reset volume displacement

19999.00 cm | 19999.00 cm
19999.00 cm | 19999.00 cm
19999.00 cm | 19999.00 cm
19999.00 cm | 19999.00 cm
19999.00 cm | 19999.00 cm

19999.00 cm
19999.00 cm
19999.00 cm
19999.00 cm
19999.00 cm

0.00°"°
0.00°
0.00°"
0.00°
0.00°

0.00®
0.00"
0.00"
0.00"
0.00"

0.00"
0.00"
0.00"
0.00"
0.00"

.( ¢ Reset all displacements \ (

Close

Figure 36: Pop-up window showing displaced volumes

IThe labels in figure 35a are produced as explained in section 9.1.2



47 9 EXERCISE4: EXPLORING MORE FEATURES

9.2.2 Hiding volumes, the fast way with Selection mode

If a number of volumes or super volumes must be hidden, there is a fast and efficient
way to do so with the Selection mode of the Navigation tool bar.

Click on the Selection mode icon of the Navigation

® ) 7 Selected volumes tool bar and click on the volumes or super volumes
to be displaced. The list of selected items appears
EOL_F4_Z+6 . . .
EOL F4_7+5 in the Selected volumes pop-up window, shown in
EOS F4_Z+6/EOS/Etab /Phid /MDT /MLZ [ ﬁgure 37

EOS_F4_Z+5 /EOS/Etas /Phi4,/MDT /ML2 /

FOSFE_Z+4JEOS/Erad /PRI MDT/ML2 | A left-click selects a volume (in blue).

(" & Edit color ) (1) Move to infinity ) A right-click selects a super volume (in red).
Use the

per) volumes listed in the window. Note that
volumes to be hidden can also be selected us-
ing the functions available in the window shown
(CMore) (7 un-selectall ) in figure32a.  This window is obtained by
right-clicking on a volume, the Default mode
being selected in the Navigation tool bar. In this
Figure 37: Selected volumes window case, the list of volumes to be hidden is made
by choosing Select volume or Select super volume.
The color of all selected volumes and super vol-

umes can be changed with the | Edit color| button. [Un-select all), can be used to

clear the entire list. With the button, one makes a selection of sectors (see
also10.3). The button gives access to two more functions concerning ” ATHENA

reconstructed tracks”: (see 11.1.3) and (see 11.1.1 and 11.1.3).

button to hide the (su-

Inv. mass ¢ Sectors )

Edit shape

[T Close afterwards

A

9.2.3 Displacements of volumes
It is possible to change the display parameters of volumes by selecting the Volume

information icon in the Navigation tool bar and clicking on the volume to be altered.

This opens the Modify volume window shown in
figure 38. | = Modify volume

+

Selection mode

?

Volume
information

Volume [ Supervolume

The functions used most often are:
8 EML_F4_Z+5/EML/Eta5/Phi4/MDT/ML2/ O EML_F4_Z+5

1. Selecting a volume or super volume by clicking on
the appropriate button. Color

2. Changing the color of the volume/super volume. I |

3. Hiding volume/super volume (i.e. “Move to in- Translation
finity”), a function already performed by other Xoffset : |0.00 cm 8] O
means (section9.2.1). Yoffset: 0.00 cm ® O

Z offset:  0.00 em (2 €

Click on - to view the changes made to the _
( Reset translation ) ( L Move to inﬁniw)

selected volume.

Rotation

The two other features (Translation and Rotation)
Ax angle: 0.00° @

were used extensively during the design of the muon =

. .« . . 5 o 2 P
spectrometer and during the commissioning phase fyangle: 0.00° I}
. . . o 2l Fay
with cosmic rays. The development of the recon- Azangle: 0.00°
struction software also benefited from this tool.

Cancel

A

Figure 38: Modify volume window
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9.3 Compare geometries

The comparison of displays obtained with different

geometries can be performed with the Save special... function described in section 6.4.
Below are two figures which illustrate its use. They were obtained with two different
geometries of the supporting structure of ATLAS (the "feet”). The following exercise is
done with a pre-loaded .p2vf file located in the directory Persint-00-02-ee /example. It
can be repeated with any other .p2vf file of your choice.

1. First, using the Open view function, we display the feet structure by loading the

relevant file compare_persint_views.p2vf, located in the directory Persint-00-02-
ee/ example . The expected geometry is amdb_simrec.r.04.01 and should be
loaded by choosing in the warning box. This geometry file is located in the
Persint-00-02-ee/ AmdcData/share directory.
When the ATLAS "feet” are displayed, we perform a zoom to get figure 39a. By
using the Save special... function of the File menu and answering to the
prompt, the .p2vf file is saved into the $HOME/ .persint directory and an image
file persint-view-000.png is written into the same directory.

2. We now change the geometry description. Click on the Data manager icon of the
File menu and choose the Volumes tab. Click on - and choose the new geom-

etry file amdb_simrec.r.03.01.Initial.Light.EIL.BML.S13.Patch.! Close the
Data manager window. We now want to load the compare _persint_views.p2vf
file again to display it with the new geometry. Proceed as above, using the Open
view function. Answer in the warning box in order to use the new geome-
try, and not the geometry expected by the .p2vf file. Ignore the AGDD warning.
Perform a zoom to obtain figure 39b. Use the Save special... function of the
File menu again, answer to the prompt, and the new display is saved as
persint-view-001.png into the $HOME/ . persint directory.

3. These two .png images are now available for comparisons. Toggling between the
two images, persint-view-000.png and persint-view-001.png shows the differences:
there is less material in the first.

(a) First feet geometry (b) Second feet geometry

Figure 39: Two "feet geometries” to be compared.

!Geometry files of the amdc _simrec type are available in the Persint-00-02-ee/AmdcData/share
directory.

800

EoBE= o

Open view

Open view. ..

(= =
Data manager
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9.4 Detect volume clashes

This feature was used extensively during the building of the geometry files (GeoModel).
It is not commonly used, except by developers of geometry data bases. For completeness,
its functioning is explained below.

We continue working with the display of figure 35a, which should be the current view.
If not, you can use one of the following three methods to get this view back: <1:|

e Use the Previous view function of the Image tool bar once or several times. Previous view

e In the pop-up window of Displaced volumes (Fig. 36) click on [Reset all the displacementsj

and then on .

e If the view has been saved, as indicated in section 8.1, use the Open view function
to load the saved Exercise3.p2vf file.

We now want to displace a volume to produce a clash between two volumes. a
In the active display (Fig.40a), zoom on the area shown in red by using the Zoom on z,om on
custom area of the navigation tool bar. We obtain figure 40b. custom area

(a) Starting display (same as Fig. 30) (b) Detailed view of end cap MDT chambers after zoom

Figure 40: Displays used for detecting clashes

1. Right-click on the EOL chamber !(the violet volume) and choose Volume infor- 7
mation in the pop-up window 2.

Volume
2. In the Modify volume window, select the Supervolume EOL_F4_Z+6 and set the information
Ax angle to 6 degrees, as shown in figure 41a. After performing a Zoom, we obtain
figure 41b. Ay G b [

Hide clashes
Partially show clashes

3. To identify the clashes resulting from the rotation, click on Clashes in the Volumes goenios,
menu (down arrow) and check Show all clashes. Clashes
Click on the Clashes triangle to open the Clashes window which lists the 5 pairs
of volumes which present a clash (Fig.42a). C‘?Lh'

ashnes

The list of clashes can be saved as a .txt file with , or stored for future
comparisons within Persint with the box. The default name is "Backupno.1".

!'Remember that a volume can be identified by positioning the cursor on it, in order to activate the
information box (see section9.1.1).
2 Alternatively, you can select Volume information in the Navigation tool bar, and click on the volume.



50 9 EXERCISE4: EXPLORING MORE FEATURES

Volume / Supervolume
(O EOL_F4_Z+6/EOL/Eta6/Phi4/MDT/ML2/ @ EOL_F4_Z+6

Color

I | | I The clah between the twe volmes is indicated by the red line

Transiation

Xoffset: [pooem 2] e
Voflset: 000cm (2] e

EOLF4Z+6/EOL/Etat/Phid /MDT/ML2/
Zoffsetz0.00 cm () =—— Volume displaced by 6 degrees (Ax angle)

(" Reset translation ) ("G Move to infinity )

]

Rotation

Acangle: 600 [ e ‘

Ayangle: 0.00° @ —_——
Azangle: 0.00° @ —_——

(o) @O0

(a) Modify volume window for (b) BOL volume displaced by 6°; the clashes are in red
rotating chambers

Figure 41: Rotate EOL chamber by 6°

4. We now change the rotation of the same EOL chamber to 3° (instead of 6°) by
changing the value in the Modify volume window of figure 41a.

A

After having closed the window with -, click on the Clashes triangle to display Clashes

again the clashing volumes: only two clashes are left.
Again, the list of clashes can be saved as a .txt file with the box, or
stored for future comparisons within Persint with the box. This time the

default name is "Backup no.2".

5. Finally, we can compare the two stored geometries. In the Clashes window, click
on the box. In the window which appears (Fig.42b), select the two

stored files "Backupno.2" and "Backupuno.1" and click on -

Use the tabs on the left hand side to perform the comparisons:

_ Clashes.
[

Compare between : [ Backup no. 2 [%) and [Backupno.1 %) (* & Compare)

Velume no. 1 Velume no. 2
EOL_F4_Z+6_CRO EOS_F4_Z+6/EQS/Etab/Phi:
EOL_F4_Z+6/EOL/Eta6,/Phi4/MDT/ML2/ EOS_F4_Z+5_CRO
EOL_F4_Z+6/EOL/Eta6/Phi4/MDT/ML2/ EOS_F4_Z+6_CRO
EOL_F4_Z+6/ECL/Eta6/Phi4/MDT/ML2/ | EOS_F4_Z+5/EOS/Eta5/Phi:
EOL_F4_Z+6/EOL/Eta6/Phi4/MDT/ML2/ | EOS_F4_Z+6/EQS/Eta6/Phi:

Volume no. 1 Volume no. 2
EOL_F4_Z+6/EOL/Eta6/Phi4/MDT/ML2/ | EOS_F4_Z+5/EOS/Eta5/Phi4/MDT/MLL/
EOL_F4_2+6/EOL/Eta6/Phi4/MDT/ML2/ | EOS_F4_2+6/EOS/Eta6/Phi4/MDT/MLL/

(T I I FTR S

- ] Jlr]
ﬁ [ € Center on clash ) ( 7 Volume information )
( Bstore ) ( £ Export ) € <) Compare 3

[New clashes _ Clashes solved | Remaining clashes |

p
A

(a) Clashes window when EOL is rotated by 6 degrees. (b) Result of comparing clashes

Figure 42: Compare clashes for two geometries
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9.5 Animation

It is possible to produce an animation of a displayed view. Parameters such as ampli-
tudes of rotation and zoom, number of iterations can be chosen. The generated frames
can be used as input for video software.

You may use any view made with Persint, but for simplicity, we start with the view of

800

& 8B

B

Open view

figure 30. Choose the function Open view of the Image menu. Open the file Exercise3.p2viopen view. ..

in the directory Persint_working files where it was saved in section 8.1.

Choose Animation in the Tools menu. In the Generating animation window which opens
(figure 43), choose the parameters, e.g. those indicated in the caption below.

Figure 43:
The parameters are:
- Number of steps (iterations)

" Generating animation...

Warning : This feature is under development.

Iterations 36 T

- The parameters of the motion (Direction Rotation
and angle of rotation; Zoom factor)

. Direction 0,0° r?
Options:
- Save images Angle 100° 2
If the generated frames are to be saved, —
check the Save images box (the default S 0,000 )

is "no save”), choose the Directory, the

filename and the format (extension .png, 8 save images

bmp or . Jpg) Directory ( {Users fernwein/Desktop/Animation persint 3
- Stereoscopic mode — .
Filename animation . 0001 7 [.png [%

[T Steroscopic mode I Cancel

v

Clicking on the box will start the animation. With the parameters chosen (Fig. 43),
the view rotates in 36 steps of 10 degrees, for a complete revolution.

The Save images box having been checked, 36 files are saved in the specified directory
for future use by video software. With the Stereoscopic mode enabled, the number of
saved frames would be doubled.

IE’ Window Help

& Edit color palette

&8 Animation...

Animation
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9.6 Wire mode
The wire mode exists in two flavors:

1. Global Wire Mode.

In the Wire mode, the program bypasses the time-consuming computation of hid-
den faces and volume intersections. This results in a much faster processing of the
view for display and optimal fluidity in the displacements.

It can therefore be advantageous to switch to the wire mode when making complex
navigations, and go back to the full volume display when finished.

2. Partial Wire Mode.

By checking the appropri- ANDE Y-l
ate box in the “Wire” col-
. . Volume & Selection Wire
umn in the Selector window,
o
groups of volumes can be BIL l’é?é- =]
displayed in the fuu or in the 8IS .:‘O.e — |Click to switch on/off wire mode for this volume
. . . T -
wire mode. This function S0
BML gog=— O
i ; T
is used to make certain vol- o
. BMS o O
umes ”transparent” in order Py -
to get a view ”inside” the
detector. Figure 44: Partial Wire Mode switched on.

The partial wire mode can also be chosen in the ”MDT options” and "RPC/TGC
options” panes (see Fig. 26).

9.7 Magnetic Field Interface

The Magnetic Filed interface provides a fully interactive 3D visualization of the magnetic
field. This application is coupled to a set of subroutines that read the field database and
compute the field at any given point.

9.7.1 Loading a Magnetic Field file

The muon spectrometer magnetic field map is loaded from the Magnetic field tab of the
Data manager window (Fig.5). Instruction are given in section6.1.1, item 2, page 21.

Click on |Modify... |, and the Magnetic field wizard proposes several possible actions,
first for the spectrometer (toroidal) field map (Fig. 6a):

° to load the default map initially proposed ! or chosen as follows:

. to choose from maps proposed in Persint-00-02-ee/BFieldData/share

) to download additional files from a CERN repository to the

Persint-00-02-ee/BFieldData/share directory

Clicking the button will load the chosen spectrometer field map, and will
prompt two options for the solenoid field map (Fig.6b):
i) Use the muon spectrometer map for the solenoid map 2 ;

ii) Use a specific map which needs to be ed or ed.

Finally you are asked if the field maps you just loaded should be your future default
maps (Fig. 7).

When running Persint on Ixplus at CERN for the first time, there is no default map available.
2 All spectrometer field maps contain a generic description of the solenoid field in the inner detector
region

§ \W‘ire mode

Wire mode
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9.7.2 Display B-field lines

The magnetic field interface is launched in the following way: in the Selector window
open the Magnetic field pane (Fig.45a) and check the Display magnetic field box.
The field is visualized by means of arrows located at a series of lattice points. The
direction and length of the arrow corresponds to to the direction and magnitude of the
magnetic field. The field display can be customized with the following choices:

- Color of the arrows

- Linear or logarithmic scale

- 3D or projections, at x, y, or z positions

- Lattice for field display

The vector field can be built either in a very localized region or over large distances. {:';.

Once all properties of the field visualization are defined, the display is obtained by éompute
clicking on the Compute icon.

Finally, elements of the Magnet system can be visualized through the AGDD pane of the

Selector window. Figure4b shows an example of a display of the magnetic field where

one element of the cold mass of a barrel coil is shown.

Magnetic field 00

Generate maps:

¥ Display magnetic field lines

Color [ ]
Scale [Togarihmic 3] s270cmTesh 8]
Projection
Qso ox ez Q¢
Z= 0,00cm [%)
AV
pavavs
Lattice :/ i o
S
Minimum Mesh Maximum ': N
A
X 1500,0 om [%] 500cm [5] 15000 om [3) P T
- = = ! 1
et
Y 1500,0 om [%] 500cm [5] 15000 om [3) 725
O 8] ) 2
2=
z -18000cm [5] 1000em [£] 1800,0om (%) 7230
O O - N
A

TIII A
4
fean

"] Print magnetic field information

IRFN ALY
s AT

["AMDB ~ AGDD | Magneticfied | X0 | Parsne

(a) Chosen display parameters (b) Display of field lines

Figure 45: Example of magnetic field lines displayed with a barrel toroid cold mass,
selected with the AGDD interface. The parameters in (a) are used to obtain display (b).
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9.7.3 Display B-field maps

e B-field map
The Magnetic field map can be displayed by clicking on the first (left) button of
the Generate maps box in the Magnetic Filed pane of the Generate maps: (% ) (1 )

Selector window (Fig.45a) !. The Select options for map window opens and the
parameters can be chosen in the three available panes (Fig. 46):

— Field/Component (B, , By, By, By, B, Biot) as well as various field gradients (deriva-
tives): VB,,VB,, VB, and 9 specific derivatives: ‘gf; (i,j =x,y,2)

— The |Variables| to be displayed in 2D plots (Xvs.Y, Xvs.Z,Yvs.Z) and the value
(position) of the 3" coordinate; or 1D plots (R, ¢, Z, X,Y);

— In the [Latticel pane one can select the range of the axes and the step (Fig. 46¢).

When all the parameters are set, click on one of the JOK buttons.
Figure 47 shows the 2D field map.

Several other field maps may be added to the display by using | Add map| Each
map can be saved with a choice of formats (.png, .eps, .pdf, etc.)

The magnetic field file used (bmagatlas05_test2) is one of the files available ? in
the Magnetic field pane of the Data manager window (see6.1.1, and figure 5).

77 Select options for map
| Component | Varables | Latiice |
2D
"7 Select options for map
[XvsY [& ]
[ Component  Variables | Latice
{ElSelectoptiopsfonman 1D Miimum ~ Step  Maximum
fiGempensn] Voinbes | Lo )
Selactfield component: R L X |H000,0 cm E‘ 50,0 cm ’;‘ 1000,0 cm E‘
(Bt =]

Position ¥ -1000,0 cm E‘ 50,0 em @ 1000,0 em @

z 500,0 cm |2)

Comaa) — (Canea)
A 4 4
(a) Field component (b) Variable(s) to be displayed (c) Lattice

Figure 46: Selecting options and variables for displaying the 2D field map.

" Maps of magnetic field
eo0o Map 1
Btot (bmagatlas05_test2)
107
- - ‘ )
5 » .
Figure 47: ®
_ - - 107
2D display of Biot in the X — Y plane at Z = 500cm. The £ o : 3
corresponding selections are shown in figure46. Units are . . .
102
Tesla and m. s » @&
‘ o |
o : 0 5 L
X [m]
#Log (" Range ) ( Export ) /
@B (“Addmap ) ("Close )
4

!An alternative is to use the Tools menu: Tools/Histograms.../ Map of magnetic field (see
Appendix E.6).

2 Additional field maps can be made available through the Download. .. button in the Data manager
window (see6.1.1, item 2, page 20); or by choosing Download. .. in the File menu (Appendix E.1).
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The magnetic field can also be illustrated as 1D plots. With the selections shown

in figure 48, the total field By is shown as a function of R in figure49 (Map 1).

7" Select options for map

[ Component  Variables | Latice |

Minimum Step Maximum

R |H000,0 cm %)

500¢cm (31 10000 cm %)

"7 Select options for map "7 Select opticns for map
[ Component  Varables  Lattice | ! Component | Varables | Latlice |
Select field component: O2o
[ Btot = ) Xvs Y
™ 1D
(L
Position
¢ oo [
z 5000 cm [3)
4 4

Cancel )

rd

(a) Component

(b) Variables

(c) Lattice

Figure 48: Selections for 1D plot of the magnetic field.

The field of the central solenoid magnet can be added, as shown in figure49
(Map 2), with the following selections (made in the panes of figure 48):

Component= B;; Variable= Z, at ¢ = R =0 ; Lattice: Z € [-300, 300]cm.

800 Map 2
gy
Figure 49: Units are Tesla and m. %“:
Map1: 1D display of Biot as a tu,
function of R at Z =5 m, ¢ = 0. i
Map 2: display of B, as a function of | B TR
o . | -3 -2 -1 Zﬁn] 1
Zat R=0,p=0. oo (Rarg) By
@B (Addmap)

7 Maps of magnetic field

Map 1

Btot (bmagatlas0s_test2)

os
s

030

[Tesla]

02f

0.1

2 3

With the IMDI ! button, the display can be arranged to show each map separately,
using the tabs, as shown in figure 50.

" Maps of magnetic field
| [ Map 1 L= Map 2 ]
‘Bz (bmagetlas0s_test2)
2
I,B;
I,S;
Figure 50: Same as figure 49, but in T uE
=4 =
MDI mode, showing one plot at a time =,
in separate tabs. =
! 08—
| ; , , ‘ | , ‘
3 -2 -1 0 1 2 3
| Z[m)
| Ot (Ramge) (Bwom) Coe)
(MDI) (Addmap ) (Close )
VA

'Multiple Document Interface
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e Integral B-field map ([ Bdl)
The integral field can be displayed by clicking on the second (right) button of the
Generate maps box in the Magnetic Filed pane®. First, choose the component in
the Component tab (Fig.51a), then check ”2D” in the Variables tab (Fig.51b) and
finally choose the lattice in the Lattice tab (Fig.51c). The line integral of the B,

scalar component is shown in Fig. 53a.
An example of selections made to obtain a 1D plot of [ Bdl is shown in figure 52,
and the resulting plot in figure 53b.

Generate maps: ( #5 ) (Wl )

"' Select options for map

77 Select options for map

" Select options for map. |

Component | Variables  Lattice

Select component:

(@ Line integral of the Bphi scalar component
integral of the Bz scalar component
integral of the magnitude |8 of the field
() Line integral of the B field vector

("Cancel )

4

Integration limits

Variables | Lattice |

#20

! Component

[nlvse %

1

o

423,00 cm (3] 8]

1200,00 cm 3} (Inl < ned

Nert 120 [3)

2300,00 cm [3)

680,00 cm (2] (Inl 2 ne)

4

[ Component _ Variables | Lattice

Steps Minimum  Maximum

Inl 54 3) 00 [ 2,7 )

™

® 90 (3 o A 450 [ ‘

(Cancel )

A

(a) Select Component

(b) Select Variable and integration

limits

(c) Select Lattice for 2D plot

Figure 51: Map of the field integral [ Bdl. The unit is Tesla.m

" Select options for map

7 Select options for map

{ Component | Variables Lattice |

Select component:
(@ Line integral of the Bphi scalar companent
() Line integral of the Bz scalar component

(O) Line integral of the magnitude |B| of the field
() Line integral of the B field vector

4

" Select options for map. |
! Compenent | Variables | Lattice |
20
inivs &
™ 10
[m s ‘
Integration limits ‘
R 42300cm (3] 1200000m (2 (nl < neo)
e 120 7]
z s80,00cm (5] 230000 cm (2 (Inl = no
Position
0 00+ [3 \
=)
4

[ Component  Variables | Lafice

Steps Minimum Maximum

27 [

Inl b4 2] oo [3

( Cancel )

A

(a) Select Component

Figure 52: 1D display of [ Bdl as a function of n

(b) Select Variable and integration
limits

'OR: Use the Tools menu: Tools/Histograms. . .

Map of field line integral.

(c) Select Lattice for 1D plot
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9

8

_ 7|

1

E

£ 7

E 41

i 3

2|

1

0.5 1 15 2 25
leta] eta]

[Log ( Range ) ( Export ) (" Close ) H Clog ( Range ) ( Export ) (" Close ) H
(a) 2-D (n — ¢) map of [ Bdl (b) 1-D plot of [ Bdl as a function of n

Figure 53: Display of [ Bdl

e Field gradients
This feature is destined for special studies by advanced users. Figure 54 shows
various field gradients in the context of the 2013-2014 upgrade studies. The field
gradient to be displayed is chosen in the selection window (Fig.46a)

o= e -l

(bmagatlas_09_full Asym20400) (bmagatlas_09_full Asym20-400)

¥ [m]
[Tim]
Y [m]

o
-0.4
-0.8
P A
5

3 4

X [m] X [m]
O oo Pomosons) (N (semees) (snsmmen)| O v Dmssen) (Bsne) (mEscie) (sssmne)
= Map 4 SETEE] Map 1 SETEY
{bmagatlas_09_fullAsym20400) gradBz (bmagatlas_09_fullAsym20400)

5

5|

-

Y [m]
[Tim]
Y [m]

1w’

0 1 0!
o 1 2 3 4 5 o 1 2 3 4 5

oy mepion, [ aoe | B | [ s || @ 150 Bowopin [ e | [ Bwor | sow

Figure 54: Display of magnetic field gradients: %, 86%, 683;, top left, top right and

bottom left respectiveley. Bottom right shows the divergence VBz = 88% + aa% + 68%.
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9.8 X, map: Distribution of material

The amount of material (in units of radiation length Xj) along any chosen direction
from the interaction point can be displayed in the following way.

In the Option pane of the Selector window (Fig.2), choose the Xy tab!, and hit the
Generate X Map button 2.

In the Select options for Xy Map window (Fig.55a), the direction (7, ) can be chosen.

After hitting the - button, the next step invites you to chose the integration

range (R, Z) (Fig.55b). After hitting the - button, the resulting map is shown in
figure 56. The regions with high quantities of material because of the magnet coils are
clearly visible (in warm colors): at ¢ = 22.5° for the barrel region and at ¢ = 0° and
45° in the forward region ( > 1.5).

8nNon 7 Select options for X0 map | [ NoNe) 7 Select options for X0 map
Lattice Integration range
Define lattice for X0 map. Specify the integration range for integration by cylinder
subtraction.
Min Step Max.

n n n R z

n 0,00 O 0,020 O 2,70 O — —
- - - Internal cylinder 42500cm (7] 67500cm (3]

© o00° 2] [ osoe|(f) [ 45007 Lo e
= - - External cylinder 1260,000m (%] 225000 om (3]

y V.
(a) Choose the direction (b) Choose the integration range

Figure 55: Options for Map of Xj.
The two successive windows Select options for Xy Map allow to choose the direction (7, ¢) (a), as
well as the integration range (R, Z) (b). The amount of material - in units of X - is calculated.

Figure 56: Resulting map of Xj.

Two dimentional (7, ) Map of Xy. At the right,
the color scale for the amount of material is
expressed in units of radiation lengths (Xj).

You may have to open the X tab by checking Xy in the Windows menu
20R: Use the Tools menu: Tools/Histograms... Map of Xg.
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9.9 Map of the expected number of crossed muon stations

Ideally, the number of detector stations crossed by a muon is at least 3. There are
regions in the spectrometer where this is not the case: e.g. in the transition region
between barrel and endcap (around | n |~ 1.2), where a muon crosses fewer stations;
and also at regular azimuthal angles. The tool described below makes it possible to
determine the number of stations at any given n and ¢.

The map is obtained by generating straight tracks from the IP and propagating them
through the spectrometer, counting the number of chambers on the trajectory.

In the Tools menu, choose Histograms. .. / Map of expected stations button . In the pop-
up window ”Select options for map”, make the following selections shown in figure 57a:
- Lattice: choose the desired 7, ¢ ranges
- Type : select precision stations (MDT+CSC) or trigger stations (RPC+TGC)

- Selection : use all stations in the spectrometer or only the stations being displayed

77 Select options for map " Map of expected stations
Lattice
45
Minimum Step Maximum Ut VUl
- 1k
; 0l omf [ el -
= = = |-- L]
@ 00° [ 20° [2) a50° (%)

Stations

Statioas (MDT, CSC)

Type: ) Precision stations (MDT, CSC) (7) Trigger stations (RPC, TGC)

Selection: (@) Use allstations () Use displayed stations only
25
(Cancel ) 4 [CLog ( Range Export Close
(a) Choose the options for the display (b) Map of Number of expected sta-

tions

Figure 57: Number of expected stations.

a) Options for displaying the map: n and ¢ ranges, type of chambers, selection of chambers.

b) Two dimentional (n, ¢) map of Number of expected stations. At the right, the color scale for
the number of stations.

Clicking on , produces the map of figure 57b. The regions where only one station

or none are crossed can be clearly identified (blue resp. purple).

There are also a few rare regions where the number of expected stations exceeds 3, as
indicated by the regions in

By using the selection Use displayed stations only in figure 57a, it is possible to restrict
the map to the stations displayed in an event.

In any of the resulting maps (Figs. 47,49, 50, 46b, 52¢, 56, 57b, ), several actions are pos-
sible with the tabs at the bottom of the display:

e Range : Set the range of the color scale for the plotted quantity .
e Export : Saves the map as an ASCII file (.dat format).

e Save : Saves the map as a picture with a choice of formats (.png, .eps, .pdf, etc.).

e Close window without saving or exporting.

'!OR: In the Option pane of the Selector window (Fig.2), choose the X, tab, and hit the
Generate map of expected stations button
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10 Exercise 5: ATLAS Physics Events (1)

10.1 Input files
10.1.1 Files loaded by the user

Persint allows the reading of event hit files and the visualization of these hits. It is also
possible to reconstruct the event interactively !. All this is done with the help of the
Events menu (Appendix E.5).

To display event hits, the following files must be loaded:
1. A geometrical data base of the ”amdb_simrec.xxx” type.

2. An input Event file containing the hits of the ”0OutMboyView_yyy” type. The
structure of this ASCIT file is given in Appendix D.3.6, and an example Event file
in Appendix D.3.7.

The interactive reconstruction of events requires the loading of two additional files.
1. The Magnetic field file
2. The user’s directives in the form of ” Data cards”

All these files are available through the Data manager icon of the File tool bar. For
details, refer to section6.1.1, figures4,5,8, and AppendixD, figure133a. As already
mentioned, these files are loaded, if available, in the working directory. The program
checks if the correct files are loaded. If there is a discrepency between the loaded geom-
etry file and the event hit file 2, a warning is issued and the correct file(s) can be loaded
(see section 6.3, item 4, and figure9 on page 24).

The user may change these input files at any time during the running of Persint.

10.1.2 Event dependent files

The geometry file of the "amdb_simrec.xxx” type which is loaded at the beginning of
a session represent the nominal geometry corresponding to the event file in use. The
actual geometry, which represents the state of the detector at any given moment, must
be used. Using a port ® to a CERN data base, these files are invoked for each event
displayed with Persint according to its time stamp.

— The "missing" file indicates the detector parts or channels which are inoperative
for a given event.

— The "Corr" file provides the alignment parameters (A lines) and deformation pa-
rameters (B lines) of the precision chambers.

IThe interactive reconstruction is using the interface with the Muonboy reconstruction program.

The event hits file ”OutMboyView.yyy” indicates the required geometry file in its
header (AppendixD.3.7)). The file 7Persint-00-02-ee/PersintData/AtlasNode AmdcFile
_MagFieldFile.txt” indicates the magnetic field file needed for a given geometry file (Fig. 133b).

3To get automatic access to these files, open the port with the following command:
ssh -D 3128 lxplus.cern.ch
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10.2 Display physics events (Exercise 5 starts here)

For this exercise, we start from scratch; after starting Persint, we erase the display
window with the Clear button of the Image tool bar.

Then we load the necessary files with the Data manager icon of the File tool bar:

e An amdb_simrec.xxx geometry file in the Volumes tab (Fig.4).
Check the box ” Load AGDD Volumes from the AMDB file”

e A magnetic field file in the Magnetic Field tab (Fig.5).

e The (default) Muon hits file in the Events tab (Fig.8).

Answer ”Yes” if you are invited to load the ”expected” AMDB file (see figure9). Choose the
magnetic field map (Fig. 9b) corresponding to the default Event file (answer ”Yes”). Finally, load
the appropriate Data Cards file Muonboy_collision _simul_cards, for a simulated event.

- To display the event of the default Event file (Out.Mboy View_Zmumu4023)* click
on the Next event icon of the Event tool bar. The muon chambers which contain hits
(and only those chambers) are displayed.

- To display the reconstructed tracks, click on the Athena reconstruction icon of the

dan

Clear

M

Next event

7

Event tool bar. A second click will remove the tracks. Athena-
. . . . . reconstruction
- The Simulated tracks icon can be used to visualize generated tracks. A second click
will remove those tracks.
- The muon chambers belonging to the event can be hidden by un-selecting Chambers %II
in the Event menu.
Simulation-
Reconstruction | Simulation _ Calorimeter cells __ Physics _ TRT | tracks
A  Muongoy segments E]
N B (=)
4 1D tacks at P osocev @ [ |
-‘__"T__""\::-\_\ N () MuonBoy tracks at Spectro 020 Gev [3] E
] MuTag tracks at IP 0,20Gev [2) E
’ﬁ 7] Moore tracks at Spectro 0.20Gev [3) E
[71MulD extra tracks. 0,20Gev [3 E
£ MulD Comb tracks at 1P 020Gev 3] E
% Maximurm d0 1,0000 cm [}
L., Maximum 1201 1,0000 cm [3)
] Draw scattering boxes
Track width ——0— 0210804 [3)
[ Segment width ——0— o200 )
(a) Display of Event 4023 showing tracks and (b) The Set track parameters win-
the chambers containing hits dow
Figure 58: Display of Event 4023 resulting from the selections made.
After having used some functions of the Navigation tool bar to change the aspect of the
display, figure 58a shows the event with the two muon tracks and the chambers which
contain hits. &

Many different reconstructed objects can be displayed; they are selected in the Set track
parameters window (Fig. 58) 2 available through the corresponding icon. Set track parameters

For instance, one can choose to display tracks reconstructed by Muonboy or Moore,

Staco or Muid etc. .. dy 0 A Ly
Besides these objects specific to the muon system, it is possible to visualize objects ¢ e o 1
relevant to the calorimeters (cells) and Inner Detector (tracks). These displays will be !
discussed in section 11.3.

Note that the Event can be erased from the display with the Clear event function.

£ Clear AMDB volumes
£ Clear ACDD volumes
£ Clear event

{ Clear labels

£ Clear captions

£ Clear pictures

Clear event

!The file ” Out.Mboy View_Zmumu4023” used in this tutorial contains only one event.
2See also figure 136 in AppendixE.5.1.
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10.3 Select Sectors to be displayed

Because all chambers with hits are displayed in an event, the display may become
crawded. Although this is not the case for the current event 4023, we will nonethe-
less clear the display of the chambers which do not have a reconstructed track.

First we identify the sectors of interest: by moving the cursor over the 6 chambers which
contain the two reconstructed tracks, we find that the two sectors concerned are sectors
3 and 7, as indicated by the chamber labels. The goal is now to only display those
sectors 3 and 7.

To do this, we use the function Select Sectors... of the Events menu. In the window
which appears, we choose the sectors we want to display, by using the button
shown in figure 59a. In the pop-up window, make the selections to display sectors 3, as
shown in figure 59b; repeat the operation for sector 7. It is also necessary to select other

options such as Barrel/endcap, Large/Small, Z+-. Upon clicking on -, the selection

is displayed in the Select sector(s) window (Fig.59c). Clicking once more on will
produce the event display of figure 59 where only sectors 3 and 7 are displayed.
Select séctor(s) to display Edit sector 7 Select sector(s) to displa
Add M B3LX Add
E Barrel I Endcap B71x
Edit Sector: ‘ 3 @ Edit
" Remove ) " Remove |

M Large  [Small

M z+ M z-
( Resat ) (Cancel ) ( 0K ) ': Cancel ) ( oK ) ( Reset ) (Cancel j f—ﬁK—)
4 P VZ:
(a) Select sector(s) window (b) Edit sector(s) window (c) Selections made

Figure 59: How to select the sectors to be displayed in an event.

e

4

Parsing Parsint

(a) Display of Event 4023 showing all cham- (b) Display of Event 4023 showing only
bers containing hits chambers in sectors 3 and 7

Figure 60: Event 4023, display (2), resulting from the selection of two sectors.
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The selection of sectors remains active until another selection is made in the Select sector(s)
window or until one restores the entire display, using the button of that window.
Note that figures 60a (default) and 60b correspond to the selections of figures 59a and
59c, respectively.

There is an alternate and faster way to select the sectors to be displayed. Instead of using
Select sectors. .. of the Events menu and enter the sector numbers into the Edit sector
window (Fig. 59b), select the volumes directly in the following way:

Starting with figure 60a, Right-click in succession on the volumes which one wants to
display and choose each time Select Super-volume. When done, the Selected volumes
window (Fig. 61a) shows the list of volumes. Hit the m button and check the list
in the Select sector(s) window (Fig. 61b).

0.0,0 3 Selected volumes 7 Select sector(s) to display
BOL_F3_Z+2
BML_F3_Z+2
BIL_F3_Z+2 B3L+ Ir Add N'I
BIL_F7_zZ+2 T
BML_F7_Z+2 B3L+
BOL_F7_Z+2 B3L+ Edit
B7 L+
B7L+ Remove
B7 L+
(& Editcolor ) () Move to infinity )

Inv. mass | Sectors )
e L

(7 Uncselectall ) [ Reset ) (" Cancel ) E oK )
4 A
(a) Selected volumes window (b) Select sector(s) window

Figure 61: Alternate method for selecting sectors for display

Finally hitting produces again figure 60b, with only sectors 3 and 7 displayed.

10.4 Select minimum number of hits =" Minimum # of hits per MDT chamber
It is possible to restrict the display to MDT Minimum # of hits:
chambers which contain at least a specified L 0
”Minimum number of hits”. In the simulated )
Cancel

event of figure 60, the inner stations have 8 possible
hits, whereas the middle and outer stations have 6
possible hits. In the Events menu, choose Minimum
number of hits.... In the pop-up window (Top
figure) set the minimum # of hits to 7. After

clicking on , only the inner chambers are
displayed (Bottom figure).

/4

A faster way to set the minimum number of hits is
to use the spinbox |n Hit(s)| in the Event tool bar
(see figure 2 and appendix E.5).

7 hit(s}

Spinbox
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10.5 Dressing the event

It is often convenient to ”dress” the event with surrounding detectors in order to get a
sense of orientation in ATLAS. This is particularly true for displays destined for pre-
sentations or publication. One can add the detector elements useful for orientation and
change the aspect of the display at will. To do this, we use the Selector window and the
Navigation tool bar as explained in section 7.

For this exercise, we will again load the predefined detector file for this event: click on
the Open view icon of the File tool bar and select Zmumu4023.p2vf in the directory
Persint-00-02-ee /example. The display now resembles figure 62a.

We want first to change the aspect of the display. In order to ensure fast processing
of each action and to get optimal fluidity in the displacements, we turn to the global
Wire mode (see section 9.6, item 1) by clicking on the relevant icon in the Image tool
bar. The display of figure 62b is obtained.

We now Zoom-out and Rotate the view using the navigation tool bar as explained in
section 8 to obtain a display resembling figure 62c.

To obtain the display in full volume mode, we click again on the Wire mode icon to
obtain figure 62d.

Parsint -

(a) Event 4023 dressed with the default file
Zmumu4023.p2vi

Parsint 4 Parsint

(c) Event 4023 rotated and after Zoom-out (d) Event 4023 in full display mode

Figure 62: Display of Event 4023 resulting from the selections made.

In this view, the event itself is partially hidden. To remedy this, we will drop some
elements of the detector to be displayed. First we remove the endcap toroids by un-
checking the relevant item in the AMDB tab of the Selector window and we also remove
the lower coil of the barrel toroid by selecting the four left-most coils. Remember that

800

X

(a|

=

=)

Open view

Open view. ..

§ \W‘ire mode

Wire mode
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the color of the detector items (e.g. the barrel toroid) can be chosen in this pane. These
modifications are indicated in figure 63b.

We now remove the feet and the shielding by making the appropriate selection in the
AGDD pane of the Selector window, as indicated in figure 63d.

e AMDB AGDD AGDD
| Volume | & | Selection Vol | & |sel Volume [ a (& | Volume. | | &
MDT @ >u ul’d“l;T & [selection v ® List of independant_trees 1] v ® Listof independant_trees 1]
» RPC » RPC » [ ECT_Toroids 2 » [ ECT Toroids 2
» TCC » TGC N S“‘“‘Jﬂ'ﬂid 193- » [l BAR_ Torcid 103
» Feet 208 b O Feet 208
: :‘iﬁ. : ICAZCT » [ RailAssembly 512 » [ RailAssembly 512
» [ JFSH_AFrame_Assem... 536 » [} JFSH_AFrame Assem... 536
R I ’ [ JFSH_AFrame.
BARREL TOROID 808 eem BARREL TOROID Q0K == > @ JFsH_shield 555 » [ JFSH_Shield 555
:: %% - gJDSH_ShmId 565 » [ JDSH_Shield 565
S04 eem a5l > JTSH_Shield 576 » [ JTSH_Shield 576
ENDCAPTOROID  IIGOS ENDCAPTOROID GO o 0w o e 576

(a) Initial status

(b) Modified status

(c) Initial status

(d) Modified status

Figure 63: Modifications made in the Selector window.

After the selections have been made, click on the Compute icon of the Image tool bar. ﬁ

A view similar to figure 64 is displayed. Compute

To return to the bare event display (without the ”dressing”), use elements of the ==

Clear view function to remove AMDB and AGDD volumes. 1 e e
£ Clear event

O |4 Ly 4
B |

Clear view

I'I‘.!f.‘llm P=+21.16 Pi=2037 eta=026

== B E———

Tack 791 P=-8546 P1=6146 eta=031

Figure 64: Display resulting from the modifications made to the selected detector ele-
ments. Track labels were produced as indicated in section 9.1.2.
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10.6 Save the view

By clicking on the Save view asicon in the File tool bar the view displayed in the main dis- | |
play can be saved as a . p2vf file to the directory of your choice, e.g. Persint_working_files. ===

This file (e.g. exercise5.p2vf) can be retrieved for later use in Persint via the Open view Save view as...
icon.

The view can also be exported or printed as explained in section 6.4.

10.7 Changing the event file

We now want to use a different event file. In the File menu (or tool bar), choose Data

manager and then the Event tab and click on . Choose the file ”0ut . MboyView_Top_evts_5”
of the Persint-00-02-ee /example directory. Persint issues a warning and invites you to

load the appropriate geometry file (Fig. 65a): answer in order to load the correct
file. A second warning is issued (Fig.65b) which invites you to load the appropriate

magnetic field file. Again, answer 1 The loading of the appropriate files takes
several seconds.

. . . . — The current magnetic field map(s) differ(s) from the
The current AMDBE file is not the file required by the new muon - map(s) required by the new event file:
hits file. Maps ¥ lenoid
Current file : amdb_simrec.r.03.01.Initial.Light.BML.S13.Patch Current bmagatlas05_test2.data map7730bes2.grid

maps:
Expected bmagatlas04_testl.data
maps:

Expected file : amdb_simrec.r.01.01.Initial.Light_v02_Egg_Rndm

Do you want to load the required AMDB file ?

Do you want to load the required magnetic field
map(s)?

\i-' i No Yes

(a) AMDB geometry file (b) Magnetic field file

Figure 65: Warnings issued by Persint about loading the proper files.

The panes Events and Magnetic field now display the current files which are used, and
also the default files (Fig. 66). >

Data Manager Data Manager
! Volumes | Events = Magnetic Field  Others | ! Volumes  Events | Magnetic Field | Others |
MboyView Muan Hits
Magretic Field
Default file : Out.MboyView_Zmumu4023
. Muon Spectrometer: bmagatlas04_testl.data
Current file : Out.MboyView_Top_evts_5
Solenoid: 25 from the spectrometer field map.>
(T3 Load ) ( Define As Default ) (" Load Default ) — -
Data Cards | Modify ... )
Default file : muonboy_collision_cards
Current file : muonboy_collision_cards
I Load Define As Default Load Default
Close ) Close )
A A
(a) Event file (b) Magnetic field file

Figure 66: ”Default” files and ” Current” files being used by Persint.

1t is possible to use geometry and field files different from the recommended files, by answering .
This may be needed in special cases.

2Note that the current file can be defined as the default file by clicking on [Deﬁne as Default ]
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10.8 Scanning events

Persint is well adapted for scanning events. To illustrate how the scanning works, we
shall load a file which contains many events (unlike Out.Mboy View_Zmumu4023 which
has only one event).

In the Event tab of the Data manager window (Fig. 8), click on in the Muon hits
file part. In the pop-up window, choose Out .MboyView_1 in the Persint-00-02-ee /example
directory, a file of simulated single muon events. Depending on the previously loaded
event file, two consecutive warnings, similar to figure 65, are issued about geometry and
magnetic field files. Choose the suggested files by answering . Close the Data
manager window.

10.8.1 Manual scanning 1Y

Click on Next event to display the first event of the file. Next event
The event number is # 3998 and is displayed in the Event number scale Event: (3998 18) ) W
of the Event tool bar. Event number scale
Click on Next event to display the following event.

The details of the event visualization can be defined using a series of functions of the
Events menu (e.g. Athena reconstruction, Hit calorimeter cells, Strips, Tubes etc.) L.

Any event can be chosen directly from the Event number scale. It can also be entered
with the keyboard. f?g]
The Reload event icon is used to load the current event again.

Reload event

10.8.2 Automatic scanning

The scanning can be performed automatically with the Start autoscan icon. )
The Autoscan speed icon makes it possible to choose the time between events Start autoscan
(1, 2, 5, 10, 20, or 30 seconds). The change of speed can be made ”on the fly”. Autoscan speed
If one wants to work with a given event, the automatic scanning can be interrupted with g By

the Start autoscan icon which has now changed aspect (Stop autoscan).
Stop autoscan

10.8.3 Visualization properties

By default, each visualization of a new event is done from a predefined perspective. How-
ever, when scanning events, it may be convenient to retain the current (modified from

the default) visualization properties. This is done with the Store visualization properties Store visualiza-
icon tion properties

To illustrate this feature, we go back to the first event (#3998) of the loaded event file ,;:E'

by choosing the event number in the Event number scale. Display the reconstructed Athona

tracks using the Athena reconstruction icon (Fig.67a). reconstruction
Now we use the navigation tools to change the visualization properties. First we zoom-
out and display the ATLAS coordinate axes by choosing Huge axes in the Axes menu
(Fig.67b). Ay

Axes

'See AppendixE.5
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{

Persint

(a) Event 3998: initial default visualization properties (b) Event 3998: after zoom-out and with axes

Figure 67: Various views of Event 3998

Let’s rotate the view to obtain figure 68a. We assume that the Store visualization prop-
erties icon is enabled. Clicking on the Next event icon will display event #3999 with the
stored visualization properties (i.e. the rotated view). These parameters are used until
the Store visualization properties icon is disabled and the next event #4000 is displayed
(Fig. 68Db).

oy
Persint Peraint
(a) Event 3998: after rotation (b) Event 4000: Back to initial visualization prop-
erties

Figure 68: Events 3998 & 4000

This feature of changing the visualization parameters can be used ”"on the fly” in the
Autoscan mode.
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10.8.4 Using 2D projections

For scanning purposes, it may be useful to use a two-dimentional projected view of the
events: B Iy

e Stop the autoscan with a click on the Stop Autoscan icon. Stop autoscan

%=y s,
e Display the X-projection by clicking on the appropriate item of the Projection
menu vx. X
‘ Y ®Y ¢
z ®Z |
e Resume the automatic scanning with the Start autoscan function. All events are © |
now displayed in the X-projection until the Store visualization properties function Ivert 381
is disabled to return to the initial 3D view, or the Stop autoscan function is used Proiecti
rojection

to end the automatic scanning. T
.4"-.' v _i-'

v No axes

Figure 69 shows two events captured during the automatic scanning with the X-projection * ) aces
enabled. Note that the display of the axes can be disabled at any time by choosing  Smallaxes

X Medium axes
No axes in the AXGS menu. Large axes
Huge axes
M Axes color...
Axes
i
-
L ﬁ/
Z< &
i R e H\
Papalnt Parating
(a) With coordinate axes displayed (b) Without Coordinate axes

Figure 69: X-projection of scanned events
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11 Exercise 6: ATLAS Physics events (2)

In this exercise, we will examine more features provided by the Events menu. They
concern the data from the muon spectrometer, the calorimeters, and the Inner Detector.
Remember that it may be convenient to save the display as a .p2vf file (e.g. in your I,.—.||
Persint_working_files directory) if you must interrupt your work. This is done with the |§
Save view as function, as explained in section 6.4.

11.1 Muon spectrometer data #

Again, as in exercise 5, we start from scratch. After starting Persint, we erase the display ¥
window with the Clear button of the Image tool bar. Clear
Then we load the necessary files with the Data manager icon of the File tool bar:

e An amdb_simrec.xxx geometry file in the Volumes tab (Fig.4).
Check the box " Load AGDD Volumes from the AMDB file”

e A magnetic field file in the Magnetic Field tab (Fig.5).

e The (default) Muon hits file in the Events tab (Fig.8).
Answer if you are invited to load the "expected” AMDB file (see section 6.3, item4 and
figure 9). Furthermore, you are invited to choose the magnetic field map (Fig.9b) corresponding

to the default Event file (answer ). Finally, load also the (default) Data Cards file which

is needed for interactive muon reconstruction with Muonboy.

To display the event of the default Event file m
(Out.MboyView_Zmumu4023) * click on the Next Next event
event icon of the Event tool bar. The muon cham-
bers which contain hits (and only those) are displayed
in the figure to the left.

“The file ” Out.Mboy View_Zmumu4023” used in this tutorial
contains only one event.

11.1.1 ATHENA reconstructed segments and tracks

Now we want to display the reconstructed tracks in the muon spectrometer.

1. First we choose the parameters of the tracks to be displayed by opening the Set &
track parameters window. We replace the default values by the following;:

e For now, we only are concerned with the first pane (Reconstruction).
e Check "Muonboy segments” (or Moore segments)
e Check "Muonboy tracks at spectro” (or Moore segments)

e Select the ”Track shape”: Ribbon, Crossed ribbons, or Cylinder
e Set "Track width” to the desired value ﬂ
The resulting Set track parameters window is shown in figure 70a.

Close the window by clicking on , then click on the Compute icon.

To visualize the reconstructed tracks, click on the Athena reconstruction icon and :;'.}ﬁ'
obtain figure 70b.

Compute

Athena-

Save view as. ..

Set track parameters

reconstruction



T [ Simulation _Calonmeter cells _ Physics _TRT
Rec
¥ MuonBoy segments E
(I Moore segments E
11D tracks at IP 050Gev 2]
¥ MuonBoy tracks at Spectro 020Gev [z} E
OStaco tracks at 1P 020cev ) E
(] MuTag tracks at IP 020Gev [2) E
1 Moore tracks at Spectro 020Gev [3) E
£ MulD Comb tracks at IP 020Cev 2] E
Maximum o 1,0000 cm (2]
Maximum [20] 1,0000 cm 3]
Track shape [Ribbon I}
e s
Track width —@— 2,249055 [
Segment width —@=—— 0200778 [2)
(o) (o) &) =)

(a) Selections made in the Set track (b) Display of reconstructed Muonboy

parameters window tracks

Figure 70: Event 4023 (first pass)

2. We will now label the tracks. Select the Default mode in the Navigation tool bar. [:E'
Move the cursor over the first track, right-click and choose Add cutomized
label. In the pop-up window, un-check the two coordinate boxes and choose the Default mode
SW position (Fig. 71a). Click on - .
Repeat this operation for the second track to obtain figure 71b.
The labels indicate the charges and momenta (in GeV/c) of the reconstructed
tracks.

Zdd volume label

Volume information Track P=+21.18 ‘

[ Hardware name -
™ Name Track P=+21.18

" Cartesian coord. X =-182.89cm | ¥ = 1168.37 cm | Z = 345.73 cm

[ Cylindr. coord. R=1182.60 cm | @ = 98.90° | n = 0.29

Additional text

This is a customized label

Position : | SW = @

Track P=-85.46

(b) Display of reconstructed tracks
with labels

(a) Selections made in the Set track parameters window

Figure 71: Event 4023 (second pass)

3. We may want to save the display into the directory (Persint_working_files) as a B

.p2vft file, for future use with Persint, using the Save view as ... function. 3 .
ave view as. ..

Remember that the Export view as ... can be used for saving the display for
presentations as a (e.g. .jpg) file, with the possibility of adding captions, logos or
pictures (see sections 6.4 and 6.5).
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T | Simulation Calorimeter cells _ Physics TR |

Reconstruction

ST—— = ez dia

# Moore segments E

11D tracks at IP os0cev o) [ ]

1 MuonBoy tracks at 1P oa0Gev ) E

S smcer £ (2]

7] Staco tracks at [P 020Gev [z} E

7] Moore tracks at Spectro 0,20Gev [2] E y
M extra tracks oz0cey ) [=]

Maximum d0 1,0000 cm 3]

Maximum [20] 1,0000 cm 2}

Track shape Ribbon ]

™ Draw scattering boxes

Track width —— 2,249055 [1)

Segment width —— 0299778 1)

Track P==-900.13|
eas ancel

(a) Selections made in the Set track  (b) Display of reconstructed MulD tracks
parameters window

Figure 72: Event 4023 (third pass)

4. As can be seen in the Set track parameters window, one can choose other objects
to be displayed. For example, the choices: ”Moore segments” and ”MulD extra
tracks” shown in figure 72a result in figure 72b, once the customized labels have
been added as before.

5. Instead of showing the tracks, one can choose to display only the segments. To
do this, open the Set track parameters window and select only the Muonboy or
Moore segment box (or both), as shown in figure 73a. We look now at the upper
triplet of detector stations. After rotating the display and zooming-in, we obtain
figure 73b.

— % T Simulation _Calorimeter cells _ Physics  TRT |
———
e — =
) Moore segments E
110 ks e asocw B[]
ra— owoen 1 [=]
. owew I [=]
Dl ke omaw (=]
Er—— oew o [=]
. owew I [=]
ra— oew 1 [=]
Maximum do 1,0000cm 3}
Maximurm |20] 1,0000cm [}
et Pr—
™ Draw scattering boxes
Track width —— 220055 [

—O— 0299778 [3
=) &==) Porsing

(a) Selecting segments in the Set  (b) Display of reconstructed segments (in
track parameters window red)

Figure 73: Event 4023 (fourth pass)
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6. We now choose different settings of the "MDT options” shown in figure 7?7, we ro-
tate the view, and we zoom-in on the BML chambers with the Zoom on custom area
function discussed in section 8.3, item 4. We obtain figure 7?7, where one recognizes
the hit MDT tubes (in red), the active RPC strips (in yellow) and the reconstructed
segment (in red). The labels have been added as explained in section 9.1.2.

Segmentl/chi2l.35
Reconstructed segment]

MDT options

) Cross plate (| Long beams [ Tubes envelop

¥ Tubes [ ] [ | MDTHIt21 /BML/Jff3 /jz22 Job8 £I513 {tubed f |
MDT hit (drift radius) 7
[Tl End-plugs [ Faraday-cages [ Stair-casing

(a) Selecting MDT options in the (b) Display obtained with the settings shown in figure 74a
Options pane

Figure 74: Event 4023 (fifth pass)

7. We choose now the X-projection in the Image menu. In the Set track parame-
ters window, make the selection shown in figure 70a (Reconstructed segments and
tracks). The MDT options are again shown in figure 75a. After zooming, we obtain
figure 75b where labels (section9.1.2) and a caption (section 6.5) have been added.
The red square is the location of a scattering center along the reconstructed track.
Multiple scattering is computed at that location, using the track momentum and
the average amount of surrounding material.

MDT options

" Cross plate (| Long beams ¥ Tubes envelop
™ Tubes ] ]

) End-plugs [ Faraday-cages (| Stair-casing
Persint

(a) Selecting MDT options in the (b) X-projection of reconstructed tracks with the settings shown in
Options pane figures 70a and 75a

Figure 75: Event 4023: Zoomed X-projection with reconstructed tracks
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8. Finally, selecting segments instead of tracks in the Set track parameters window,

according to figure 73a, and choosing the MDT options of figure 76a, we obtain the
display of figure 76b.

Segment is in red \

MDT options

[ Cross plate [ Long beams.
= Tubes [ | [ ]

[ End-plugs || Faraday-cages [_| Stair-casing

=l Tubes envelop

(a) Selecting MDT options in the (b) X-projection of reconstructed segments with the settings shown
Options pane in figures 73a and 76a

Figure 76: Event 4023: Zoomed X-projection with reconstructed segments
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11.1.2 Simulated muon tracks

£
This exercise is only valid for simulated events ! ¥
Clear
e Start with an empty main display by using the Clear view function.
e Load the previous event again (Event 4023) with the Reload event function. @

Reload event

e Open the Set track parameters window and make the following additional selec-
tions: Generate tracks at IP and Only muons so as to obtain the overall selections = @& .

of ﬁgure 7. Set track parameters

e Click on - to close the window.

e Validate the selections by clicking on the Compute icon.

e To visualize the generated tracks, click on the Simulation tracks icon. =
The simulated tracks appear (from the IP). %

Simulation tracks

e Click on the Athena reconstruction icon and the reconstructed tracks appear _
superimposed on the simulated tracks, as expected for a successful reconstruction =4
(Fig.77c).

MuonBoy segments =
) Moore segments =
110 tracks at 1P osocev ) [ ]
@ MuonBoy racksat 1P osocey () [m]
) Muongy tracks at Spectro o =]
oz (=]
oo (=]
oaocey [ ]
020 Gev ) E
P
—
Simulation | Calorimeter Cells  E/G Objects _ TRT Selection |
|
™ Generated tracks at IP 0.10Gev [3)
—— 2249055 [3) ) Generated tracks at spectro 0.10Gev [3)
Segment width —O— 0200778 [1) Displayed tracks (Only muons 18]
( Restore Defauits ) Cooen) Gavem) (Gave) (Ganesl) (060, CRestore Defauts ) (Open) (Savess) (Swve) (Cance) (0K

(a) Selections in the Set track (b) Selections in the Set track pa- (c) Display of simulated and recon-
parameters window (Reconstruc- rameters window (Simulation)  structed tracks
tion)

Figure 77: Event 4023 (sixth pass)

Athena reconstruction
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11.1.3 Reconstructed muon tracks and invariant mass

As seen in 11.1.2, the reconstructed tracks are visualized with the Athena reconstruction
icon (Figure77c). It is possible to compute the invariant mass of two reconstructed
muon tracks in the following way.

e Start with an empty main display by using the Clear view function. hi
Clear
e Load the previous event again (Event 4023) with the Reload event function. @
e Click on the Athena reconstruction icon and the two reconstructed tracks appear. . = .

(Fig. 78a).

-

Select the two tracks by clicking in turn on each track, so that their parameters .
appear on two lines in the Selected volumes window (Fig. 78b). Athena reconstruction
It may be necessary to increase the width of the tracks in order to make the selec-

tions easily. The track width can be increased e.g. to 8, in the Set track parameters

window (Appendix E.5.1).

Track 680 P=+26.13 Pr=25.17 eta=0.28
Track 679 P=-88.39 P1=84.26 eta=0.31

ﬁ\a_ BT —

(& Edit color ) (72 Move to infinity )
( Inv. mass Yy ( Sectors

R\) |

"I Close afterwards

H ( 4 Un-select aII:]

Pareint A

(a) Reconstructed tracks (b) Selected tracks in the Selected volumes win-
dow

Invariant mass of tracks 789, 790 :
- 81.4 GeV/c?

(c) Calculated invariant mass

Figure 78: Invariant mass of two reconstructed muon tracks

e Click on to compute the invariant mass of the selected muon tracks.
The result is shown in figure 78c.
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11.1.4 Interactive reconstruction with Muonboy

We start again with Event 4023 of the Out .MboyView_Zmumu4023 file. Make sure all nec-
essary files are loaded by using the Data manager windows. In particular the Magnetic
field file and the Data cards file need to be loaded as indicated in figures5 and 8 on
pages 21-22. Use the default files for this exercise. Click on the Muonboy interactive
reconstruction icon. Two reconstructed candidate tracks are displayed.

We now make a customized label for each candidate (see section9.1.2) and obtain
figure 79.

Figure 79: Display of two candi- <
date tracks x::\

For each candidate track which is displayed, the Muonboy pane at the bottom left of
the Persint display shows the characteristics as seen in figure 80. This pane also shows
a warning if no muon could be reconstructed. !

Muonboy (5]
2 muon candidate(s).
Total invariant mass : 88.2 GeV/c?
Momentum : -85.3 GeV/c
. 2 oF i .
Figure 80: The parameters of each X" of internal fit : 10
. . 2.

muon candidate are shown in the X" SESNZECE)
Muonboy pane. They include the BDEL R R s
signed momenta of reconstructed Number of strips used : 12
muons, the track fitting parameters, Number of holes : 0
and the invariant mass of a muon pair. Stations used : BOL, BML, BIL

[ Track no. 1 | Track no. 2 |

In the Muonboy window, the total invariant mass of all reconstructed muons is displayed.

le.g. an explicit message is issued if data such as alignment parameters of the A-lines are missing.

=
7
Muonboy

interactive
reconstruction
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A table containing the parameters of all reconstructed muons can be obtained by clicking
on the icon at the right hand side of the title bar, which makes it a floating window.
When this table (Fig.81) is displayed, a right-click on the content will offer the Copy
to clipboard function which can be used to save the reconstruction data in a text file.

Muonboy
2 muon candidate(s).

Total invariant mass 88.2 GeV/c?
Fl.gure 81: The Muonboy window, Track no. 1 Track no.2
with a table of all reconstructed Momentum 853 GeV/c | 21.1GeV/c
muons. The total invariant mass e i3 1.0 18
is given at the top, the invariant X 20.4 (21 d.o.f) | 11.3 (20 d.o.f)
mass of the chosen muon(s) at Number of tubes used | 20 19
the bottom. The Copy to clip- Number of strips used | 12 12
board function is obtained by Number of holes 0 0
rlgh_cllcklng on the table Stations used BOL, BML, BIL BOL, BML, BIL

Invariant mass: —

0.107 GeV/c? E‘ —

The boxes at the bottom of the window make it possible to calculate the invariant mass
of any number of muons by making the appropriate selections. In figure 81 with one box
checked, the invariant mass is the muon mass. Again, the table may be copied to the
clipboard and saved.
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11.1.5 Color code for MDT hits

The interactive reconstruction can be used to look at the reconstruction process in detail.
We start again with Event 4023 of the Out .MboyView_Zmumu4023 file. Make sure all nec-
essary files are loaded by using the Data manager windows. In particular the Data cards
file and Magnetic field file need to be loaded as indicated in figures5 and 8 on pages 21
and 22. Use the default files for this exercise.

With the nominal MDT options (Fig. 82a), we obtain the display of figure 82b.

BILF3Z.+2/BIL/Eta2/ Phi3 /MDT/ML1/ |

MDT options f

E Cross plate M Long beams

¥ Tube envelops [ | Tubes

["1End plugs [1Faraday cages
["] Staircasing
Parsing
(a) Nominal MDT options (b) Event 4023
Figure 82: Event 4023 without reconstruction X o
We now choose the X-projection with the Projection menu, and zoom on the BIL cham- "i‘, ii‘(

ber indicated by a label to obtain figure 83b which uses the MDT options of figure 83a. z ®Z ¢
©

Invert 381

Projection

MDT options

[ Cross plate [l Long beams

[ Tube envelops = Tubes | )

@)
["1End plugs "1 Faraday cages y 5
[ Staircasing oot @)
(a) MDT options (b) MDT hits before reconstruction (red)

Figure 83: Event 4023: Detail of BIL chamber in the X-projection
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|
Muonboy
The reconstructed track is obtained by clicking on the Muonboy interactive reconstruction interactive
. . reconstruction
icon (Fig. 84).

Figure 84: MDT hits after reconstruction (black)

The color code for MDT hits is the following: black hits are those selected by the pat-
tern recognition, red hits do not belong to a track (all hits are selected by the pattern
reconstruction in figure 84).

The interactive reconstruction can be used to act on the event characteristics to un-
derstand which role they play. For instance, a hit MDT tube or a RPC strip can be
removed with the Move volumes to infinity (see section9.2). Then, when re-running the
reconstruction algorithm, the removed tube or strip will not be taken into acccount.
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11.2 Inner Detector data and Vertex display

The primary vertex as well as secondary vertices are available for display. Histograms
of primary vertices can also be produced.

The primary vertex is obtained by a fit of all reconstructed Inner Detector tracks. Like-
wise, the secondary vertices are obtained from an analysis of the ID tracks.

The default settings in the ATHENA job options produce the primary vertex candidate
in the Persint event file 0UT.MboyView_xxx, as seen in AppendixD.3.7: the line VIX
appears seven lines before END EVT line.

To obtain the secondary vertices in OUT.MboyView_xxx, the proper job options need to
be chosen when running the reconstruction programs in ATHENA.

11.2.1 Vertex display
e Start with an empty main display by using the Clear view function.
e Load the previous event again (Event 4023) with the Reload event function.

e To best illustrate this function which displays the vertex, we will first display the
Inner Detector tracks:
Open the Set track parameters window and make the selections shown in figure 85.
In particular, check the “ID tracks at IP” box.!

Clear

(¥

Reload event

#

Set track parameters

[ Reconstruction Simulation Calorimeter cells Physics TRT !

Reconstruction

E MuonBoy segments

=
=)

osocev 2 | ]
0,40 Gev [2] E
0,20 Gev [2] E
0,20 Gev [3] E
0,20 Gev [3] E
0,20 Gev [%] E
0,20 Gev [%] E
0,20 Gev [%] E

"I Moore segments

EID tracks at IP

E MuonBoy tracks at IP

"1 MuonBoy tracks at Spectro
[ Staco tracks at IP

"1 MuTag tracks at IP

"1 Moore tracks at Spectro
[ MulD extra tracks

[ MulD Comb tracks at IP

Maximum d0 1,0000 cm 3]
Maximum |20] 1,0000 cm (2]
Track shape | Ribbon == !
E Draw scattering boxes
Track width —@— 2,249055 [3]

. )
Segment width —_—— 0200778 5 U

[f Restore Defaults \

(Open ) ( Saveas ) Save Cancel OK

Figure 85: Selection made in the Set track parameters window to display Inner Detector
tracks at the IP.

!Note that it is not necessary to display the Inner Detector tracks in order to display the primary
vertex.
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e Click on to close the window.

L,
f

e Validate the selections by clicking on the Compute icon.
Compute

e Click on the Display vertex candidates icon of the event tool bar.
In the window which opens, choose the Vertex display options: check the Primary
vertex box and choose the size and color of the sphere which represents the primary Display vertex

vertex candidates

\
\
=t
" Vertex Display Options |
EPrimawr vertex | 18,00 cm T|I | I ‘
["]Secondary vertices 8,00 ecm - E
[ Cancel
py Bttt
(a) Vertex Display Options (b) Display of Inner Detector (blue) and muon (black) tracks,

and the primary vertex in red.

Figure 86: Display primary vertex.

e Click on to close the window.

e Zoom on the vertex region and obtain figure 86, with the Primary vertex displayed.

11.2.2 Histogram of d0 (primary vertex)

A histogram of the primary vertex candidates in an event is obtained by clicking on
the item Histogram of d0 distribution in the Events menu (See Appendix E.5). The
histogram can be saved in various formats [.png, .gif, .ps, .eps, .pdf, .C (ROOT macro)].

& @ do distribution

0 i

Figure 87: Histogram of d0: distribution of primary
vertex candidates for a 7 TeV collision event.

Each Inner Detector track has an associated dO.

(Run 155678, Event 13304729)
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11.3 Calorimeter data

11.3.1 Display calorimeter hits

e Start with an empty main display by using the Clear view function.

e Load the previous event again (Event 4023) with the Reload event function.

Reload event

e Open the Set track parameters window and choose, in each of the four tabs, the

values shown in figure 88. Make sure to select Energy as Cut-off criterion in the

Calorimeter cells tab.

.

Set track parameters

‘ Restore Defaults

{ i Simulation

Calorimeter cells  Physics  TRT

Reconstruction

™ MuonBoy segments

(] Moore segments

11D tracks at IP

™ MuonBoy tracks at IP
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() Moore tracks at Spectro
[ MulD extra tracks

[ MulD Comb tracks at IP

Maximum d0
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Track shape
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Track width
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0,20 Gev [+ E
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Figure 88: Selection made to obtain the display of figure 89

[
i
e Validate the selections by clicking on the Compute icon. :
Compute
e To visualize the reconstructed muon tracks, click on the Athena reconstruction %,
icon. |
Athena reconstruction
e To visualize the calorimeter cells which have a signal, click on the Hit calorimeter .’
cells icon. . .
Hit calorimeter cells
e To dress the display with some detectors, make the selections in the AMDB pane of

Click on - to close the window.

the Selector window, as shown in figure 89a.
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Figure 89b is the result of these these selections and shows the reconstructed muon tracks,
the calorimeter cells with hits and two sectors of the calorimeters and inner detector.

This display may now be saved for future use: click on the Save view as... icon and save
the file as exercise6-Calo-low-thresholds.p2vf in your Persint_working files direc-
tory.

AMDB

Volume | & Selection | wire
TGC
CsC
MAT
CAL
S5
g 850
ECAL [@pOs D
4
O54
HCAL (@)= ==
&R
v ID
rova)
1D (@)s]===]|
&R

dv vy

(a) AMDB selection pane (b) Calorimeter hits (low thresholds)

Figure 89: Display of event 4023 with two reconstructed muon tracks, and hit calorime-
ter cells: electromagnetic liquid argon in red, [hadronic Tile, endcap, and forward c
alorimeters] in purple

11.3.2 Display calorimeter hits with increased thresholds

1. Display bare calorimeter hits

Starting with the display of figure 89b !, we now change the thresholds for display-

ing calorimeter hits, as they were set very low in the default settings.

Open the Set track parameters window and change the values according to

figure 90. Note that the thresholds may be set for Energy or Transverse energy.
Instead of setting the parameters by hand, you may load the prepared Track

parameter file which we already used in section6.1.2, item 3. Click on

and select Zmumu4023.p2ts in the Persint-00-02-ee /example directory. Click on

and then on the Compute icon. Activate the Athena reconstruction and Hit
calorimeter cells icons to obtain the display of figure 91.

Note that the dressing with calorimeter and Inner detector sectors has been re-
moved by clicking in the center of the three wheels of figure 89a.

Save view as. ..

&

Set track
parameters

(& ite
Athena
reconstruction

'_'l'

Hit calorimeter cells

Note also that since the ”ID tracks at IP” box is checked with a 0.5 GeV/c thresh-
old (Fig.90), Inner detector tracks are displayed as well.

'In case the work was interrupted, remember that the display was saved as a .p2vf file.
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(c) Selections for Simulation (d) Selections for Physics objects

Figure 90: Selection made to obtain the display of figure 91

e

Figure 91: Display of
event 4023 with in-
creased thresholds for
calorimeter hits: essen-
tially 2 GeV in for-
ward calorimeters. Re-
constructed Inner de-
tector tracks are also A

displayed “";ﬂ(

2. Display calorimeter hits inside cell envelopes
In the Set track parameters window (Calorimeter Cells), check the Draw cell enve-

lope box and increase the threshold of "LAr e.m. end-cap (EMEC)” to 0.5 GeV,
and to 2 GeV for "HEC” and "FCal” (Fig.92). Save the selections as a .p2ts file

with the box of the Set track parameters window.
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I Reconstruction  Simulation | Calorimetercells | Physics  TRT
Calorimeter Cells
General cut-off: 999.99 GeV @
E LAr e.m. barrel (EMB) presampler 0.10 CeV @ E
ELAI e.m. barrel (EMB) 0.10 CeV @ E
E LAr e.m. end-cap (EMEC) 0.50 GeV @ E
™ Tile 0.20 Gev 3] E
# LAr hadronic end-cap (HEC) 2.00 GeV @ E
# LAr forward (FCal) 2.00 Cev [3) E
g LAr e.m. end-cap (EMEC) presampler 1.00 GeV @ E
Cut-off riterion @
EDraw cell envelop
( Open ) ( Save as ) ( Save ) ( Cancel ) ( oK )/

Figure 92: Selection of thresholds and cell envelopes to obtain the display of figure 93

After making an X-projection and after some zooming, we obtain the display of
figure 93.

N

Figure 93: Display
of event 4023 (X-
projection) with
increased  thresholds
for calorimeter hits
shown  within  cell
envelopes et
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11.3.3 Histogram of calorimeter hits

Note that the use of the Histogram facility requires that the dependency for QtROOT

be satisfied (see Appendix B).

We start again with Event 4023 of the Out.
Open the Set track parameters window and choose [Restore defaults]. Once the event
is displayed, click on the Histogram of hit calorimeter cells (also available in the Tools
menu). The histogram is displayed in figure 94 and shows the cell energy as a function

MboyView_Zmumu4023 file.

of Eta (Pseudo rapidity n) and Phi (Azimutal angle ¢).

ea00n Histogram of hit caloimeter cells

Energy (GeV)

[(Log fr Range \I I'r Export \I

Run #5145, Event #4023 : energy flow from calorimeter

Energy (GeV)

Figure 94: Histogram of hit calorimeter cells (low thresholds)

We now increase the thresholds of the cell energy in the Set track parameters window

as shown in figure 95.

Figure 95: Selection of high thresholds
in the Set track parameters window:
energy thresholds of LAr HEC and
FCal have been set to 20 GeV'.

Reconstruction  Simulation | Calorimetercells | Physics  TRT | |

Calorimeter Cells

General cut-off: 999.99 GeV rg- (" Apply )

¥ LAr e.m. barrel (EMB) presampler 0.10 Gev 7] E
¥ LAr e.m. barrel (EMB) 0.10 Gev 3] E
¥ LAr e.m. end-cap (EMEC) 0.50 Gev 3] E
# Tile 0.20 Gev 3] E
¥ LAr hadronic end-cap (HEC) 20.00 Cev [3) E
¥ LAr forward (FCal) 2000 Cev |3 E
E‘ LAr e.m. end-cap (EMEC) presampler 1.00 CeV T E
Cut-off criterion ["Energy I ]

E‘ Draw cell envelop

Restore Defaults Open (“Saveas ) Save ) [ Cancel ) ( oK )
e P 2

Histogram of . ..
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To display the modified histogram, close the Set track parameters window by clicking

on the box and then on the Compute icon.

Finally, clicking on the Histogram of hit calorimeter cells icon two times, displays the

modified histogram (Fig. 96).

a0 0n Histogram of hit calorimeter cells

Enemgy (GeV)

[log Ir Range \I fr Export \I

Run #5145, Event #4023 : energy flow from calorimeter

Enemgy (GeV)

Figure 96: Histogram of hit calorimeter cells (high thresholds)

i !

Compute

R

Histogram of ...

+ Energy

Note that calorimeter cell thresholds may be set according to Energy or Transverse energy. = rasese eergy
The selection is made via the Cut-off criterion box in the Set track parameters window.

The histogram can be resized or displaced at will by using the pop-up window obtained
by right-clicking on the title bar of the histogram window.

With Maximize, the histogram will occupy the entire area of the Main display.

With Minimize, the histogram is reduced to a ”"tab” at the bottom of the display, and

can be retrieved with Restore.

ASCII file (.dat format) with the button.

Cut-off criterion

Move

Size
—Minimize
OMaximize
Stay on Top

Aspect of histogram
Just as with previous maps (9.7.3, 9.8, and 9.9), the histogram can be exported as an

The histogram can be saved by clicking on the box. A number of formats are

proposed, as shown in figure 97.

Figure 97:
File formats proposed when saving the Histogram of
hit calorimeter cells

PostScript (*.ps)

Encapsulated PostScript (*.eps)
PDF (*.pdf}

ROOT macro (*.C)

PNG (*.png)

All files (*)

Note that, when scanning events (see section 10.8), the histogram is automatically re-

freshed when a new event is displayed.



89 11 EXERCISE 6: ATLAS PHYSICS EVENTS (2)

11.4 Physics objects
11.4.1 Jets

Reconstructed jets can be shown as labels placed on calorimeter cells.

We will use a real event from data collected in 2011. First clear the display by clicking
on Clear view in the Clear icon menu.

Open the Data manager window and load the file Out .MboyView-74566644-1 from the
Persint-00-02-ee/example directory. Answer ”Yes” to the suggestion to load the
proper geometry file.

Open the Set track parameters window and click on Restore defaults. This will result
in the parameters to be set according to figure 98 which shows the parameters for Re-
construction, Calorimeter cells, and Physics. In particular, use the Physics window
(Fig. 98c) to set the parameters for displaying the jets:

check the Jets box

set the scale (in cm/GeV) for the jet cone (box 1)

set the scale (in cm/GeV) of the arrow of the jet axis (box 2)
choose the number of faces of the jet cone

choose the wire or solid mode for the jet cone

Click on OK and then on the Compute icon'.

T Simulation | Calorimeter cells _ Physics | TRT T TR i i Calori cells | Physics  TRT | {
Reconstruction Calorimeter Cells M
(7] MuonBoy segments E
General cut-off: 999.99 Gev 31 (“Apply
[ = - o ey )
el n
mBE oz0cev 3 | [)LAr e.m. barrel (EMB) presampler 0.40 Cev 2] E
[ MuonBoy tracks at 1P oxocew (=]
r # LAr e.m. barrel (EMB) 0.40Gev [3)
W ozocev (=] =
#taco tracks at 1P 020Gev (3 E (O] LAr e.m. end-cap (EMEC) 0.40 Gev (3] E
Mg racks a P oxocew (=]
# Tile 0.40 Gev 2] E
W et oxocew (=]
———— 020cev 3 E [J LAr hadronic end-cap (HEC) 0.40 Gev [3] E
G P i | — e |
Maximum d0 10000 )
Maximun 101 1,0000 cm (1) )LAr e.m. end-cap (EMEC) presampler 0.40 Gev [3) E
Track shape [ Ribbon \3:
Do seatiering Laxcs Cut-off criterion [Transverse energy %] o
rrack wic —_—— Y A .
Tck ety 0249804 ] Draw cell envelop e
S —_—— o2 )
H
(restor Do) Cooem) Comman) o) (oamcer) @) ( Restore Defaults ) (COpen ) ((Saveas ) ((Save ) ((Cancel) (0K
(a) Selections for Reconstruction (b) Selections for Calorimeter cells
Reconstruction  Simulation  Calorimeter cells | Physics | TRT | [
Sgamma abjects [
™ Photons [ =)
W Electrons =
Trapezoids 0,425 cm/Cev (2] [Solid M = |
Jet, W, ol
Tets 2,000 cm/Gev 2] 2,400 cm/Gev 3] 16 fac (2] [Wire %]E
] Missing Et 500,0 cm 5
"I Regions of Interest (Rol) Select ... 3] [ Wire 0 0,00GeV 7 E
Restore Defaults Open ) (Saveas ) ( save ) ( Cancel )

(c) Selections for Physics objects

Figure 98: Selection made for displaying jets in event 74 566 644 (Fig. 99).

'Remeber that it is usually necessary to click on the Compute icon after closing the
Set track parameters window.

dy . A Ly 3
£ Clear view 2 |
4 Clear AMDB volumes

¢ £ Clear AGDD volumes
| s Clear event

£ Clear labels
£ Clear captions
£ Clear pictures

Clear view

!
5

Compute
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Add the default caption by right-clicking on an empty space of the display.

Add default labels by right-clicking on one of the jet axes and one of the jets cones.
The result is shown in figure 99.

Note that the size (scale) of the jet cones and jet arrows, as well as the color (blue in
figure 99) can easily be modified in the Set track parameters window, Physics tab.

P o — 1
[} y, |Jetl/AntiKt4 TopoEMJets/eta=0.5615/phi=199.5224/R=22.9190/FE=62.8488
o /

ATLAS Experiment
“ Run Number: 182796, Event Number: 74566644

'Dale: 2011-05-30, 06:54:29 CET

Figure 99: Display of an event from 2011 data where the ”jet” feature is illustrated.

11.4.2 Missing Er

A vector representing the calculated missing transverse energy (missing E7) can be
drawn in the following way:

Click on the Set track parameters icon in the Events tool bar (or use the Events menu),
and go to the Physics tab. Check the Missing Er box, and hit the Compute icon. Note
that the legnth of the arrow does not reflect the size of missing Er, but is determined
by the value (in cm) given in the spin box in the Missing Ep line of the Set track
parameters window. The color of the arrow (green in figure 100) can be chosen in the
Set track parameters window, Physics tab (Fig. 98c).

The value of the Missing Ep can be looked up in the information box which appears
when placing the cirsor on the arrow. The same information appears if one inserts a
"label” by right-clicking on the Missing Fr arrow. Note that the value of the Missing
E7 corresponds to the variable MET_RefFinal.

Figure 100 shows the same event with the Missing Er arrow.

Another illustration of the ”Missing E7” feature can be found in figure 125.



91 11 EXERCISE 6: ATLAS PHYSICS EVENTS (2)

-

||

/ /|MET 1I/METRefFinaliphi=164.3354 deg/Et=14493 GeV

S B (

nt
“* Run Number: 182796, Event Number: 74566644
’Datez 2011-05-30, 06:54:29 CET

Figure 100: Display of the same event where the ”"Missing Ep” feature is illustrated.

11.4.3 Rol (Regions of Interest from trigger)

Under development
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12 Persint: a versatile tool

12.1 An analysis tool

Many features of Persint can be used for illustrating the properties of the muon spec-
trometer. For example, the Generate muon tracks function is a convenient tool for
studying the behavior of muons in the spectrometer. In the early collision data of 2009,
a charge asymmetry of low energy muons was spotted in the forward regions.

: _l TT 7T I TTTT I TTTT I TTTT I TrrrT [ TT 17T [ TTrTT I T
3‘_ . . MC
F a
o g + Data
- . .| _
1— Lo, L —
Figure 101: Scatter plot o et . . 3
showing the = /u™ asym- or = . - ]
metry: .;F are more nu- _1; . "ol E
n}erous in the n > 0 re- c 'f‘:f'z . St ]
gion, whereas p* are more 2 L E
numerous in the n < 0 b e . . =
1 1 1 NN TS FEEEE N SRR PR R PR R R
region. ‘This is true for 05 -04 03 02 01 0 01 02 03 04 05
900 GeV  collision data )
and Monte Carlo events. 9/P (GeV')

The effect has its explanation in a rather subtle acceptance property of the spectrometer
for positively and negatively charged muons. Persint was used to illustrate this behavior

[7].

Figure 102: Tllustration of the charge asymmetry of forward low energy muons in
900 GeV collision data. The intricate acceptance effect is illustrated with generated
positive (red) and negative (blue) muons in the forward regions.
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The muons of figure 102 have been generated with the parameters shown in the Generate
muon tracks window of figure 103: P = 10 GeV and | 7 |€ [2.5, 3.0]

| n | ] | Pt | PP | P | Xv | Yv | 2v | Color | = Add muon
2.6 -67.5° | 1.477... <-- 10 GeV 0cm 0cm 0cm —_—
( Remove muon
2.7 -67.5° | 1.338... <-- 10 GeV Ocm Ocm Ocm
2.8 -67.5° | 1.211... <-- 10 GeV Ocm Ocm Ocm
2.9 -67.5° | 1.097... <-- 10 GeV Ocm Ocm Ocm
2.9 -67.5° | -1.09... <-- -10 GeV Ocm Ocm Ocm
2.8 -67.5° | -1.21... <-- -10 GeV Ocm Ocm Ocm
2.7 -67.5° | -1.33.. <-- -10 GeV Ocm Ocm Ocm
2.6 -67.5° | -1.47... <-- -10 GeV Ocm Ocm Ocm
-2.6 -67.5° | 1.477... <-- 10 GeV Ocm Ocm Ocm
-2.7 -67.5° | 1.338... <-- 10 GeV Ocm Ocm Ocm
-2.8 -67.5° | 1.211... <-- 10 GeV Ocm Ocm Ocm
-2.9 -67.5° | 1.097... <-- 10 GeV Ocm Ocm Ocm
-2.9 -67.5° | -1.09... <-- -10 GeV Ocm Ocm Ocm
-2.8 -67.5° | -1.21... <-- -10 GeV Ocm Ocm Ocm
-2.7 -67.5° | -1.33.. <-- -10 GeV Ocm Ocm Ocm
-2.6 -67.5° | -1.47.. <-- -10 GeV Ocm Ocm Ocm
-2.5 -67.5° | -1.63... <-- -10 GeV Ocm Ocm Ocm
-2.5 -67.5° | 1.630... <-- 10 GeV Ocm Ocm Ocm
2.5 -67.5° | 1.630... <-- 10 GeV Ocm Ocm Ocm
2.5 -67.5° | -1.63... <-- -10 GeV Ocm Ocm Ocm
3 -67.5° | -0.99... <-- -10 GeV Ocm Ocm Ocm
3 -67.5° | 0.993.. <-- 10 GeV Ocm Ocm Ocm
-3 -67.5° | 0.993.. <-- 10 GeV Ocm Ocm Ocm
-3 -67.5° | -0.99... <-- -10 GeV Ocm Ocm Ocm
( Open ) ( Save ) ( Cancel ) f—ﬂt—g
¥

Figure 103: List of muon tracks generated in figure 102. Muons of momentum P =
10 GeV have been generated at the IP and propagated through the calorimeters, using
the Generate muon tracks function (section7.1)
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12.2 Study of the geometry and dead material

Persint has been used to optimize the muon spectrometer throughout the design phase.
At present it is the tool with which the most recent layout and the dead material content
of ATLAS support structures are being introduced into the geometry description used
by the reconstruction software.

As an example, the latest barrel toroid cryotube structure has been introduced into the

geometry. With this study using Persint the primary numbers entering the geometry
data base have been updated.!

| \‘P
The red coloured volumes are subtracted. For L ° :
detailed explanation see the next slides!
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Figure 104: Using Persint for the geometry description: the modified volumes are visu-
alized and the primary numbers are entered into the data base.

!The GEOMODEL in particular uses these primary numbers.
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12.3 New MDT chambers: layout and geometrical acceptance

During the long shut down of 2013-2014, additional MDT chambers (so called ”Elevator
chambers”) are being installed in the barrel part of the muon spectrometer. The goal
is to cover areas in the feet region (Sector 13) where the original layout has acceptance
holes. Figure 105 shows the location of the new MDT chambers.

The layout is implemented in the geometry data base and is checked with Persint. In
particular, the geometrical acceptance is verified by reconstructing muon tracks with the
built in reconstruction program Muonboy.

Persint is the only tool available for these studies as a stand alone software package and
is used to display the new chambers in their environment, resolve geometrical clashes and
reconstruct tracks using the new geometry data base. The standard ATLAS software is
not capable of such flexibility and rapid response.

Side C
4
& ’&smshglt
. < 7 P |
BMF3AT2]. = o (e 4 "/ ‘O
> AATCY
s el g ;
- - «L@
BOFTA12'L\ ~ / &
Il m
& 7 v ‘ | \
7/ v / az
A 4 / \
a sector 12 ';'J sector |4
BOEF7Z |
sector 13
e
(a) 3D view (b) Z view

Figure 105: Layout of the new MDT chambers (BME and BOE)

Figure 106 shows the new BME and BOE chambers and illustrates how they close the
holes in the MDT coverage. Generated tracks with the momentum and direction indi-
cated in the box are shown in red. Some tracks which cross two stations (BIL and [BML
or BOL]) are now crossing one additional MDT chamber.

Note the tilted RPC chamber in the BOE station on the left. The tilt is needed because of
an obstacle in the floor structure. This particular geometry is implemented in the latest
AMDB data base so that in Persint the built in Muonboy program is able to reconstruct
tracks crossing this station, even though the RPC chamber is tilted and the station
is outside the standard ATLAS GEANT4 fiducial volume. The reconstructed track is
shown in figure 107",

!Some illustrations are taken from a presentation by Vasiliki Kouskoura (Muon Software Meeting,
June 6, 2013):
https://indico.cern.ch/getFile.py/access?contribId=9&resId=0&materialld=slides&confId=
256006
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Figure 106: The new MDT chambers in Persint.
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Figure 107: Reconstructed muon in the new MDT chambers, using Persint and Muonboy.
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12.4 ATLAS Upgrade studies: New Small Wheel

PERSINT was used during the 2013-2014 shutdown to check the geometry (AMDB primary
numbers) of the new small wheel Micromegas chambers. Several checks and improve-
ments have been made. These studies were only possible with PERSINT because it is a
standalone program which is not hindered by the rigid data base structure in ATHENA.
The turnaround is fast enough to be efficient and useful for such studies.

e
o W Ty
I‘ ' LI

=

Figure 108: Layout including the New Small Weels:
the sTGC’s are in grey, the MicroMegas detectors in purple
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13 Selected event displays
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Figure 110: Min Bias event in 900 GeV data: Run 141749, Event 171059. (December, 2009)
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Figure 111: A J/¥ — pp candidate in the 7 TeV collision data of 2010.

YZ view : N\ \ QXY view
R \} U

Figure 112: The same J/¥ — pu: in 2D projections and details of track reconstruction.
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W->pv candidate in 7 TeV collisions;

Run Number: 152221, Event Number: 383185
Date: 2010-04-01 00:31:22 CEST

PT(u+) = 20 GeV, 1 = 0.66

ETmis = 24 GeV

MT =53Gev

Figure 114: A W — pv candidate in the 7 TeV collision data of 2010.

YZ view =~ ~ XY view

W->pv candidate in 7 TeV collisions
Run Number: 152221, Event Number: 383185

Date: 2010-04-01 00:31:22 CEST

PT(u+) = 29 GeV, n = 0.66

ETmis = 24 GeV

MT  =53Gev

http://atlas.ch

Figure 115: The same W — pv candidate: in 2D projections and details of track reconstruction.
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Figure 125: Candidate event H — ppupup with Etp,ss as a green arrow. M (pppup)
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Figure 127: Candidate J/v — pp in Heavy Ion collisions. Run 169226; Event 379791.
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Figure 129: Heavy Ion collision Z — ee + ?7. Run 193546; Event 27903149. (20-11-2011)
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14 Useful hints

1. Compute
The effect of the Compute icon is to make all computations necessary to display
an event, after changes have been made to the parameters.
Actionning Compute is not always necessary:

For example, after closing the Set track parameters window by clicking
on , it is necessary to validate further with Compute. On the

contrary, after closing the Generate muon tracks window with , it
is not necessary to use Compute.

There is no general rule for using the Compute action. When in doubt,
it is always prudent to use it.

2. Interrupt/resume your work
It is important to realize that it is possible to interrupt and resume your work at
any time. In case Persint cannot be left idle during the pause, you can save the
files used by the program as specific ASCII files. The relevant files (described in
Appendix D) are:

e The .p2vf file m
It contains everything necessary ! for displaying the current view of the Main <&
display (see section 6.4, item 1). The file is saved with the Save view as... Save viewas...
icon, and retrieved with the Open view icon. -

e The .p2gm file Open view

This file contains the parameters of the tracks generated with the Generate
muon tracks icon (section7.1). The file is saved from within the Generate
muon tracks window by clicking on the box.

e The .p2ts file
This file contains the parameters of the Set track parameters window (Appendix E.5.1).
These parameters define the objects chosen for display in an event (Tracks,
segments, MDT, RPC, ID hits, calorimeter hits, electrons, photons, etc.), as

well as their energy or momentum thresholds. The file is saved from within
the Set track parameters window by clicking on the box 2.

3. Previous view
When modifying the aspect of a view with the navigation tools, is is sometimes -{_‘l
difficult and time consuming to go back to a previous display which seemed satis-
factory. The Previous view icon makes it possible to retrieve up to ~ 100 displays
backwards.

Previous view

'Labels and captions are saved but pictures (e.g. the ATLAS logo) are not.
2The box saves the file and makes it the default file.
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15 APPENDICES

A Architecture

Persint, the detector and event display for the ATLAS muon spectrometer originally
conceived by Marc Virchaux, now has a new Graphical User Interface developped withQt.
This appendix gives a short description on how the software source code is organized.

e Software development philosophy

QE/C++ Graphical User Interface

Intermediate laver containing
O+ wrapning classes

Software Fortran core

Figure 130: Architecture of the Persint source code

As shown in figure 130, the source code is divided into 3 distinct parts :

1. The core corresponds to Fortran code, e.g. algorithms for computing hidden
faces, routines for reading input files, and so forth...

2. The ”"wrapping” layer, written in CT, is a communication layer between the
program core and the graphical interface. It is made of classes encapsulating
the calls to Fortran routines.

3. The C** code for the Graphical User Interface (GUI).

Thus, there is no direct call to Fortran core routines from the GUI as they are only
called by the wrapping layer. Wrapper classes are organized by topics, e.g. one for
views, one for AMDB volumes, etc...

e File organization
Most source files created for the new interface are located in one of the following
three directories :

1. PersintCore/persint2_core
This directory contains all Fortran routines called by the ”"wrapping” layer.
Most of theses routines have been written specifically for the new GUI and
are code fragments extracted from the initial HIGZ- based version of Persint.
Like wrapper classes, these routines are organized by topics. For example, all
methods dealing with AMDB volumes are gathered in file wrap_amdb.FF90.
Moreover, each routine name is prefixed with a string identifying its topic :
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AMDB volume related routines start with ”AMDB_”, etc. ... Files whose
name does not start with ”"wrap_” only contain routines called from other
Fortran routines, not directly from the wrapper classes.

2. Persint2Core

This directory contains C** header (.h) and source (.cpp) files respectively
defining and implementing all wrapper classes. Each wrapper class in this
directory is associated with a Fortran file in the PersintCore/persint2_core
directory. The only constructor in each of these classes has the ”protected”
attribute, so that the only way to actually instantiate a wrapper class - and to
access its methods - is by creating a derived class. These wrapper classes have
been implemented so that, whenever possible, they use standard C* libraries
rather than Qt- specific tools. This directory also contains classes required by
the GUI but without calls to Fortran routines (e.g.: ColorF, persint::Colors,
FCString, ...).

3. PersintGui

This directory contains all Qt classes developped for the new interface. Files
with .ui extension are XML files created with the Qt designer and describing
widgets. They should be edited with the designer-qt4 executable. The direc-
tory also contains .h and .cpp files implementing classes derived from Qt wid-
gets. These classes inherit from wrapper classes as is necessary for interacting
with the core of the application. For instance, the persint::AmdcVolumeTree
class inherits from the persint::Amdb wrapper class in order to be able to
access functions related to AMDB volumes. Files ending with _moc.cxx or
_ui.h are generated automatically by Qt tools during compilation and should
not be edited by hand.

e Sample ASCII files
The various files used by Persint are listed and described in AppendixD. They
include files which contain all the information about geometry, detector description,
magnetic field, events, track parameters, generated muons, etc.
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B Installation and dependencies

This chapter is included in the manual for reference and for completeness.

However, for up-to-date instructions and easy installation, consult the Twiki page
https://twiki.cern.ch/twiki/bin/view/Atlas/Persint2Wiki
and use copy-paste operations.

The latest release of Persint is : Persint-00-02-74. This version number is used
throughout these instructions. Check for the latest version at the link indicated above.
Earlier releases can be found at:
http://atlas.web.cern.ch/Atlas/GROUPS/MUON/Persint/releases/

The running of Persint is dependent on a number of libraries which need to be installed
beforehand. Satisfying these dependencies involves procedures which depend on the
platform. On the contrary, the installation of Persint proper is common to all platforms.
The complete procedures ! are described below for reference. Bugs, comments, installa-
tion problems, or questions can be reported to :
https://groups.cern.ch/group/atlas-sw-persint-support/default.aspx

B.1 Suported platforms

Persint is developed under the latest Ubuntu release. We also make sure it runs at
CERN on Ixplus machines as well as under Fedora. We provide best effort support for
Mac OS X.

History of Persint installation tests

Platform Persint
os Release Arch. C++compller Qt  Rel Notes
Ubuntu Utopic (14.10) amd84/i386 GCC 4.8.2 4.8.6 00-02-72

Trusty LTS (14.04) amd64/i385 GCC4.82 4.8.6 00-02-73
Saucy (13.10) amdB4/i386 GCC 481 484 00-02-T0
Raring (13.04) amd84(i3856 GCC4.7.2 4.8.3 00-02-88
Quantal (12.10) amdB4/3858 GCC4.7.2 483 00-02-89
Precise LTS (12.04) amdB4/i388 GCC 4683 481 00-02-89
Oneiric (11.10) amd84/i385 GCC 4.6 4.7.4 00-02-89
Natty (11.04) amd64/i386 GCC4.52 4.7.2 00-02-69
Maverick (10.10) amdB4/i388 GCC 4.4.5 4.7.0 00-02-69
Lucid LTS (10.04) amdB4/i388 GCC 443 462 00-02-31
Hardy LTS (8.04) amd84/i386 GCC4.23 4.34 00-02-27
Scientific Linux Cern Carbon (6.4) xB6_ 64 GCC 47 484 00-02-72 kplus
Mac OS5 X Mavericks (10.9.3)  x86_54 LLVM51 486 00-02-73
Mountain Lion (10.8.4) xB8_ 84  GCC4.7.3 4.8.5 00-02-88
Snow Leopard (10.6.8) xBE 84  GCC4.21 4.8.4 00-02-65

Fedora Beefy Miracle (17) i386 GCC47.0 4.8.2 00-02-57 VirtualBox 4.1 on Mac OS X
Debian Squeeze (6.0) x86 64 GCC 445 463 00-02-57 VirtualBox 4.1 on Ubuntu
Cent0S 6.3 xB6_64 GCC 446 4.6.2 00-02-57 VirtualBox 4.1 on Ubuntu
5T i386 GCC4.1.2 474 00-02-27 VirtualBox 4.0 on Ubuntu
Cygwin 1.7 iBBE GCC 453 453 00-02-48 Tested under Windows 7

Figure 131: History of Persint installation

When updating to a new version of Persint, it is usually sufficient to do only the installation without
repeating the part concerning dependencies.
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B.2 Installation
B.2.1 Tarball (default procedure)

Download and install the complete source tarball (15 MB).
In the following, ~00-02-ee is the evolving version number of Persint, e.g. Persint-00-02-74

wget http://atlasinfo.cern.ch/Atlas/GROUPS/MUON/Persint/releases/00.02.00/
src/Persint-00-02-ee.tar.gz

tar xvfz Persint-00-02-ee.tar.gz
cd Persint-00-02-ee

./configure

make -3j3

./start_persint.sh

Warning: the above instructions assume all dependencies are satisfied.

B.2.2 svn

Download code from source repository and install, as follows.

After configuring subversion, checkout the Persint source code. From the Persint direc-
tory, run the bootstrap.sh script to download other required Atlas software compo-
nents. You can then start compilation with "make”.

After you are done, simply run the .start_persint.sh script, that will set your library
and binary paths and run the program.

export SVNROOT=svn+ssh://svn.cern.ch/reps/atlasoff

svn co $SVNROOT/graphics/Persint/tags/Persint-00-02-ee Persint-00-02-ee
cd Persint-00-02-ee

./bootstrap.sh

make -j3

./start_persint.sh
Warning:

e The above instructions assume all dependencies are satisfied.

e Subversion configuration: if your local username is different from your lxplus
username, you may need to specify the latter in your $HOME/ . ssh/config file.
For details, see:
https://twiki.cern.ch/twiki/bin/viewauth/Atlas/SoftwareDevelopmentWorkBookSVN.

B.2.3 Ubuntu package

Persint is available as an Ubuntu package on a dedicated repository!. However, this
package provides a version of Persint without histograms (because ROOT is no longer
available as an Ubuntu package). To benefit from histograms, you need to install Persint
by hand.

The procedure below can be found at:
http://sizun.web.cern.ch/sizun/persint/ubuntu.html.

"http://atlas-samusog.web.cern.ch/atlas-samusog/mionboy/persint/jobOptions.html
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Persint on Ubuntu

To install Persint on ubuntu, follow the following steps:

1. Add the repository containing the persint package to the package manager's list of available repositories:
o Edit the /efc/apt/sources.list file (with administrative privileges, e.g. gksudo gedit fetc/apt/sources.list)and add this line:

deb http://sizun.web.cern.ch/sizun/ubuntu <ubuntu_version> contrib
Replace <ubuntu_version> with the version of ubuntu you are using (i.e. vtopic, frusty, saucy, raring, quantal, precise, oneiric, nafty, maverick, lucid or
hardy).
You may want to run leb_release —-codename --short to find out which it is.
2. Add to the package manager's list of trusted keys the GPG key used to digitally sign the persinf package:

sudo apt-key adv --recv-keys =--keyserver keyserver.ubuntu.com 25DB4A9D

In case the keyserver.ubuntu.com key server fails to respond, you may try one of the following servers: pgp.mit.edu, kevs.gnupg.net, wwwkeys.ch.pgp.net.
3. Update the list of available packages:

sudo apt-get update
4. Install the persinf package:
sudo apt-get install persint
You should then be able to start Persint via the Applications > Science Of Applications > Education Menu panel (depending on your ubuntu release).

Support

« Mailing list: atlas-sw-persint-support

Notes
« Packages are now only provided for release trusfy (14.04 LTS) and later.

« For other distributions, platforms, installation methods or versions of Persint, please refer to the official Persint page.
« This repository is not always updated as frequently as the official Persint repository.

Creation: December 3rd, 2009. Last modification: June 23rd, 2014.

B.2.4 Pre-installed lxplus version
If you have an account on the lxplus network, you can run a version of Persint pre-
installed on AFS, though it might be a little slower.
Run the pre-installed version of Persint on Ixplus:
ssh -X lxplus.cern.ch

\ln -sf /afs/cern.ch/atlas/www/GROUPS/MUON/Persint/releases/00.02.00/s1c5-x86_64-gcc34/
share/ Persint/start_persint.sh

./start_persint.sh

B.3 Dependencies

Persint no longer requires either CERNLIB, HIGZ or LAPACK.

B.3.1 Mandatory requirements

1. Install C** compiler

e Ubuntu
sudo apt-get install g++

e Mac OS X
After installing MacPorts (see B.4.1):

sudo port install gcc46

e Fedora
With administrative privileges (su command), execute the following command line:
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yum install gcc-c++
e Debian

sudo apt-get install g++
e CentOS 5/6

With administrative privileges (su command), execute the following command line:

yum install gcc-c++

e CernVM
After installing OpenAFS:

source /afs/cern.ch/sw/lcg/external/gcc/4.3/‘uname -m‘-slc5/setup.sh

e Cygwin
Update your Cygwin installation by running the setup.exe program to install the
following package:

gccld-g++
2. Install a fortran compiler

e Ubuntu
sudo apt-get install gfortran

e Mac OS X
After installing MacPorts:

sudo port imstall gcc46
sudo 1ln -s /opt/local/bin/gfortran-mp-4.6 /opt/local/bin/gfortran

e Fedora
With administrative privileges (su command), execute the following command line:

yum install gcc-gfortran
e Debian

sudo apt-get install gfortran
e CentOS 5/6

With administrative privileges (su command), execute the following command line:
yum install gcc-gfortran

e Cygwin
Update your Cygwin installation by running the setup.exe program to install the
following package:

gccd-fortran
3. Install other standard utilities: wget, make, perl, pkg-config, head, sed

e Mac OS X
After installing MacPorts :
sudo port install wget pkgconfig
export PKG_CONFIG_PATH=/opt/local/lib/pkgconfig;

You might want to add PKG_CONFIG_PATH to your login script.

e Fedora
With administrative privileges (su command), execute the following command line:

yum install wget pkgconfig xterm perl

e Debian
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sudo apt-get install make pkg-config
e CentOS 5/6

With administrative privileges (su command), execute the following command line:
yum install wget pkgconfig xterm perl make
e Cygwin
Update your Cygwin installation by running the setup.exe program to install the
following package:

wget make sed tar pkg-config

4. Install Qt
Persint requires Nokia’s Qt framework (>4.3.4).

e Ubuntu
sudo apt-get install libqt4-dev

e Mac OS X
After installing MacPorts :

sudo port install qt4-mac +debug
This may take a while. ..
e Fedora
With administrative privileges (su command), execute the following command line:
yum install qt-devel
e Debian

sudo apt-get install libqt4-dev

e CentOS 5
The release of Qt (4.2) provided by the gt4-devel CentOS 5 package is too old for
Persint. Hence, Qt needs to be installed from source. Set the PKG_CONFIG_PATH
variable appropriately to indicate to Persint the location of Qt.

e CentOS 6

With administrative privileges (su command), execute the following command line:
yum install gt-devel

e Cygwin
Update your Cygwin installation by running the setup.exe program to install the
following package:

qtd4-devel-tools 1libQtCore4-devel 1ibQtGui4-devel 1ibQtTest4-devel libQtNetwork4-devel

¢ CernVM
After installing OpenAFS, add the path of Qt on AFS to the PKG_CONFIG_PATH
variable:

export PKG_CONFIG_PATH=/afs/cern.ch/sw/lcg/external/qt/4.6.3/
‘uname -m‘-slcb-gcc43-opt/1ib/pkgconfig/: $PKG_CONFIG_PATH

e Scientific Linux Cern
The release of Qt (4.2) provided by the gt4-devel SLC5 package is too old for Persint.
Hence, Qt needs to be installed from source.

— Ixplus
The location of the Qt library on AFS will be automatically taken care of by
the Persint makefile and the start up script.
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— Non-lxplus machine with access to CERN AFS directories
Qt is installed in the /afs/cern.ch/sw/lcg/external/qt/ directory. Choose the
appropriate version and add the path of the lib/pkgconfig subdirectory to your
PKG_CONFIG_PATH environment variable.

— Standalone machines
Download and install Qt from source. If you do not install it into a standard lo-
cation, add the path of the lib/pkgconfig subdirectory to your PKG_CONFIG_PATH
environment variable.

B.3.2 Optional features

Install QtROOT. QtRoot is a Qt plugin of ROOT, used to display ROOT histograms
within the Qt interface. The version of QtROOT you install should be compatible with your
version of the Qt4 library.

1. General instructions

e Method 1

The simplest way to get QtROOQOT is to install ROOT with the —enable-qt flag. You
first need to install Qt and pkg-config to allow the ROOT configure script to find
Qt. Then :

wget ftp://root.cern.ch/root/root_v5.30.00.source.tar.gz

tar xvfz root_v5.30.00.source.tar.gz

cd root

export QTDIR=‘pkg-config --variable=prefix QtCore°

./configure --enable-qt --prefix=<PREFIX> --etcdir=<PREFIX>/etc

make

make install

e Method 2
To install the latest QtRoot module, you will need to use the official INSTALL_QTROOT . sh
script and to follow these instructions. This method is for experts of Unix only. Af-
ter installing Qt and pkg-config, you will have to download the INSTALL_QTROOT. sh
script and patch the script before running it:
wget http://root.bnl.gov/QtRoot/INSTALL_QTROOT.sh

wget http://atlas.web.cern.ch/Atlas/GROUPS/MUON/Persint/releases/
INSTALL_QTROOT.sh.patch

patch < INSTALL_QTROOT.sh.patch

chmod u+x INSTALL_QTROOT.sh

export QTDIR=‘pkg-config --variable=prefix QtCore°
./INSTALL_QTROOT.sh

The existing version of Qt package has been found under QTDIR=

Do you want to use it? (yes/no) yes

Do you want to proceed? (yes/no) yes

Do you want to install COIN3D also? (yes/no) no
After installation is complete, you need to run the QtRoot setup script:
./set_environment.sh
You might want to add this command to your login script.
2. Ubuntu

In Ubuntu releases 8.10 (Intrepid), 9.04 (Jaunty), 10.04 (Lucid) and 10.10 (Maverick),
QtRoot is directly available as an Ubuntu package :
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sudo apt-get install root-plugin-qt libroot-dev

For other releases, follow general instructions above, but set the QTDIR variable by hand
to:

export QTDIR=/usr/share/qt4

3. Mac OS X

After installing MacPorts, install the qt_mac variant of the root port:

yum install gt-devel

4. Fedora
With administrative privileges (su command), execute the following command line:

yum install root-gui-qt root-physics

5. CernVM
After installing OpenAFS:

source /afs/cern.ch/sw/lcg/app/releases/
ROOT/5.30.00/ ‘uname -m‘-slc5-gcc43-opt/root/bin/thisroot.sh

Install SOCI library. Persint uses the SOCI library for access to the ATLAS Oracle
databases, to download extra geometry files. This feature is really optional.

1. Install the Oracle Database Instant Client software development kit.

¢ Ubuntu

(a) Go to the Oracle download page, in the Instant client section and select
the appropriate platform. Download the Instant Client Basic RPM pack-
age and the Instant Client SDK RPM package. You will need to create
a (free) Oracle user account an to accept the license agreement.

(b) Convert the RPM packages into debian packages :
sudo apt-get -y install alien

sudo alien -d oracle-instantclient-basic-<version>-<platform>.rpm
oracle-instantclient-basic-<version>-<platform>.rpm

(c) Install the generated debian packages and their dependency libaio :

sudo dpkg -i oracle-instantclient-basic-<version>-<platform>.deb oracle-
instantclient-basic-<version>-<platform>.deb

sudo apt-get -y install libaiol

(d) Define some environment variables to notify Persint of Oracle’s location:
export ORACLE_LIBDIR=/usr/lib/oracle/<version>/client/lib;
export ORACLE_INCDIR=/usr/include/oracle/<version>/client;

(The exact name of the installation directories will depend on your platform.)
e Mac OS X

— Install the oracle-instantclient port:
sudo port install oracle-instantclient

Make sure you download the actual zip files and not an HTML error page (accept

the license agreement first, and use the left mouse button).

(a) Delete intermediate files created by the failed building process and
create a directory
/opt/local/var/macports/distfiles/oracle-instantclient:
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sudo port clean --all oracle-instantclient
sudo port selfupdate
sudo mkdir -p /opt/local/var/macports/distfiles/oracle-instantclient
(b) Go to the Oracle download page, register, download manually the
packages
instantclient-basic-10.2.0.4.0-macosx-x64.zip
and
instantclient-sdk-10.2.0.4.0-macosx-x64.zip
and place them into the newly created directory:
/opt/local/var/macports/distfiles/oracle-instantclient
sudo mv instantclient-*.zip /opt/local/var/macports/distfiles/
oracle-instantclient/
Make sure you download the actual zip files and not an HTML error page
(accept the license agreement first, and use the left mouse button).
(c) Install the downloaded packages
sudo port install oracle-instantclient
— Define some environment variables to notify Persint of Oracle’s location:
e Scientific Linux Cern
On a SLC machine with access to CERN AFS directories:

export ORACLE_INCDIR=/afs/cern.ch/atlas/www/GROUPS/MUON/Persint/releases/
opt/oracle/instantclient10_-1/sdk/include;

export ORACLE_LIBDIR=/afs/cern.ch/atlas/www/GROUPS/MUON/Persint/releases/
opt/oracle/instantclient10_1;

2. Install the SOCI C*+ Database Access library.

e General intructions
wget http://downloads.sourceforge.net/soci/soci-3.0.0.tar.gz
wget http://downloads.sourceforge.net/soci/soci-3.0.0.tar.gz
tar xvfz soci-3.0.0.tar.gz
\rm soci-3.0.0.tar.gz
cd soci-3.0.0
wget http://atlas.web.cern.ch/Atlas/GROUPS/MUON/Persint/releases/soci-3.0.0.patch
patch -pl < soci-3.0.0.patch

./configure --include-prefix=<PREFIX>/include --lib-prefix=<PREFIX>/lib
--oracle-include=$0RACLE_INCDIR --oracle-1ib=$0RACLE_LIBDIR

make

make install

Where <PREFIX> is the installation path of your choice. You might encounter an
error if the version of your Oracle client is recent as SOCI expects version 10. Just
patch the SOCI source code before compilation :

sed -i ’s;nnzl0;nnz<version>;g’ build/unix/build-oracle.tcl

sed -i ’s;nnzl10;nnz<version>;g’ src/backends/oracle/test/Makefile.basic
Inform Persint of the library’s location with an environment variable :
export SOCI_HOME=<PREFIX>;
e Scientific Linux Cern On a SLC machine with access to CERN AFS directories:
export SOCI_HOME=/afs/cern.ch/atlas/www/GROUPS/MUON/Persint/releases/opt;
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B.4 Platform-specific instructions
B.4.1 Mac OS X

1. Installing MacPorts
To install the required dependencies, you might want to install MacPorts.

(a) First install, if not already done, Apple’s Xcode tools from Mac OS X instal-
lation DVD or from Apple’s site

(b) Download and install the MacPorts software distribution package

(c) Update the list of available ports:

sudo port selfupdate

2. Updating MacPorts ports

sudo port selfupdate

sudo port upgrade outdated

B.4.2 CernVM
1. Installing CernVM

e VirtualBox (https://www.virtualbox.org/wiki/Downloads)
e http://cernvm.cern.ch/portal/downloads
e CernVM (https://twiki.cern.ch/twiki/bin/viewauth/Atlas/CernVM)

e CernVMGuideSoftwarelnstall
(https://twiki.cern.ch/twiki/bin/viewauth/Atlas/CernVMGuideSoftwareInstall)

2. Installing OpenAFS

e See CernVM release notes (http://cernvm.cern.ch/portal/release_2.4.0)
e Do:

sudo conary update group-openafs-client openafs openafs-client
sudo conary update kernel-module-openafs-‘uname -r‘

sudo mkdir -p /afs

echo cern.ch > /tmp/ThisCell

sudo cp /tmp/ThisCell /usr/vice/etc/ThisCell

After reboot, AFS should be mounted under /afs. To authenticate use the kinit
command.

3. Installing binary distribution of Persint

e Install AF'S and authenticate with kinit
e Download, install and setup binary kit

wget http://atlas.web.cern.ch/Atlas/GROUPS/MUON/Persint/releases/00.02.57/
Persint-00-02-ee-cernvm- ‘uname -m‘-gcc43-qt463.tar.gz

tar xvfz Persint-00-02-ee-cernvm-‘uname -m‘-gcc43-qt463.tar.gz

cd Persint-00-02-ee

source install_cernvm.sh

./start_persint.sh
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B.4.3 Cygwin

1. Installing Cygwin under Windows 7
Install Cygwin by running setup.exe.

e In addition to the packages listed in the dependencies, select the following
packages required to connect to an X server:
xorg-server xinit

e Before starting Persint (using the start_persint.sh script), connect to a
Cygwin/X server by typing startxwin from the Cygwin shell.
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C ATLAS coordinate system
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X XYZ Right handed coordinate system TN
with z in beam direction

Figure 132: ATLAS coordinate system.
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D Files used in Persint

D.1 File formats

Several types of files are encountered when using Persint. Most are specific to Persint,
except the “exported” files used for presentations and publications.

File extension

Description

Default directory

Comments

.p2vt

Detector description file.

Persint-00-02-ee
/example

Produced by Persint
with the Save view as
function of the File menu.
Retrieved with the

Open view function.
(Section 6.3, item 3)

.p2ts

Track parameter file for
displaying an event

Persint-00-02-ee
/example

Produced with Save or
Save as, retrieved with
Open in the Set track
parameters window.
(Section 6.3, item 6)

.p2gm

Generated muon
parameter file

Persint-00-02-ee
/example

Produced with the Save
action, retrieved with the
Open action in the
Generate muon tracks

window.
(Section 7.1, Figure 19)

amdb_simrec.xxx

Detector geometry file
(" primary numbers”)

Persint-00-02-ee
/amdcData/share

Loaded from the Volumes
tab of the Data manager

(Section6.1.1,

item 1; figure 77)

window.

Bmagatlas.data

Magnetic field file

Persint-00-02-ee
/BFieldData/share

Loaded from the
Magnetic Field tab of the
Data manager window.
(Section 6.1.1, item 2;
figure 77?)

Out .MboyView_yyy

Reconstructed event file

Persint-00-02-ee
/example

ASCII file produced by
ATHENA.
(Section6.1.1, item 3,
figure 77 and

Section 6.1.2, item 2)

.png, .jpg, .bmp

File containing the

User’s choice

Produced by Persint
with the Export function

.svg, .ps, .pdf Persint Main Display of the File menu.
(Section 6.4)
Produced by the Export
.dat ASCII file User’s choice function in_ the  varous

maps available in the

Tools menu
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Directories for Persint files

" Open an AMDB geometry file

[ 3 /Usersiemw ein/desktop/Persint/Persint-00-01-75/AmdcDala/share |4

e EE

Look in:

Bl Computer | ™ amdb_simrec.r.01.01.Cosmics_Barrel_sector13.v01

AN _ amdb_simrec.r.01.0 1.Initial.Light_v02_Egg

[g ernwein amdb_simrec.r.01.01.Initial.Light_v02_Egg_InAlinesOnly
amdb_simrec.r.01.0 1.Initial.Light_v02_Egg_Rndm
amdb_simrec.r.01.0 1.Initial.Light_v02_Egg_Rndm_InAlinesOnly
amdb_simrec.r.01.0 L.Initial.Light-M4-EIL4only
amdb_simrec.r.01.0 L.Initial.Light-M4 -EIL4 only-TileMov-NoEIS-NoT 4 -noBee-NoCSC-noshield
amdb_simrec.r.02.03.Initial.Light.BML.513.Patch
amdb_simrec.r.03.01.Initial.Light.BML.513 .Patch
amdb_simrec.r.03.01.Initial.Light.EIL.BML.513.Patch
amdb_simrec.r.03.02.Initial.Light.BML.513 .Patch
amdb_simrec.r.03.05

amdb_simrec.r.03.11

amdb_simrec.r.03.13

amdb_simrec.r.04.01

EEEEErErEEEE v |

| amdb_simrec.r.04.02
1 amdb_simrec.r.04.03
_J amdb_simrec.r.04.04
| ] amdb_simrec.r.04.05

File name: amdb_simrec..04.01.A-ignes

(" Open )

'ﬂ (" Cancel )

Files of type: [ AlFies (*)

3

(a) Available geometry files in Persint/AmdcData/share. This window is prompted when clicking
Load in the Data manager window (Volumes tab) of figure 4.

eanon | AtlasNode_AmdcFile_MagFieldFile.txt |
ATLAS-CommMF-85-0-88  amdb_simrec.r.8z.82.Initial.Light-PaAtchBML-IDParserkRA1-MG MF ~
ATLAS-CommMF-A6-AA-8A  omdb_simrec.r.BZ.02.Initial.Light-P4&tchBML-I0ParserkA1-MG MF

ATLAS-CommMF-A7-AA-88  omdb_simrec.r.BZ.082.Initial.Light-P4&tchBML-I0ParserkA1-MG MF

ATLAS-CommMF-83-A8-68  amdb_simrec.r.83.81.Initial.Light .BML.513.Patch MF

ATLAS-Conm-G8-86-68
ATLAS-Conm—81-80-88
ATLAS-Conm-A2-80-68
ATLAS-Conm-A3-80-68
ATLAS-Conm-A4-80-88
ATLAS-Conm-A5-60-08
ATLAS-Conm-A5-86-68

amdb_simrec.r.81.81, Initial.Light
andb_simrec.r.81.81. Initial.Light bmagat losB4_testl.data
andb_simrec.r.91.81.Initial.Light bmagat lose4_testl.data
amdb_simrec.r.91.81.Initial .Light-M4-EIL4only-TileMov-NOEIS-NoT4-noBee-MoCSC-noshield  bmogat los@4_testl.data
r
r

bmnogat lasA4_testl.data

omdb_simrec.r.B1.81.Initial .Light-M4-EIL40only-Ti leMov-NoEIS-NoT4-noBee-NoC5SC-noshie ld-corr bmogot losP4_testl.dota
andb_simrec.r.B2.82, Initial .Light-PAtchBML-IDPorserRAL-MG bmagot lasB4_testl _WithMoToroid_OnlySolandIron.data
andb_simrec.r.83.81, Initial .Light .BML.513.Patch bmagat |a=65_test2.dota

ATLAS-GEONF -B4-B0-86 andb_simrec.r.83.81.Initial.Light .BML.513.Patch NF

ATLAS-GEOMTF-85-08-88  amdb_simrec.r.B3.01.Initial.Light .BML.513.Patch bmagot lasPd_testl _WithMoToroid_OnlySolandIron.data

ATLAS-GEOMSF-A3-0A-88  amdb_simrec.r.93.03 bmagot Lloses_testZ_MoSalenoid.data
ATLAS-GEO-AS-AA-AZ omdb_simrec.r .B3.85 bmagat la=A5_testZ?.dota
ATLAS-GEO-1A-AA-AA omdb_simrec.r.B3.11 bmagat la=A5_testZ?.dota
ATLAS-GED-1A-A8-A1 andb_simrec.r.83.13 bmagat |a=65_test2.dota
ATLAS-GEO-11-A6-AA andb_sinrec.r .84 .81 bmagat |a=65_test2.dota
ATLAS-GED-11-81-08 andb_simrec.r.B4 .81 bmagat |as@5_testZ.data
ATLAS-GED-11-82-08 andb_simrec.r.B4 .81 bmagat las_B5_ful [455ym28488 .data.bzz %
ATLAS-GEO-11-A3-0A andb_simrec.r .94 .81 bmagat las_B5_ful lAsynz0488 . dota.bzz .
ATLAS-GEO-11-A4-AA omdb_simrec.r .84 .81 bmagat las_B5_ful |453ym0ld .data.bz2 v
DEFAULT andb_simrec.r.A3.13 bmogat lasA5_test2 .data 4

(b) Part of the file ”Persint-00-02-ee/PersintData/AtlasNode_AmdcFile MagFieldFile.txt”: Correspondence be-
tween geometry and magnetic field files

D.3 File description

Figure 133: Details of some files used by Persint.
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D.3.2 .p2ts

[simulation] parameters\tile\checked=1
parameters\Gen_trk_at_IP\checked=0 .

parameters\Gen_trk_at_IP\value=0.1 parameters\endcap_lar_hadr\checked=1
parameters\Gen_trk_at_spectro\checked=1 .
parameters\Gen_trk_at_spectro\value=0.1 parameters\very_forward_lar\checked=1

options\simul\value=1 .
parameters\endcap_presampler\checked=1

[reconstruction] parameters\endcap_presampler\value=0.1

parameters\Mboy_Seg\checked=1 parameters\endcap_presampler\red=1

parameters\Mboy_Seg\red=1 parameters\endcap_presampler\green=0.2

parameters\Mboy_Seg\green=0 parameters\endcap_presampler\blue=0.2

parameters\Mboy_Seg\blue=0 options\envelop\value=0

parameters\Moore_Seg\checked=0

parameters\Moore_Seg\red=0 [EgamaObjects]

parameters\Moore_Seg\green=1 parameters\Photons\checked=1

parameters\Moore_Seg\blue=0 parameters\Photons\red=1

parameters\ID_trk_at_IP\checked=0 parameters\Photons\green=0.6

. parameters\Photons\blue=0.2

parameters\Mboy_trk_at_IP\checked=0 parameters\Electrons\checked=1

. parameters\Electrons\red=0.6

parameters\Mboy_trk_at_spectro\blue=0 parameters\Electrons\green=0.6

parameters\Staco_trk_at_IP\checked=0 parameters\Electrons\blue=0

parameters\MuTag_trk_at_IP\checked=0 [TRT]

. parameters\bra\checked=0

parameters\Moore_trk_at_spectro\checked=0 parameters\bra\min=6

. parameters\bra\max=50

parameters\MuID_Extra._trk\checked=0 options\braphi\value=32

. parameters\brc\checked=0

parameters\MuIDcomb_trk_at_IP%20\checked=0 parameters\brc\min=6

. parameters\brc\max=50

options\matter\value=1 options\brcphi\value=32

options\width\value=1.71 parameters\eca\checked=0
parameters\eca\min=6

[calorimeterCells] parameters\eca\max=50

parameters\barrel_presampler\checked=1 options\ecaphil\value=32

. parameters\ecc\checked=0

parameters\barrel_lar_em\checked=1 parameters\ecc\min=6

. parameters\ecc\max=50

parameters\endcap_lar_em\checked=1 options\eccphil\value=32

options\allenvelop\value=0

D.3.3 .p2gm

[Muons]

1\track=1.2, 90, 100, true, 0, 0, O

1\color=@Variant (\O\O\O\x43\x1\xff\xff\xff\xf£\0\0\0\0\0\O0)
2\track=1.2, 0, 100, true, 0, 0, O

2\color=@Variant (\O\O\O\x43\x1\xff\xff\0\O\O\O\xff\xff\0\0)
3\track=1.2, 0, 10, true, 0, 0, O

3\color=@Variant (\O\O\O\x43\x1\xff\xff\0\O\xff\xff\0\0\0\0)
size=3
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D.3.4 amdb_simrec.xxx

3k 3k 3K 3k 3k 3k 3k %k 3k 3K 3k 3k 5k %k 3k 3k 3k 3k 5k 5k %k 3k 3K 3k 3k 5k 5k 5k 3k 3k 3k 5k %k >k >k 3K 3k 3k 5k %k 5k 3k 3k 5k 5k %k >k 3K 3k 3k 3k 5k % 3K 5k 3k 5k 5k %k >k 3k 3K 3k 3k %k % 5K 3k 3k 5k %k %k >k 3k >k %k >k k kK

NAME (16 Char.) of this AMDB_SIMREC data base (ATLAS Muon Layout version R)

stokokok ok sk okokokok o kokok ok
stk ke sk sk s ok sk sk o ok sk ok ok
R.03 01
.Initial.Light.BML.S13.Patch
BIS 1,2,4,5,6 without supports
BML 01d numbering
EIL mv by 20m to avoid clashes in GeoModel/G4
NO EEL, EES
stk ok ok sk sk ok ok sk ok ok sk ok ok
stokokok ok ootk ok o kokok ok

COMMENTS :
Final Layout R
R.03 01
Huge corrections From Stefania Spagnolo on RPC orientation
all corrections appear with comments "x"
Update on RPC and cutouts
-BMS 2 5, 6 , 7 (cutouts)

-BOF
-B0OG
-W RPC 7
-add W DED 3
Update XML part for Andrea converter
-saddle
-PP2
-passerel/platforms
-ECT_Cryo7SidTemp suppress composition replace by a rotation
-many ";" + other correction in Patch Panel.

R.02 03

corrections From Andrea Dell’Acqua about ";" and TGCSupport

Without symetry convention to build TGC support
CSC position corrected
R.02 02
ID Patch Panels PP2 (not at the correct position)
Muon Barrel Access Platforms
Feet Struts
Access Platform Sector 13
MDT Big Wheel
Calorimeter Saddle
TGC support (not at the correct position)
BOL Support
Mobylette: Cyclomoteur

R.02 01:
Pierre-Franois
new 1 BIM with HV <-> RO inverted
new 6 BIR with HV <-> RO inverted + correction 75mm
BIS8 bad position
BML sector 13 add hole corresponding to elevator place
12345 -> 12367
BOG bad position
Stefania
BMF1,BMF2,BMF3 LB2->LB1
BOG1,B0G2,B0G4,B0G5 RPC size
W PRC8, RPC17
Florian
B0S2,B0S3,BOF1->BOF8 1868->1853 (+3mm? should be checked)

¥ OX X X X K K K K K K K X X K K K K K K K X K K K K K K K K K K K K K K K X K K K X K K K X X K K K X X X X = X ¥ ¥ ¥ ¥ *
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BOS1 CRO est a -2656mm
CRV est a 1050mm
: Same Dead Matter as R.01.01
initially based on q.02_test8
R.01 01 BOG positions from ATLM____0034 Version AG (Layout R sector 12) based on Feet as installed
EOL/EOS positions in Z according to Layout R Version AG
BOG 6 RO/HV swapped from ATLM____0041 Version AG (Layout R sector 14)
BOL sector 13 positions z+40 mm after elevator shaft according to Layout R Version AF
AGDD-XML section : correction to JDSH_TUBEleng, JDSH_PLUGleng
variable names follow DB conventions
implementation of ECT Service Tower
correction to EEL sector 9
positions of stations located at Z<0 not mirrored following 30.035 wire pitch
dz of BOG cutouts following 30.035 wire pitch
BOL 3,6,7 swap dz of RPC and DED (stations not mirrored)

¥R K X X X X X X X X X X X * X *

KKK oK ok ok ok o ok KoK oK ok ok ok o o KoK oK ok ok ok o K KoK oK ok ok ok o ok KK ok ok ok ok o o kK oK ok ok ok o kKK oK ok ok ok o ok KK ok ok ok ok Kok ok ok ok ok K

VERSION NUMBER (Integer I5) of this AMDB_SIMREC data base (Default is 0)

*okk Kk
*okok Kk

7
*okkkok
*kkkk

¥R X X < X X X X ¥

53 ok oK oK K 3 ok oK oK K o ok oK oK K o ok ok oK K ok ok oK K ok ok oK K K 3 ok oK K K 3 ok ok ok K 3 ok ok oK K ok ok K K 3 ok ok ok K K 3k ok oK K K 3 ok ok ok K ok ok ok K ok ok ok K ok

The lines which start with the character D correspond to the
Hokskok ok

DEFINITION OF THE DIFFERENT STATIONS

The station Typ It is formed of No different objects (or multi-layers).
*A KKK KoKk

Within a station, the relative postion of each object is given by

dx , dy and dz , the local reference frame (x,y,z) being
Kdokk  kokokk *ok ok

the same one as in V.Chaloupka Data Base.
--------------- > Typ It : Identify the station type.
------------- > No : Number of objects forming the station.
And, for each object
——————————— > dx, dy, dz : Relative position of the object.
——————— > TIo : Object serial number in the station.
| - > Tec : Type of technology used for the object.
| - > Iw : Inner structure type index.
| ———————- > Isplit_x : Number of sections in x
| for RPC’s (1 if missing).

| ====—- > Isplit_y : Number of sections in y
| for RPC’s (1 if missing).

¥R K X K X X X X K X K X X X X K X K X X X X K X X X X ¥ X ¥ ¥ ¥ ¥ %

| —----> Ishape : Type of geometrical shape
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missing
or 0 --> trapezoidal (or rectangular)
1 --> "T" shaped
2 --> "Diamond" shape (CSC)
3 --> rotated trapezoids (TGC)

————— > Width_xS, Width_xL, Length_y,
Excent., Deadl, Dead2 :
Dimensions of the object

(See figures).

¥ X X X X X X X ¥ ¥

x|
* XXX-X X | |
*XXXXX--XXXXX--XXXXX X XXX X
*XXXXX--XXXXX--XXXXX X XXX X

X XXXXXX--XXXXXX--XXXXXX--XXXXX--XXXXX--XXXXX
X XXXXXX--XXXXXX--XXXXXX--XXXXX--XXXXX--XXXXX

B — — — — — — — — — — — —

3k 3K 3K 3k 3k 3k ok >k 3k 3K 3k 3k 5k %k 3k 3k 3k 3k 3k %k %k 3k 3K 3k 3k 5k %k 3k 3k 3k 3k 5k %k >k 3k 3k 3k 3k 5k %k 3k 3k 3k 5k 5k %k >k 3k 3K 3k 3k %k %k 3k 3k 3k 5k 5k %k >k 3k 3K 3k %k %k %k 5k 3k 3k %k %k %k >k 3 >k %k %k %k Xk Xk

The lines which start with the character C correspond to the
Heokskok ok

DEFINITION OF THE CUT-OUTs IN THE STATIONS
The cut-out Icut in the station Typ It is formed of Nocut

kk kKK k %k %k K 3k %k %k k % ok kKK k k

different sub-cuts in the various objects (or multi-layers) of
this station.
————————————— > Typ It : Identify the station type.
------------ > Icut : Cut-out index
| === > Nocut : Number of sub-cuts in the station.
: And, for each sub-cut
: -------------- > dx, dy : Relative position of the sub-cut.

——————— > To : Serial number of the object in which
the sub-cut is made.

————— > Width_xS, Width_xL, Length_y,
| Excent.

| Dimensions of the sub-cut
| (see figures).

¥ O X X K X K X X X X X X K X X X X X X X X X ¥ X ¥ X * ¥

I
[
|
I
[
[
[
*XXXXX--XXXXX X XXXXXX--XXXXXX--XXXXXX--XXXXX
X

* XXX-X X X |
*XXXXX--XXXXX XXXXXX--XXXXXX--XXXXXX--XXXXX

*¥—— Definition of stations --- -—= -—= -—= -

* Typ I No

* s z t IoTecixym W_xS W_xL L.y Ex D1 D2 D3
Hokokokok Kok Rokokdokokk  kkok kk o kok ook ok ok Hokokkok ook Hokokkokok ok

* skokokok ok ook *k Kk okk kskokakokokskok skokok ok ok ok ok ok sokokk ok ook ook sk ko ok

*
*

*¥—— Definition of BIL stations ---- - - - -
* Typ I No
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* dx dy dz Io Tec i xy s W_xS W_xL L_y Ex D1 D2
x ..
DBIL1 7
0. 0. 0. 1 MDT 1 2671.5 2671.5 1081.261 0. 55. 0.
-1280. 0. 123.07 2 CHV 1 6.0 6.0 1081.261 0. 0 0.
0. 0. 123.07 3 CMI 1 6.0 6.0 1081.261 0. 0 0.
1280. 0. 123.07 4 CRO 1 6.0 6.0 1081.261 0. 0 0.
0. 215. 170.57 5 LB 1 2620.0 2620.0 50. 0. 0 0.
0. 815. 170.57 6 LB 1 2620.0 2620.0 50. 0. 0. 0.
0. 0 293.07 7 MDT 2 2671.5 2671.5 1081.261 0. 55. 0.
DBIL2 7
0. 0 0. 1 MDT 1 2671.5 2671.5 901.051 0. 55. 0.

and so on ...
towards end of file

<mposPhi volume="raill" ncopy="8" Phi0O="-14.35" R_Z="10040;-6000" impliedRot="false" />
<mposPhi volume="rail2" ncopy="8" Phi0="14.35" R_Z="10040;-6000" impliedRot="false" />
</composition>

</section>

<section name = "Solenoid"
version = "1.1"
date = "22 11 1962"
author = "laurent"
top_volume = "Solenoid">

<l--

ook ok ok ok ok ok ok ok ok o ok ok sk ok o ok ok sk ok ok ok ok o ok ok ok o ok ok oKk o ok ok ok K o ok ok ok ko ok ok ok ok ok ok ok ok ok ok ok ok ok ko K
* ok ok Solenoid *ok kK
ok ok K K o ok ok K K o ok ok K K o ok ok K K o ok ok K K 3 oK ok K 3 3 oK ok oK 3 K oK ok oK 3K K oK ok ok K K o ok ok Kk K ok ok kK ok ok ok K K

-=>
<tubs name="tubs_hole" material="Azur" Rio_Z="1200;1300;5000" />
<composition name="Solenoid">
<posXYZ volume="tubs_hole" XY Z="0; 0 ; O" />
</composition>
</section>
<section name = "EtaOServices"
version = "1.1"
date = "22 11 1962"
author = "laurent"
top_volume = "EtaOServices">
<cons name="cons_angle" material="Orange" Riol_Rio2_7Z="4500;9000;4500;9000;300" profile="-14;28" />

<composition mname="servicesAtZ0" >
<mposPhi volume="cons_angle" Phi0="45" ncopy="8" >
</mposPhi>

</composition>

</section>

</AGDD>

X p— —_ —_ —_ ————— -

*
*
*
End
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D.3.5 Bmagatlas

B-3D-R.1  ATLM dtb => atlmOlp
8 5.80 20500.00 20500.00
30 4 1.28 5.78 492.20 985.30 1241.00 137.90
1 4 1.25 4.30
32
122.46
498.57
825.04
1256.16
96.00
96.00
80 99 0.785398185

0.000000000 0.006000000 0.008500000 0.009000000 0.011000000 0.013900000
0.017238000 0.019000000 0.022000000 0.024070000 0.027379000 0.030670000
0.035531000 0.043423000 0.052974000 0.064359000 0.078351000 0.115947000
0.168554000 0.231067000 0.285960000 0.325066000 0.341732000 0.349282000
0.356406000 0.359997000 0.364267000 0.368445000 0.370000000 0.372000000
0.374908000 0.378033000 0.379500000 0.380000000 0.381000000 0.382000000
0.384113000 0.388406000 0.392699000 0.396685000 0.398699000 0.400670000
0.401699000 0.402500000 0.403760000 0.404000000 0.405199000 0.406800000
0.409937000 0.411699000 0.414699000 0.416769000 0.420078000 0.428230000
0.445673000 0.471050000 0.508646000 0.561253000 0.623766000 0.678659000
0.699990000 0.717765000 0.729584000 0.734431000 0.738464000 0.741981000
0.745518000 0.749105000 0.752696000 0.756966000 0.761144000 0.762699000
0.764699000 0.767607000 0.770732000 0.772699000 0.774699000 0.776812000
0.781105000 0.785398000

0.0000 38.0000 72.0000 100.0000 124.0000 145.0000

492.0000 516.0000 543.0000 566.0000 636.0000 723.0000
764.2500 791.7500 805.2619 812.8077 816.0000 818.0000

and so on ...
towards end of file ...

Cy;zJzEzNz0zv=yYP+2+1z+zwztzozmzjzhzf=xJ6=yZ1!228!227z6zaz5!2z7z6!2z7'!4z6z5z6g.=
xrWy;=y6jyedPzu=z2m*2!5y;y,y:y, ! 2yZyXyWyV!2ySyQ! 2yRySyVyXy.yL=-2Cy; zJzEzNz0zv=yY
P+2+1z+zwztzozmz jzhzf=xJb=yZ1!2z827z627zaz5!22z72z6!2z7!526z5g:=xrLy;=y; 0*1=xQAzm=
z2ny;*1y;*1y;y:y;y,y:y,y. ' 2yY!12yVI2ySyQ! 2yRySyVyXy . yL=-2Cy; zJzEzNz0zv=yYP+2+1z+z
wztzozmzjzhzf=xJi=yZ12827282627zaz5!4272627262z5!226z5h0=xrz*1=x¥YnystZzi=z2n*1y;*
113y;y:y,y:y,y. ' 2yY!12yV!2ySyQ! 2yRySyVyXy . yL=-2Cy; zJzEzNz0zv=yYP+2+1z+zwztzozmzjz
hzf=xJq=yZ20z9!'4z72zaz5z8z6!3z7!4z6z526h2Q00*%3=xUez j=z2n*2!4y;y:y,y; ! 2y. 1 2yY!2yV!2y
SyQ!2yRySyVyXy.yL=-2Cy;zJzEzNz0zv=yYP+2+1z+zwztzozmz jzhzf=xJx=yZ0!2z8!3z7zaz6! 2z
726!1227262725!226z5h6=xqUz1NzyML1zm=z20y;*1y;*1y;y:y;y.y; ! 2y.yZyXyWyU!2ySyQ! 2yRy
SyVyXy.yL=-2Cy;zJzEzNz0zv=yYP+2+1z+zwztzozmzjzhzf=xJ)=yZ0!228!3z7zaz6 ! 2272628262
713z6!2zbha=xq-*1=y;0%1=xV) zq=z20*1y;*1!3y;y:y,y:y, ! 2yZyXyWyUyTyRyQ! 2yRySyVyXy .y
L=-2Cy;zJzEzNz0zv=yYP+2+1z+zwztzozmz jzhzf=xJD=yZ0!2z8!3z7zaz6 ! 5z7 ! 4z6z5z6hd=xqk*
1-x23,Xzt=z20%2!4y;y:y,y:y, ' 2yZyXyWyUyTyRyQ! 2yRySyVyXy . yL=-2Cy ; 2JzEzNz0zv=yYP+2+
1z+zwztzozmz jzhzf=xJF=yZ0z8z7z8!2z7zaz6!5z7 ! 5z26z5hfPQ*3=xVNzv=2z2py; *1y; *1y; ! 2y:y
,¥:Y, 1 2yZyXyWyUyTyRyQ! 2yRySyVyXy . yL
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D.3.6 Description of the Out.Mboy View ASCII event file readable by PERSINT

Here is an example of an event file. The first word of each line is a keyword which has to start
on the first column : only the first 3 letters are mandatory, and usually case sensitive.
The first part of the file contains global parameters which are optionnal.
GEO geometry : if present, it should be the first line and contains info on the geometry to be
used, i.e. ATLAS-DC3-05.
RTpara integer allows to set the RT relations which will be used for MDT.
0 default, the RT will be explicitely given for each MDT of each event using the RS lines
which will be described later.
> 0 will use our "home-made" parametrization done on the first cosmic rums.
< 0 a constant value (equals to the abs of the given value, divided by 100) in cm will be used.
For nice displays, -120 is a good choice.
Then for each event,
NEW EVT eventNumber runNumber AmdcAthenaFlag CosmicFlag
AmdcAthenaFlag : hits are identified by the Amdc (0) or Athena identifiers (1 = default).
CosmicFlag : O if standard (collision) or 1 if cosmic
HIT numberMDThits numberRPChits numberTGChits number CSChits
MDT BIL il i2 i3 i4 i5 X Y Z DriftTime ADCcount Particle TDCcount digitID
i1l to i5 are the Athena idenfiers of the given tube/station
X Y Z are the positions of the middle of the tube. If unknow, put 0. 0. 0. and they will be
computed by Amdc.
RPC BML il i2 i3 i4 ib5 i6 i7 i8 X Y Z Particle digitID time
il to i8 are the Athena identifiers of the given strip/station
X Y Z are the positions of the middle of the strip. If unknow, put 0. 0. 0. and they will be
computed by Amdc.
END EVT last line of the event.
In addition to the muon information, we can add calorimeter or tracking information in these
files. Starting with the calorimeter cells, the format is
CAL TYP radius eta phi layer Energy(MeV) deta dphi dr dx dy dz
TYP indicates the type of calorimeter. It must be one of the following 3 characters words :
PSB(PreSamplerBarrel), EMB(largEmBarrel), EME(largEmEndcap), TIL(tile), HEC(largHadronicEndcap), FCA(veryForwardEndcap)
or PSE(PreSamplerEndcap)
radius, eta and phi give the position of the center of the cell
deta, dphi, dr, dx, dy, dz give the size of the cell. The parameters used are (dx, dy, dz)
for FCA, (deta, dphi, dr) for PSB, EMB and TIL and (deta, dphi, dz) for EME, HEC and PSE.
The parameters not used may be arbitrary.
Example :
CAL EME 615.1562 -2.5600 0.2495 1 722.0 0.1000 0.0982 0.0000 0.0000 0.0000 224.1685 740294660

For Egamma Objects the format is

CAL EgammaContainerLocation X Y Z Px Py Pz E eta phi Charge

electromagnetic objects are dumped if : //(isEM & Ox7FF)==0 means all cuts except TRT

X,Y,Z are the track intercept at the perigee, Px,Py,Pz are the gtrack momentum at the perigee

for neutral particles, X,Y,Z and Px,Py,Pz are set to O

E, eta, Phi are the cluster energy, pseudo-rapidity and azimuth respectively

Example :

EGA egammaCollection 0.001 -0.035 -11.853 -50455.172 -792.320 -49976.254 73027.702 -0.882 -3.117 -1

For Trackparticle and Trk::Track Objects the format is :

TRK TrackParticle TrackParticleContainerLocation dummy X Y Z Px Py Pz Charge PDG_Code

the track representation is the perigee one

Examples

TRK McEventCollection TruthEvent dummy 0.009 0.006 23.258 -1400.825 2469.821 -6805.638 1 211

TRK CombinedMuon MboyESDMuonContainer dummy 2.488 -82.009 -591.075 -1125.241 -34.143 -7849.847 -1 0

TRK TrackRecord MuonEntryLayerFilter dummy -50.110 -52.002 -6740.000 -8.635 1.688 -125.547 -1 11

TRK CombinedMuon StacoCombinedMuonContainer dummy 0.000 0.001 84.526 31681.809 -12270.981 37905.569 1 0O

TRK CombinedMuon MuidCombinedMuonContainer dummy 0.002 0.005 84.522 31454.320 -12184.459 37634.866 1 O

TRK CombinedMuon MuidExtrCombinedMuonContainer dummy -7.415 -19.176 94.293 32445.334 -12545.980 38727.635 1 0
TRK TrkTrack Tracks KalmanFitter 0.012 0.002 83.630 103.873 -670.289 -3445.807 1 0O

TRK TrkTrack ConvertedMBoyMuonSpectroOnlyTracks Muonboy 4021.170 -1375.752 4822.313 28616.934 -9429.886 33776.897 1 0
TRK TrkTrack ConvertedMooreTracks MooreLegacyCnv 4133.017 -1699.972 5078.248 30054.322 -11982.251 36321.348 1 0

Description
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TRK McEventCollection TruthEvent are the generated tracks. They are drawn inside the tracker (except for muons).

TRK TrackRecord MuonEntryLayerFilter are the generated tracks at the spectrometer entrance.
They are drawn starting from the surface defining this spectrometer entrance.

TRK TrkTrack ConvertedMBoyMuonSpectroOnlyTracks are the Muonboy tracks, drawn inside the spectro.

TRK CombinedMuon MboyESDMuonContainer are the Muonboy tracks, back-propagated to the interaction point.

TRK TrkTrack Tracks are the tracks from the Inner Detector.

TRK CombinedMuon StacoCombinedMuonContainer describe the Staco tracks, i.e. combination of InDet and Spectro tracks.
For Segment Objects the format is :

SEG MuonSegment TrkSegmentCollectionLocation X Y Z Dx Dy Dz Chi2

X,Y,Z are the segment position (global frame)

Dx,Dy,Dz the segment direction

Chi2 the segment Chi-squared

Example :
SEG MuonSegment ConvertedMBoySegments -7271.419 -5869.373 -14294.539 -0.114541 -0.096927 -0.988679 8.2018
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D.3.7 Out.MboyView_Zmumu4023

GEO ATLAS-GE0-02-01-00
NEW EVT 4023 5145 1 0
HIT 44 36 0 0 O

MDT
MDT
MDT
MDT
MDT
MDT
MDT
MDT
MDT
MDT
MDT
MDT
MDT
MDT
MDT
MDT
MDT
MDT
MDT
MDT
MDT
MDT
MDT
MDT
MDT
MDT
MDT
MDT
MDT
MDT
MDT
MDT
MDT
MDT
MDT
MDT
MDT
MDT
MDT
MDT
MDT
MDT
MDT
MDT
RPC
RPC
RPC
RPC
RPC
RPC
RPC
RPC
RPC
RPC
RPC
RPC
RPC
RPC
RPC
RPC
RPC
RPC
RPC
RPC
RPC
RPC
RPC
RPC
RPC
RPC
RPC
RPC
RPC
RPC
RPC
RPC
RPC
RPC
RPC
RPC
RS3
RS3
RS3
RS3

RS3
TRK
TRK
TRK
TRK
TRK
TRK

BIL
BIL
BIL
BIL
BIL
BIL
BIL
BIL
BIL
BIL
BIL
BIL
BIL
BIL
BIL
BIL
BIS
BIS
BML
BML
BML
BML
BML
BML
BML
BML
BML
BML
BML
BML
BOL
BOL
BOL
BOL
BOL
BOL
BOL
BOL
BOL
BOL
BOL
BOL
BOL
BOL
BML
BML
BML
BML
BML
BML
BML
BML
BML
BML
BML
BML
BML
BML
BML
BML
BML
BML
BML
BML
BML
BML
BML
BOL
BOL
BOL
BOL
BOL
BOL
BOL
BOL
BOL
BOL
BOL
BOL
BOL

Trackl
Trackl
Track
Trackl
Trackl
Trackl

2 1
2 2
2 2
2 3
2 5
2 4
2 5
2 5
2 7
2 7
2 7
2 8
2 10
2 10
2 11
2 10
-7

=7 2

OO NN WWWo

NNNWWWWWwWwWwWwWwNNNNN NN NN NTWW W wWwwwwwwwwwooNNNNNNWWWWwwwNNNNNNWWWwwwoooNNNNNNNN®Wwwwwwww

PR R RRRRRRRRRONNNNRRRRRBRBONNNNHEHEHEEEERERERBERNNNNAERERNNNRRRRONRNNRRRONONNRREBEOBEONONNEREBERBEONNNE BB
PR RERRRRRRRRERRRRRRBRREREBRBBHBHBHBHBHEHEHEHEHEEEEEEREBNDONEFONREFONR, O, OO, OORONORONRE AR R RAONE RO R RN -
P
o

NONOMNOMNOMNNMNONOMNOMNONONOMONMNONNONONOMNONNMONONONERNDNNMNNONNOMNOMNOMNOMONMNNONONONNDNNDN

NEPNRNRRRRRONRRRONRNONRORRONRBRORRNDENERBNDNR B

7 1
0 -1308.750  4770.927
1 -1308.750  4796.939
2 -1308.750  4822.950
3 -1308.750  4848.961

43 -4822.968 -8293.094

Record MuonEntryLayerFilter
Record MuonEntryLayerFilter
Record MuonEntryLayerFilter
Record MuonEntryLayerFilter
Record MuonEntryLayerFilter
Record MuonEntryLayerFilter

cOcoooooo0o

Lo
© 0o oo

40 -
41 -

44 -
45 -
45 -

FPOORKLPHRHEPROOOOHRRLROORKHROOORHKHLOORKEREROOOOO
-
w

16
1 16
1280.035
1295.052
1310.070
1325.087

6885.787
dummy
dummy
dummy
dummy
dummy
dummy

.000
.000
.000
.000
.000
.000
.000
.000
.000
.000
.000
.000
.000
.000
.000
.000
.601
.481
.000
.000
.000
.000
.000
.000
.000
.000
.000
.000
.000
.000
.000
.000
.000
-000
.000
.000
.000
.000
.000
.000
.000
.000
.603
.031

-860.
-860.
-860.
-860.
-860.
1086.
1059.
1086.
-860.
-860.
1165.
1192.
1192.
.000
.000
.000

4770.927
4796.939
4822.950
4848.961
5048.997
5075.009
5101.020
5127.031

100
000
000
900
500
500

.000

.500
.500
.500
.550
.650
.850
.750
.650
.500
.500
.050
.050
1.0000000
1.0000000
1.0000000
1.0000000

.400
.400
.700
.400
.400
.400
.400
.700
.400
.700
.400
-9857.
0.0000000
0.0000000
0.0000000
0.0000000

700

and so on ...

-0.7071068 0.7071068

26.
34.
303.
26.
-19.
-0.

231
158
879
442
992
584

1

31.
-22.
107.

31.

7.

40.

035 0.000
052 0.000
070 0.000
087 0.000
157 0.000
140 0.000
157 0.000
175 0.000
245 0.000
227 0.000
245 0.000
262 0.000
332 0.000
350 0.000
367 0.000
350 0.000
210 0.000
805 0.000
087 0.000
105 0.000
122 0.000
227 0.000
245 0.000
262 0.000
332 0.000
315 0.000
332 0.000
472 0.000
490 0.000
472 0.000
402 0.000
420 0.000
437 0.000
542 0.000
560 0.000
577 0.000
612 0.000
630 0.000
647 0.000
752 0.000
770 0.000
787 0.000
140 0.000
787 0.000
1900.750
1927.250
1874.250
1900.750
1927.250
2285.000
2285.000
2285.000
2112.750
2112.750
2285.000
2285.000
2285.000
2086.250
2112.750
2086.250
2285.000
2285.000
2285.000
2298.250
2298.250
2285.000
2285.000
2834.000
2868.000
2902.000
2868.000
2885.000
2885.000
2885.000
2885.000
2885.000
3023.150
3053.450
2705.000
2705.000
0.0000000
0.0000000
0.0000000
0.0000000
0.0000000
511 -5169.224
677 4018.539
051 -881.413
334 3931.646
941 -6750.000

996 -4986.499

12

12
12

21

101
88
161
90
145

116
147
83
88
107

108
146
83
80
129
94
103
133
83
106
66
104

101
120
116
83
116
98
110
64
99
97
106
127
126
96
107

111
98
95

0.

-37

275.

-265
18

-3.

DDODDDDDDADDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDDD DD O

222.625
222.625
222.625
222.625

236.262
120
.150
440
.210
.730
045

DDA DDDDDDDDDDDDDDDDDDDDDDDDDDDD DD O

-

R g N

14
-7.
33.

-195.
-166.
99.
-9.

860
662
.356
.765

.548
474
002
088
037
074
014

0N OSWN RO

31.250
31.250
34.375
31.250
31.250
25.000
31.250
28.125
31.250

34.375
34.375

34.375
31.250

28.125
31.250
28.125
34.375
37.500
31.250
34.375
40.625
43.750

43.750
40.625

40.625
43.750

50.000
50.000

40.625
12.854
5.646
1.324
8.752

14.546
-239.587
325.454
-130.474
1465.477
-7258.469
-114.564

PR RRBRRERRERBERBEBRBRERBRERRERERBRBRERBRERRBRBERBERBERBRRBRRBRRBRB&

12.846
5.628
1.289
8.740

[ e S e

© = o

14.

.838
.608
.261
.729

541

12.830
5.587
1.239
8.718

14.538



142 D FILES USED IN PERSINT
TRK TrackRecord MuonEntryLayerFilter dummy 19.337 36.153 -4880.334 11.948 -29.038 -142.377 1 -11
TRK TrackRecord MuonEntryLayerFilter dummy -3.994 40.805 -5043.736 -13.777 -7.566 -159.787 -1 11
TRK TrackRecord MuonEntryLayerFilter dummy 5.694 40.603 -5154.146 -2.102 -44.098 -604.135 1 -11
TRK TrackRecord Muo00.02.nEntryLayerFilter dummy 0.281 40.999 -5648.321 0.957 -13.118 -193.964 -1 11
TRK TrackRecord MuonEntryLayerFilter dummy 688.370 -918.723 2261.243 -229.182 -66.157 376.339 1 211
TRK TrackRecord MuonEntryLayerFilter dummy 4.389 54.630 6750.000 -7.909 485.134 63057.680 -1 -211
TRK TrackRecord MuonEntryLayerFilter dummy 40.997 0.510 3480.941 -305.727 -539.746 1183.440 1 2212
TRK TrackRecord MuonEntryLayerFilter dummy -10.345 -51.670 -6750.000 -192.807 -783.343  -95296.601 -1 -211
TRK TrackRecord MuonEntryLayerFilter dummy -2.909 40.897 -4784.081 210.335 -339.444 -2224.941 1 2212
TRK TrackRecord MuonEntryLayerFilter dummy -25.355 61.174 -6750.000 -600.697 1353.510 -154378.164 1 211
TRK TrackRecord MuonEntryLayerFilter dummy -12.254 -65.734 -6750.000 -207.946 -1240.695 -121680.794 1 211
TRK TrackRecord MuonEntryLayerFilter dummy -677.366 4196.687 1128.050 -3174.049 20625.379 5930.249 1 -13
TRK TrackRecord MuonEntryLayerFilter dummy 215.236 -4245.547 1281.801 3628.730 -75960.679 24125.117 -1 13
TRK McEventCollection TruthEvent dummy 1.503 2.503 -67.259 1.503 2.503 -67.259 1149.462 -2204.
TRK McEventCollection TruthEvent dummy 1.503 2.503 -67.259 1.503 2.503 -67.259 -1054.058 -829.
TRK McEventCollection TruthEvent dummy 1.503 2.503 -67.259 1.503 2.503 -67.259  -20725.680  -55372.
TRK McEventCollection TruthEvent dummy 1.503 2.503 -67.259 1.503 2.503 -67.259 40281.672 -1251
TRK McEventCollection TruthEvent dummy 1.503 2.503 -67.259 1.503 2.503 -67.259 -1087.246  -55982.
TRK McEventCollection TruthEvent dummy 1.503 2.503 -67.259 0.000 0.000 0.000 3688.245  -81230.
TRK McEventCollection TruthEvent dummy 1.503 2.503 -67.259 0.000 0.000 0.000 -4775.492 25248.
TRK McEventCollection TruthEvent dummy 1.503 2.503 -67.259 1.503 2.503 -67.259 -1087.246 -55982.
TRK McEventCollection TruthEvent dummy 1.503 2.503 -67.259 0.000 0.000 0.000 3595.597  -79488.
TRK McEventCollection TruthEvent dummy 1.503 2.503 -67.259 0.000 0.000 0.000 -4775.216 25246.
TRK McEventCollection TruthEvent dummy 1.503 2.503 -67.259 1.503 2.503 -67.259 39219.113 56356 .
TRK McEventCollection TruthEvent dummy 1.503 2.503 -67.259 1.503 2.503 -67.259 -934.032 2752.
and so on ...
CAL TIL 1646.0000 1.5104 -1.0308 0 113.0 0.2000 0.0982  181.0000 0.0000 0.0000 8.0000 1284329264
CAL TIL 1646.0000 1.5104 -0.8345 0 225.2 0.2000 0.0982  181.0000 0.0000 0.0000 8.0000 1284362032
CAL TIL 2066.0000 1.3098 -0.7363 [ 611.2 0.2000 0.0982 239.0000 0.0000 0.0000 8.0000 1284377904
CAL TIL 1646.0000 1.5104 -0.3436 0 115.2 0.2000 0.0982 181.0000 0.0000 0.0000 8.0000 1284443952
TRK CombinedMuon MboyESDMuonContainer dummy -15.153 -2.748 -73.463 -4127.595 22763.613 6537.681 1 0
TRK CombinedMuon MboyESDMuonContainer dummy 5.662 0.232 -69.260 3476.724 -84711.070 26957.698 -1 0
TRK CombinedMuon StacoCombinedMuonContainer dummy 1.595 0.072 -66.480 3823.643  -84175.569 26698.228 -1 0
TRK CombinedMuon StacoCombinedMuonContainer dummy 1.922 0.364 -67.822 -4684.434 24730.417 7015.255 1 0
TRK CombinedMuon MuidCombinedMuonContainer dummy 1.596 0.072 -66.480 3795.742  -83572.482 26507.004 -1 0
TRK CombinedMuon MuidCombinedMuonContainer dummy 1.919 0.363 -67.827 -4789.944 25295.987 7176.314 1 0
TRK CombinedMuon MuGirlCombinedMuonContainer dummy 1.919 0.363 -67.804 -4780.355 25244 .324 7156.335 1
TRK CombinedMuon MuGirlCombinedMuonContainer dummy 1.597 0.073 -66.453 3780.566  -83257.069 26385.272 -1
TRK CombinedMuon MuGirlCombinedMuonContainer dummy 1.597 0.073 -66.453 3780.566  -83257.069 26385.272 -1
TRK CombinedMuon MuidExtrCombinedMuonContainer dummy 14.491 0.578 -69.406 3423.688 -85821.615 27312.401 -1
TRK CombinedMuon MuidExtrCombinedMuonContainer dummy 36.455 6.768 -71.602 -4663.056 25116.948 7215.593 1
TRK TrkTrack Tracks GlobalChi2Fitter -0.362 2.231 -75.922 -1906.348 -309.684 -8717.668 -1 0
TRK TrkTrack Tracks GlobalChi2Fitter 0.729 -0.213 -65.348 -170.245 -583.032 381.741 -1 0
TRK TrkTrack Tracks GlobalChi2Fitter -0.245 2.386 -74.900 -7773.899 -799.400 -34786.180 1 (]
TRK TrkTrack Tracks GlobalChi2Fitter -0.925 0.690 -56.395 -326.254 -437.493 1835.077 -1 0
TRK TrkTrack Tracks GlobalChi2Fitter 0.433 -0.023 -64.817 -35.997 -690.686 1287.463 -1 0
TRK TrkTrack Tracks GlobalChi2Fitter -0.170 0.118 -69.815 16145.576 23291.786 24952.900 1 0
and so on ...
towards end of file ...
TRK TrkTrack Tracks GlobalChi2Fitter -11.839 11.872 -541.449 545.862 544.334 -492.060 -1 0
TRK TrkTrack ConvertedMBoyMuonSpectroOnlyTracks Muonboy -663.671 4197.861 1128.441 -3158.298 20126.521 5786.598 1
TRK TrkTrack ConvertedMBoyMuonSpectroOnlyTracks Muonboy 210.489 -4244.784 1281.564 3915.525  -81367.942 25839.576 -1
VTX VxPrimaryCandidate 1.4989 2.5093 -67.2314
SEG MuonSegment ConvertedMBoySegments -1129.503 7138.999 1999.174 -0.148683 0.944727 0.292205 1.3543
SEG MuonSegment ConvertedMBoySegments 350.289 -7138.999 2195.211 0.046998 -0.953258 0.298479 0.3012
SEG MuonSegment ConvertedMBoySegments -1506.562 9499.999 2748.712 -0.149175 0.940661 0.304800 2.2791
SEG MuonSegment ConvertedMBoySegments 458.330 -9499.999 2929.664 0.046037 -0.954235 0.295492 2.6723
SEG MuonSegment ConvertedMBoySegments -1230.750 4948.979 1345.019 -0.232330 0.934226 0.270637 0.4230
SEG MuonSegment ConvertedMBoySegments 615.375 -4948.979 1505.046 0.117707 -0.946624 0.300082 0.3672
END EVT

148
331
098
868
418
836
418
418
586
961
379
398

=}

216907.
-310323.
56198.
-47630.
32977.
25813.
7163.
32977.
25240.
7163.
60462.
10946.

812

IS4

94
750
281
461
820
281
912
415
516
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E Menu items

E.1 File menu

| File Image Navigation Volumes E: J1[-8 Image Navigation
= Data manager Ctrl+P

E> Data manager #EP

£ Open view... Ctrl+0

Os _ Cirles 3 Open view... #0
ave View as... ri+ — .
— - Save view as... 35
O Export view... Ctrl+Shift+5
™ Export view... {+385
(. Print.. Ctrl+P
. 2 Print... ®P
Save Special...
kel , Save Special...
Quit Download... >
(a) Linux style (b) Mac OS style

=S

Item name Action

Data manager Load various files:

Volumes, Events, Magnetic field and others

Open view ... Open a Persint .p2vf file for display
Save view as ... | Save view as a Persint .p2vf file
Export view ... | Export (save) view as a local file (.png, .jpg, .bmp, .svg)

Save special... | To compare geometries (sections 6.4, and 9.3)

Print Print current view

Download ... - Download geometry files from Oracle data base at CERN
- Download data from Trac server (Not yet available)

- Download additional field maps from:
https://atlas.web.cern.ch/Atlas/GROUPS/MUON/magfield/Fieldmap

Quit Quit Persint (for Linux only) !

In Mac OS, use “Quit” in the persint menu (section E.8).
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E.2 Image menu

| Image MNavigation Volumes Ever m Mavigation WVolum
i 4 Clear ’ 4 Clear > i
: i3 Compute F5 & Compute 88C
. < Previous view Alt+Left 2 Previous view |
v Logo Logo |
¢ Background color < Background color
7 Specific edge color & Specific edge color
Wire mode Ctrl+W Wire mode HEW
|¥ Anti-aliasing Ctrl+-A + A Anti-aliasing A
| Axes b Axes [
™ Projection » . Praojection >
(a) Linux style (b) Mac OS style
_{} { v <A Ap |v BD, v
Item name Action
Clear Several options:

- Clear view (completely); one can also use the “Brush”

- Partial clear of AMDB or AGDD volumes

- Clear event: clears the event hits and associated chambers
- Clear labels: clears all labels in the display.

- Clear captions: clears all captions in the display.

- Clear pictures (logos): clears all pictures in the display.

Compute Make the calculation to display the newly defined view

Display the view defined by the previous “Compute” action.
Up to 10 backward steps are possible

Previous view

Display or hide the Persint logo at the bottom left of the

Logo !
& display.

Background color ' | Choose the background color of the main display window

Specific edge color ! | Define the color of volume edges in the display

Wire mode Switch the Wire mode on/off for all the displayed volumes
Anti-aliasing Provide smooth volume edges

Axes Display the ATLAS coordinate system in various styles
Projection Display 3D views or 2D projections; makes axes inversion

INot present as an icon in the default tool bar.
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E.3 Navigation menu

g —d
& —2— &
a—:—a
e —4—8Q
Q—s—e

|ﬂ.1vig.1tiﬂn Volumes Event g 6 = @&

- Default mode | D ——7— N

B
« Translation & —8—®

la 7 . P = LEWEEWGLE Volumes  Even
& Zoom-in .

i - =10 = | v = Default mode |
=, Zoom-out ‘ % Translation ‘
@ Initial zoom —_11 — & Zoom-in |
,.- 8, Zoom-out
& Zoom on custom area | @ Initial zoom
#7) Rotation —_—12 — | @ Zoom on custom area
4 Set center “D Rotation

B — 13 — @ Set center
? Volume information ®—1u:—@ ? Volume information

(a) Linux style (d) Mac OS style
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# || Item name Action
All purpose function to perform Rotation, Transla-

1 || Default mode tion, Zoom-in/out, Zoom on custom area (see sec-
tion 8.2)

2 || Translation Translate the view in any direction

3 || Zoom-in ! Zoom-in by moving the viewing point forward, to en-
large the view

4 || Zoom-out ! Zoom-out by. moving the viewing point backwards, to
reduce the view

5 || Initial zoom Retrieve the original viewing parameters

6 || Zoom on custom area | Define the region to be enlarged

7 || Rotation ! Rotate view around center point of display

8 || Set center Center view on a point chosen with the cursor

9 || Volume information Open the Modify volume window to choose volume
parameters: Color, Hide, Translation, Rotation

10 || Selection mode 2 Select a series of volumes to be hidden

11 || Navigation scale 2 Set the amplitude of the following navigation actions:
Rotation, Zoom-in/out

12 || Focal length ? Set the focal length of the viewing.

13 || Reset focal length 2 Reset focal length to nominal value (35 mm)

14 || Tsometric view 2 Set /reset parameters for isometric viewing (infinite fo-
cal length).

1 The amplitude of these actions is controlled by the displacement of the cursor in the Navigation scale

gauge

2These five items of the Navigation tool bar are NOT in the Menu.
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E.4 Volumes menu

Volumes Events Tools Window Help

VLD Events  Tools  Window  Help

es

. Displaced volumes

Create volume

4 |: Hide clashes
Partially show clashes
Show all clashes

Clashes @l v Hide clashes
@ Displaced volumes Partially show clashes
Show all clashes

Create volume

(a) Linux style

(b) Mac OS style

)

Item name

Action

Clashes

Show /Hide intersections of clashing volumes (for debugging
geometry)

Displaced volumes

Show and edit list of displaced volumes (“Move to infinity”)

Create volumes

Draw many types of volumes, e.g. dead matter, using the
AGDD XML description

Displaced volumes window

Violume X Offset ¥ Offset Z Offset Ax Angle | Ay Angle | Az Angle |
1 EOL_F4_Z+6 19999.00 cm | 19999.00 cm | 19999.00 cm | 0.00° | 0.00° |0.00° |
2| EOL_F4_Z+5 19999.00 ¢cm | 19999.00 cm | 19999.00 cm | 0.00° |0.00° |0.00°
3| EOS_F4_Z+6/EQS/Eta6/Phi4/MDT/ML2/ | 19999.00 cm | 19999.00 cm | 19998.00 cm | 0.00° | 0.00° |0.00°
4| EOS_F4_Z+5/EOS/Eta5/Phi4/MDT/ML2/ | 19999.00 cm | 19999.00 cm | 19999.00cm | 0.00° |0.00° |0.00°
5| EOS_F4_Z+4/EQS/Eta4/Phi4/MDT/ML2/ | 19999.00 cm | 19999.00 cm | 19998.00 cm | 0.00° | 0.00° | 0.00°
&) Refresh Reset volume displacement (" 7 Resetall displacements \ ( Close \
A

Figure 134: Volumes can be displaced in the X, Y, Z directions and/or rotated.

The volumes shown in this window are "hidden” or Moved to infinity: X =Y = 7 =

19999.00 cm. (section9.2)

Create volume window

The Create volume function is used to draw many types of volumes. The function is
embedded in Persint and is used, for example, to display the dead matter structures
of ATLAS. Tt uses the AGDD XML description.

The xml structure of the AGDD file is given below in E.4.1, and the subroutine
used to create volumes is shown in E.4.2.
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Figure 135: With the Create volume function it is possible
to draw one volume at a time with chosen dimensions and
color. The available shapes are:

— Box (width, length, height)

— Sphere (diameter, # of facets)

— Cone (diameter, height, # of facets)

— Frame (Diameter, length, height, thickness)

" Create new volume

Name myNewVolume

Shape
Shape 7 box s

Dimensions

[+

Width 100,00 cm

(<)

Length 100,00 cm

[«

Height 100,00 em

Color

=]

( Cancel )

r

Examples of various AGDD XML volumes can be found in [8], where the ATHENA
package AGDD2Geo is presented in connexion with the AGDD XML structure.
A summary list of the AGDD volume types described in [8] is given below:

e Cube

e Tube

e Pyramid

e Cylinder

e Chain

e Polygons

e Combined volumes
e Merged volumes

e Subtracted volumes

e Extruded volumes

As an example, the following paragraph shows the xml description of AGDD files.
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E.5 Events menu

|Eurent5 Tools Window Help
) Reload event
M MNext event M

Minirmum number of hits...
Select sectors...

4. Settrack parameters

\ Generate muon tracks

’T Chambers, strips and tubes

’-_ Chambers
’7 Strips
’_j Tubes

' Envelopes of tubes

21 Simulation tracks
=1 Athena reconstruction
2 Muonboy interactive reconstruction
% * Hit calorimeter cells
Display vertex candidates
Display jets
Display missing Et
Display ROI

= Use all dead matter
E Store visualization properties

P Start or stop autoscan

) Autoscan speed v

Download A lines

mToﬂls Window Help

2 Reload event
W Next event

Minimum number of hits...
Select sectors...

#°. Set track parameters
% Generate muon tracks

+ Chambers, strips and tubes
¥ | Chambers
v 4 Strips
v || Tubes
I Envelopes of tubes

7 Simulation tracks
v 7 Athena reconstruction

Zn Muonboy interactive reconstruction

v #* Hit calorimeter cells
Display vertex candidates
Display jets

v - Display missing Et

Display ROI

v & Use all dead matter
v [5) Store visualization properties

P Start or stop autoscan
) Autoscan speed

Download A lines

(a) Linux style

(b) Mac OS style

Event: 4023 S @ o onis B g0
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Item name

Action

Reload event!

Load current event again

Next event

Display next event of the active Event file

Minimum number of hits. ..

Minimum # of hits required for a MDT chamber to be displayed

Select Sectors...

Select sectors for displaying chambers with hits in an event

Set track parameters

Open window (Fig. 10) where the objects to be displayed are chosen
and their parameters set

Generate muon tracks

Generate muon tracks at the IP. The vertex position, ¢,n, and P;
can be chosen (and the color !)

Chambers, strips and tubes 2

Display /Hide chambers, trips and tubes ”in one stroke”

Chambers ?

Display/Hide the entire chamber

Strips 2

Display /Hide RPC strips

Tubes 2

Display/Hide MDT tubes

Envelopes of tubes?

Display/Hide the tube envelopes

Simulation tracks

Display simulation tracks

Athena reconstruction

Display tracks reconstructed by ATHENA

Muonboy interactive reconstruction

Use the embedded MuonBoy program to ineractively reconstruct
segments and tracks

Hit calorimeter cells

Display the hit cells of the calorimeters

Display vertex candidates

Display primary vertex candidates of the current event

Display jets

Display jets

Missing Er

Draw Missing Er arrow

Display Rol

Display Regions of Interest (under development)

Use all dead matter

Choose to use ALL dead matter or only DISPLAYED dead matter
when computing track momentum with energy loss

Store visualization properties

Store viewing parameters from one event to the next, when scanning
an event file

Start autoscan

Display successive events in regular time intervals

Autoscan speed

Set the time interval between two consecutive event displays (1, 2,
5, 10, 20, or 30 seconds)

Download A lines 2

Download A-lines for each event from the ATLAS data base

! Active only if an event is displayed.
2Not present as an icon in the default tool bar.
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E.5.1 Set track parameters window

T

Caloril cells

Physics

TRT |

" Reconstruction

Reconstruction
¥ MuonBay segments

] Meore segments

M ID tracks at IP
EMuanBovtracks atlIP

] MuonBoy tracks at Spectro
I Staco tracks at IP

[ MuTag tracks at IP

"1 Moore tracks at Spectro
] MulD extra tracks

[ MulD Comb tracks at IP

Maximum d0
Maximum |z0|

et Ao
("] Draw scattering boxes

Track width

Segment width

0,50 Gev 2]

0,40 GeV

(«

0,20 eV

(«

0,20 Cev [7)

(2

0,20 GeV

(e

0,20 GeV

0,20 CeV

(<

()

ofafafofof of aelelc

0,20 GeV

1,0000 cm

1,0000 cm

| Ribbon

——| 2249055 3]

—_——

0,299778

Simulation |

Calorimeter cells | Physics  TRT |

Calorimeter Cells

Ceneral cut-off:

ﬂ LAr e.m. barrel (EMB)

™ Tile

W LAr forward (FCal)

(«

(«

% Cut-off criterion

"1 Draw cell envelop

(:

= Y

(¥

E LAr e.m. barrel (EMB) presampler

E LAr e.m. end-cap (EMEC)

g LAr hadronic end-cap (HEC)

E LAr e.m. end-cap (EMEC) presampler

999.99 Gev 3]

0.10 Gev 7] E

0.50 Gev 2]
0.20 Gev 3]
20.00 Gev [3)
20.00 Gev [3)

Energy 9‘

(saveas ) (Cancel ) (0K )/ Restore Defaults ( Open ) ( Save as ) ( Save ) (Cancel ) E—OK—’/
2 4
(a) Selections for Reconstruction (b) Selections for Calorimeter cells
" Reconstruction | I | Calorimeter cells  Physics  TRT © S DCMOTGGTEd
s aiecs
Simulation lhizam (=]
# electrons. E
W Generated tracks at IP | 200cev [} A oaas emicev ) (soia— W = ]
"] Generated tracks at spectro 0.20 Cev [3] R
- Cljets 2,000 cm/Gev (2] 2,400 cm/Gev 3] 16 aclZ) (Wire o E
Displayed tracks ( Only charged B‘ = ) Missing Et 1000,0 cm [+
a
v 1 Regions of Interest (Rol) Select.. %) (Wire ooocev - [
(testore Default) (“Open ) (Saveas ) ((Save ) ((Cancel ) (0K 34 (Restors Defats ) (Copen) (Smew) (Save) (Caneel) (0K,

(c) Selections for Simulation

(d) Selections for Physics objects

TRT Barrel A

[JBarrel A

Phi sector(s)
TRT Barrel C

[Barrel C

Phi sector(s)

General

[ Draw tube envelop

Restore Defaults.

{ Selection | TRT Selection

TRT End-Cap A

60 [ s00 [3) [End-Cap A 60 [ so0 [
[an z Phi sector(s) (Al B
TRT End-Can €
60 [ s00 [) CEnd-CapC 60 [ so0 [
(an 2 Phi sector(s) Al o

Comn) (suem) Come) () 06
4

(e) Selections specific to the TRT detector

Figure 136: The two panes in the Set track parameters window (Mac OS style).
Thresholds can be set for track momentum and calorimeter cell energy (both in GeV).
The selections in the TRT pane concern cuts on timing.
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Parameter

Description

Reconstruction

Muonboy segments

Choose color

Moore segments

Choose color

ID tracks at IP

Pt threshold in GeV/c; choose color

Muonboy tracks at IP

Pt threshold in GeV/c; choose color

Muonboy tracks at Spectrom-
eter

Pt threshold in GeV/c; choose color

Staco tracks at IP

Pt threshold in GeV/c; choose color

MuTag tracks at IP

Pt threshold in GeV/c; choose color

Moore tracks at Spectrometer

Pt threshold in GeV/c; choose color

MulD extra tracks

Pt threshold in GeV/c; choose color

MuID Combined tracks at IP

Pt threshold in GeV/c; choose color

Maximum |dO0|

Maximum allowed track impact parameter (x,y plane)

Maximum |zO|

Maximum allowed track impact parameter (z direction)

Track shape Choose shape of the track: Ribbon, Crossed ribbons, or Cylinder
Jets Choose parameters for displaying jet cones and jet arrows
Missing Er Choose parameters for displaying the Missing E7r arrow

Regions of Interest (Rol)

Choose parameters for displaying the Rols (Under deveolpment)

Draw scattering boxes

Scattering centers used in the reconstruction are shown (or hidden)

Track width

Can be adjusted with ruler or spinbox

Segment width

Can be adjusted with ruler or spinbox

Simulation

Generated tracks at IP

Pt threshold in GeV/c

Generated tracks at Spectro

Pt threshold in GeV/c

Displayed tracks

Only muons; only charged; only neutrals; all tracks

Calorimeter cells

General threshold

General threshold on E or Er for all calorimeter cells, in GeV/c?

LAr e.m. barrel presampler

FE or Er threshold in GeV/cQ; choose color

LAr e.m. barrel

E or Er threshold in tower (GeV/c?); choose color

LAr e.m. end-cap (EMEC)

E or Er threshold in GeV/c?; choose color

Tile calorimeter

FE or Er threshold in GeV/cQ; choose color

LAr hadronic end-cap (HEC)

FE or Er threshold in GeV/cQ; choose color

LAr forward (FCAL)

E or Er threshold in GeV/c?; choose color

Cut-off criterion

Choose E or Er threshold

Draw cell envelope
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Parameter Description
Physics objects
Photons Display or hide photons
Electrons Display or hide electrons

TRT

TRT barrel A and C

- Cuts on "time over threshold”
- Choose Phi sectors (1-32)

TRT End-Cap A and C

- Cuts on ”time over threshold”
- Choose Phi sectors (1-32)

Draw tube envelope

Draw or hide

What it does

Sets parameters back to default values

Open any .p2ts file containing saved parameters from
previous work

Save parameter file with the name of your choice to any
directory

Save modified parameter file with the same name to the
same directory

Cancel operation and leave parameter file unchanged

Validates parameter file; to take effect, this validation
must be followed by the Compute action; the file is not
automatically saved
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E.6 Tools menu

There is no default tool bar for this menu.

Tools Window Help

& Edit color palette | |JJ i R ““ Event |4023 B
== Animation...

W] Histogram of hit calorimeter cells

Preferences 1} Histogram of dO distribution

Window Help

& Edit color palette

! L
& Animation... L= Persint |
i Histogram of hit calorimeter cells
:M;- il Histogram of dO distribution I

2% Map of magnetic field
i Map of field line integral

| Map of X0

1. Map of expected stations

% Map of magnetic field
1 Map of field line integral

¥ Map of X0
I Map of expected stations

(a) Linux style

(b) Mac OS style

Item name Action

Edit color palette

Opens the Edit color table window, where the colors as well
as the color density can be chosen

Animation ...

Opens the Generating animation window, where parame-
ters which control the animation can be chosen

Preferences ...
Log console, as well

CERN data bases

Set preferences for saving track parameters, magnetic field
1 display, show warnings for reconstruction errors, disable

as network parameters for access to

2

Histogram ... calorimeter cells,

There are 6 types of histograms/maps available:
vertex
integral, Xy, expected # of stations

(d0), magnetic field, field

Edit color palette and Animation windows:

Edit color table |

Colors |

=
=
(
€
Densities
Dark 1 %
Light [ 15 |s
([ Close )

A

Ef‘
‘Warning : This feature is under development.

Iterations 36 [2)
Rotation

Direction 00° [2)

Angle 10,0° (3
Zoom

Zaom factor 0,000 (2

[ Save images

Directory ( /Users/ernwein/Desktop/Ani persint )

Filename animation| _ 0001 (3} [.ong  1%)
"] Steroscopic mode (Cancel ) 0K

i

(a) Edit color palette

Figure 137: Layout of the windows for
”Generating animation” (b).

(b) Generating animation

"Editing the color palette” (a), and

In the case of a Mac OS environment, the Preferences function is found in the Persint menu.
2With Linux, Create histogram is also found in the Tools menu, provided QtRoot is installed.
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Preferences windows:

T Preferences

[ General | Network |

[ Always save or load track settings together with view
Eﬁ!\utomaticall\-r save the view after update

[ Show magnetic field value in volume tool tips

["] Disable log console

E Show error message boxes
Labels and captions

Default font: ( Times New Roman,18,-1,5,75,0,0,0,0,0 )

Colors:l | II | I( -\

(Cancei) ( OK )
4

(a) ”General” Preferences

" Preferences

I General | Network

Proxy

If you are runnning Persint from outside the CERN network, a proxy may be
needed to download some data such as alignment corrections.

(*) With proxy () No proxy

To open a proxy, login to LXPLUS with the following command line :

ssh -D 3168 Ixplus.cern.ch Change port...

[ Cancel )

4

(b) ?Network” Preferences

Figure 138: The setting of Preferences (to be found in the Persint menu for the
Mac OS environement):

a) General for saving track settings with view, update/no-update of view, showing
magnetic field in volume information boxes, disabling/enabling Log console and warning
messages for reconstruction errors

b) Network for choosing a "proxy” when downloading from a CERN server (e.g. align-
ment constants)
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E.7 Window menu

There is no default tool bar for this menu.

| Window Help m Help

Reset window layout Reset window layout

Dimensions... | Dimensions...

Full-screen F Full-screen F
|T 1 View v 1 View !
|v AMDB v AMDB
|v AGDD v AGDD
|T Magnetic field v Magnetic field
v X0 v X0

Log v Log

(a) Linux style (b) Mac OS style
Item name Action

Reset window layout

Set the default layout of the Persint display

Dimensions

Set image canvas size

Full-screen

Makes the Main display full-screen; as a shortcut,
type F (lower case) to enter or quit full-screen mode

1 View

AMDB Enable the AMDB Selector window

AMDB (v1) EV?I?(‘;)(I):V a previous version of the AGDD Selector
AGDD Enable the AGDD Selector window

Xo Enable the Xy window (amount of material)

Log Enable the Log window
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E.8 Help menu

There is no default tool

bar for this menu.

Help
User Manual
Report a bug
About Persint
About Ot

F1
Help % <> <
search
| User Manual w7 [
Report a bug

(a) Linux style

(b) Mac OS style

Item name

Action

Linux style

User Manual

Opens the Persint User Manual in your web browser

Report a bug

Prompts to your mailer with the destination mail address:
atlas-sw-persint-support@cern.ch

About Persint !

Open information window about Persint; the version
number is found here

About Qt'

Open information window about Qt

Mac OS style

Search

Search for commonly used functions

User Manual

Opens the Persint User Manual in your web browser
(27 Mo pdf)

Report a bug

Prompts to your mailer with the destination mail address:
atlas-sw-persint-support@cern.ch

In the Mac OS environment, About Persint and About Qt are found in the Persint

(see section E.9)

menu
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E.9 persint menu (Mac OS only)

There is no default tool bar for this menu.

mml File Image

About persint
About Qt

Preferences... 3,
Services >

Hide persint 3#H
Hide Others " 3H
Show All

Quit persint ®0Q

(a) Mac OS style

Item name

Action

About Persint

Open information window about Persint; the version
number is found here

About Qt Open information window about Qt
Set preferences for saving track parameters, magnetic
field display, show warnings for reconstruction errors, dis-
Preferences ...

able Log console, as well as network parameters for access
to CERN data bases

Quit Persint !

In the Linux environment, Preferences is found in the Tools menu (see section E.6 where the two
Preferences windows are shown), and Quit is found in the File menu (section E.1)
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E.10 Warning messages

On various occasions, Persint encounters an error which is reported in a message like

those shown below.
Note that for these messages to appear, the Show errors box should be checked in the

Preferences window (see figure 138a, page 163).

Could not download alignment
corrections.
You should check your network proxy

settings.
Error code: 1

(S

(a) Failed download of alignment corrections

the current event.
It may have been truncated.
Please refer to
/Users/ernwein /.persint/Persint.log for

further details.

Muonboy error code: M_MB_Persint _Size
- Muonboy default sizes are too small for

(b) Event too big for Muonboy reconstruction with standard settings
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F Right-click

Right-click: access to special menus

 Event toolbar

@ Centér on volume

O Add/Remove label
7 Volume information

Default aptions \L Ty S

MDT options - 0 Add picture

# Cross plate [ Long beams W] Tubes envelop R-Click on empty area
[ 1 Tubes

[ 1End-plugs [ | Faraday-cages || Stair-casing
<@ Add caption
RPC/TCC options ¥ 0 Add picture

[(AMDB | AGDD  Magnetic field | Fareind

XX T—
o= MR-Click ontoolbar @ eem:fsos @G w = 7 o
Avos P oY -Click on window bar 3
:WITE}T & selection wir &
P - . .
: :cc © Restore q
Move
> MAT Size a
: :::':L R- = Minimize L
+ AMDE 1 OMaximize q
v Magnetic field Stay on Top
Status of Muonboy Reconstruction ";
Log LY
v File toolbar * Select volume Y ?
¢ Image toalbar ! + Select super-volume R- ick ontrack
v Navigation toolbar 5. Move volume to infinity +
v Volumes toolbar . Move super valume to infinity

(s | (P |

Figure 139: Special menus available through Right- click on various areas of the
Persint display

The special menu which appears depends on the location of the cursor when right-clicking.
In the case of a reconstructed track, there is a menu item called Edit track illustrated

in figure 140.

Rynaz and Zya, (both in em) define the cylinder, centered on the IP, which contains the
track.

Track #790
Rmax I Defauly @I
Zmax Default 2]

Lol

[: Restore Defaults ) C Cancel ) E—Olt—a

A

Figure 140: Window which opens when clicking on Edit track in the special menu
obtained with a right-click on a track
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G Producing Event files for Persint in ATHENA

ASCII Event files for input to Persint (Out.MboyView_xxx) are produced in ATHENA
from raw data. These files contain all coded information needed to display the recon-
structed objects. It is possible to display tracks reconstructed by the various reconstruc-
tion packages (e.g. MuonBoy, Staco, Moore, MulD, ...) by selecting the appropriate
objects in the window described in figure 10 (Set track parameters).

G.1 Event files from raw data

Inside ATHENA , Event files for Persint are produced by the MboyView package via
the doPersint flag in RecExCommon:

doPersint=true

It is possible to make a selection of events to be included in the Event file by using the
following parameters in the PITHON file used for running ATHENA:

# Event Selection: EvtSelectionType and EvtSelectionThreshold

= 1 view without Selection

= 2 view only for evts Nber of Tracks .le. EvtSelectionThreshold

3 view only for evts Nber of Tracks .ge. EvtSelectionThreshold

4 view only for evts Nber of Tracks .eq. EvtSelectionThreshold

GenEvent Selection: GenEvtSelectionType and GenEvtSelectionEta<Min/Max>

= 1 view without Selection

2 view only for evts with at least a gen track with

GenEvtSelectionEtaMin<abs(eta)<GenEvtSelectionEtaMax

H H H H H H K H

if doPersint:

MboyView = Algorithm( "MboyView" )
MboyView.EvtSelectionType = 1

MboyView.EvtSelectionThreshold = 0O
MboyView.GenEvtSelectionType = 2
MboyView.GenEvtSelectionEtaMin = 0.
MboyView.GenEvtSelectionEtaMax = 2.7

The information to be included in the Events for Persint can be chosen as follows (0=no;
1=yes):

if doPersint:

MboyView = Algorithm( "MboyView" )

MboyView.ViewDigits = 1 # dump the spectrometer digits
MboyView.ViewCalo = 0O # dump the calorimeter cells
MboyView.ViewMcEventCollection = 1 # dump the truth info
MboyView.ViewTrackRecordCollection = 1 # dump the TrackRecord

# (i.e. truth info at the spectrometer entrance)
MboyView.TrackRecordCollectionLocationForGenEventSelectionList =
[ "MuonEntryLayerFilter" ]
MboyView.TrackRecordCollectionLocationForGenEventSelectionList +=
[ "MuonEntryRecordFilter" ]
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G.2 Event files from ESDs or dESDs

The ASCII input file for Persint (Out .MboyView_xxx) can also be produced from ESD files.

G.2.1 Procedure

e Set up ATHENA release 15.6.3 or higher. You may follow instructions given in:
https://twiki.cern.ch/twiki/bin/view/Atlas/WorkBook, in particular in sec-
tions: Getting an Account, Setting up your Account, Running Athena HelloWorld.

e Get a job options file.
A generic job options file (MboyViewESD.py) is located in the directory
Persint-00-02-ee/example.
It is also available as an attachment to the following Twiki page [the file is listed
in the next section (G.2.3)]:
https://twiki.cern.ch/twiki/bin/view/Atlas/PersintDumpESD
You may want to edit the job options file for geometry and conditions tags asso-
ciated with your ESD file.

e Finally, execute the following command:
athena MboyViewESD.py -c ’inputFileList=["/path/to/ESD/file"]’
where /path/to/ESD/file is ”comme son nom l'indique”.

This will create a file MboyView which can be read by Persint.

G.2.2 Limitations

The method described above does not re-run the reconstruction but only dumps the
values already available in the ESD file. The advantage of this method is its speed.
However, in the ESD file, only the TDC counts of MDT hits are stored, and not the
radius returned by the RT calibration service.

An approximate radius is thus associated with MDT hits, in the following way:

1. If the MDT hit is associated with a Muonboy segment, the calibrated radius is
saved in the segment and this is what is returned in the ASCII dump

2. If the MDT hit is not associated with any segment, its radius is set to 7.5 mm

This last approximation makes the ASCII dump suitable for display, but not suitable
for Muonboy interactive reconstruction in Persint.

In future versions of this tool, a better radius determination may be included.

G.2.3 ATHENA job options file, an example: MboyViewESD.py

from AthenaCommon.AthenaCommonFlags import athenaCommonFlags
athenaCommonFlags.FilesInput = inputFilelist

=
7
Muonboy

interactive
reconstruction
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include (’RecExCond/RecExCommon_flags.py’)

import AthenaPoolCnvSvc.ReadAthenaPool
from AthenaCommon.ApplMgr import ServiceMgr as svclMgr
from AthenaCommon.AppMgr import ToolSvc as toolSvc

from AthenaCommon.AlgSequence import AlgSequence
topSequence = AlgSequence()

from AthenaCommon.AlgSequence import AthSequencer
selectionSequence = AthSequencer("selectionSequence")

# ______________________________________________________________
# Event related parameters

# ______________________________________________________________
# theApp.EvtMax = 100

# ______________________________________________________________
# GeoModel stuff

# ______________________________________________________________

from AthenaCommon.GlobalFlags import GlobalFlags
from AthenaCommon.DetFlags import DetFlags
DetFlags.ID_setOn()

DetFlags.Calo_setOn()

DetFlags.Muon_setOn()

# GeoModel initialisation

from AtlasGeoModel import SetGeometryVersion
from AtlasGeoModel import GeoModellInit

MessageSvc = Service( "MessageSvc" )
MessageSvc.OutputLevel = 3

svcMgr.EventSelector.InputCollections = athenaCommonFlags.FilesInput()
# Optionally add to selectionSequence any private alg that selects the
# events to be dumped in Out.MboyView

# from PFMuonAnalysis.PFMuonAnalysisConf import CosmicMuonAnalysis
# selectionSequence += CosmicMuonAnalysis("CosmicMuonAnalysis")
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# Configure the MboyView algs

from MboyView.MboyViewConf import MboyViewDigiMaker
selectionSequence += MboyViewDigiMaker ("MboyViewDigiMaker")
selectionSequence.MboyViewDigiMaker.ApproximateRsLine = True

from MboyView.MboyViewConf import MboyView
selectionSequence += MboyView("MboyView")
selectionSequence.MboyView.SwitchOff = 0
selectionSequence.MboyView.ViewDigits =
selectionSequence.MboyView.ViewTrackRecordCollection
selectionSequence.MboyView.ViewCombinedMuonContainer
selectionSequence.MboyView.ViewTrackParticleContainer
selectionSequence.MboyView.ViewTrkTrackCollection
selectionSequence.MboyView.ViewTrkSegmentCollection
selectionSequence.MboyView.ViewMcEventCollection
selectionSequence.MboyView.ViewEgammaContainer =

Il
L Y A e

topSequence += selectionSequence

# AthenaEventLooplMgr = Service( "AthenaEventLoopMgr" )
# AthenaEventLoopMgr.OutputLevel = WARNING
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1P, 35

Isometric view, 42
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Ixplus, 15, 121
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MAT, 35
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Minimize, 88
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Muid, 15

Multiple scattering, 39

Multiple scattering center, 73

Muonboy, 13, 15

Navigation, 34, 40
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Online help, 19
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Out.MboyView, 23, 24, 61, 66, 67, 70, 130,
139, 141

Persint menu, 166

Physics objects, 89-91

Picture (Add/remove), 28, 30
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Preferences, 162, 163, 166

Previous view, 35, 49, 116
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Projection, 38, 39, 43, 69, 73, 79, 86
Proxy, 163

Qt, 15

Range, 59

Raw data, 15, 169
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Reconstruction (interactive), 77, 80

Releases (Earlier), 119
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Reload event, 44, 45, 67, 75, 76, 81, 83
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Restore, 88

Right-click, 18, 28, 44, 47, 49, 71, 78, 88,
168

Rol, 91

Rotation, 41, 42, 47
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RPC options, 39

RPC strips, 39, 73

Run number, 29

Save (automatic), 37
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Save histogram, 88

Save special, 27, 48

Save view as, 18, 26, 36, 66, 71

Scanning (autoscan), 67
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Sector (Small/Large), 33, 40

Segments, 70
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Selected volumes window, 47

Selection mode, 43, 47

Selector window, 18, 24, 33-37, 39, 40, 52,
53, 64, 83
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Simulation tracks, 75
Simulation tracks, 25, 75
Software name, 45
Spinbox, 40, 42, 160
Staco, 15

Start Persint, 16
Station, 39

Store, 49

subscript, 29

Super volume, 47
superscrip, 29

svn, 120

Threshold of calorimeter hits, 84

Time stamp, 29

Tool bars, 18

Tools menu, 162
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Track parameters, 23, 25, 61, 70, 72, 73,
75, 81, 83-85, 87, 116, 159

Track shape, 47, 70

Track width, 70

Translation, 41, 42, 47

Transparency of volumes, 52

Transverse energy, 84

Twiki page, 15

Ubuntu, 15, 120
Useful hints, 116
User Manual, 165

Version number (Releases), 15, 16, 20
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Video software, 51

Visualization properties, 67, 68
Volume (Create volume), 147
Volume information, 43, 47, 49
Volumes menu, 147

Warning messages, 167
Window menu, 164
Windows 7, 15

Wire mode, 33, 39, 52, 64

X0 map, 18, 58
XML, 15

Z-halves selector, 33
Zoom, 39, 41, 42
Zoom on custom area, 41, 42, 49
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